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Help

Welcome

Hi! Welcome to the Embrilliance Platform!

Thanks for reading this User Guide! Since you're here, let us tell you about this exciting program
because it represents a giant step forward in embroidery.

For starters, it is a small, yet feature packed, program that is easy to install. It has versions for both
Mac OSX and Windows. Windows versions install on XP, Vista and Windows 7/8 (including a separate
Win 7/8 64-bit version.) It requires no hardware dongle and can be installed on multiple systems
requiring only your personal serial number to be typed in for the program to run. Once you enter a serial
number, register the program, which provides several benefits. One of those benefits is that if you ever
lose your serial number, we can recover it for you.

This manual covers the features in the platform and its available products. Some features are
available to all licensed products, but are not available in Express Mode (free version).

Welcome to Embrilliance, and let the fun begin!

Products

The Embrilliance Platform supports a free mode called ‘Express Mode’ as well as a number of paid
products. Express Mode is run by skipping the ‘Serial Number’ request when the program is run. Express
Mode allows anyone to use the popular .BX-installer for embroidery design collections that are sold as
fonts on the internet. If you have a .BX installer, please refer to the PDF document that came with the font.

Other products that are sold for use in the platform include:
Essentials, Enthusiast, Density Repair Kit, AlphaTricks and StitchArtist

Each of these products has its own sections in this manual.

Installation

Installation of Embrilliance is easy. First install the disc or download the installer. If you have the
disc, XP may automatically run it, but in later versions of Windows, Auto-Run has been turned off by
Microsoft, so you'll have to browse to it using Windows File Explorer (a.k.a. “Computer” or “My
Computer”). Look for the program with “Setup” in the name and double click on it. This will start the
installation. In Windows it looks like this:

i3 Setup - Embrilliance [E=H] Xl i5) Setup - Embrilliance o=l Xl

License Agreement
Please read the following important information before continuing.

Welcome to the Embrilliance
Setup Wizard

This will install BriT on Leap Embriliance 1.06 on your computer. Please read the following License Agreement. You must accept the terms of this
agreement before cantinuing with the installation.

Itis recommended that you close all ather applications before
continuing. END-USER LICENSE AGREEMEMT For BriTon Leap Products

] »

Click Mest to continue, or Cancel to exit Setup. Al software and designs are Copyright, BriTon Leap, inc.

Embraidered goads created with the designs included in this praduct may be resald
in limited quantities without permission. 1f more than 500 designs. in any combination
from this design collection, are embroidered on or as goods for resale, you must
obtain permission from Tacony and BriTon Leap, inc.

The BriTon Leap software ['Software'') is protected by copyright.
The Software is licensed, nat sold i

@) | accept the agreement

() | do not accept the agreement

Next > Cancsl | < Back “ Mext » Jl Cancel




The Embrilliance Platform
Click ‘Next’ then accept the license agreement by clicking the button then click ‘Next.’

i5) Setup - Embrilliance L] o
Select Destination Location \ )
‘where should Embriliance be installed? (!:'2!- s

Setup will install Embriliance into the following folder. Setup will create the program's shortcuts in the following Start Menu folder

To continue, clhck Nest. If pou would like to select a different folder, click Browse. To continue, click Mest. If you would like to select a different folder. click Browse.

| Browse: JE mbillance'E miiliance] | Eirowise:

At least 2.5 ME of free disk space is required. [T Don't create a Start Menu falder

l « Back “ Ilent » JI Cancel I « Back “ et » J{ Cancel

Click ‘Next.’ You will usually want a desktop icon for ease of running the program. Click ‘Next’

5! Setup - Embrilliance &5 e S| 15 Setup - Embrilliance =]
Select Additional Tasks \ )
“which additional tasks should be performed? I

Completing the Embrilliance Setup
Wizard

Setup has finished installing Embriliance on your computer. The
application may be launched by selecting the installed icons.

Select the additional tasks you would like Setup to perform while installing Embriliance.
then click Mext
Additional icons: Click Finish to exit Setup.

[¥7] Create a desktop icon [#] Launch Embriliance

< Back H MNent » JI Cancel ‘ Finish

You are now ready to begin installing. Click ‘Install.’

15 Setup - Embrilliance el i

Completing the Embrilliance Setup
Wizard

Setup haz finished instaling Embriliance on your computer. The
application may be launched by selecting the installed icons.

Click Finish to exit Setup.

[¥] Launch Embrillatce

‘. Finish

Run Embrilliance now or just quit the setup by unchecking the ‘Launch...’ box.

You are finished installing!

Adding Serial Numbers

Use the menu Help->Serial Numbers... window to add serial numbers that you own. Type in a serial
number and click ‘Set’ to add it. Repeat the process if you need to add multiple serial numbers. If



Program License

accepted, the product name that you are adding will be added to the list in the window. Restart the
program (not the computer.)

Font and Design collections will not need their serial numbers to be entered in this window. Once
you have installed a Font, the program will ask for its serial number when you run the program. If you
enter the serial number at that time, you will not be asked for it again after that.

Program License

Embrilliance licenses for single-user use and you may install and run the program on as many
computers as you own. You may even mix and match Mac and Windows versions. If you are a business
that requires multiple users, please contact us for additional licenses, possibly at a discount.



The Embrilliance Platform

The Windows Docking Pane Interface

This interface can be configured and the configuration is persistent, i.e. it is remembered between
program invocations. The controls for this interface consist of a Pin, a Close Box and a Tab. The Pin and
Tab are related. When the Pin is “unpinned” the window slides into the main window frame and presents
a Tab with the window name. When the Pin is “pinned” the window stays open and the Tab goes away.

In the unpinned configuration, hovering the cursor over the Tab reveals the window. When the
cursor is moved out of the window it slides back into its unpinned position.

The Close Box dismisses the window altogether. To restore a dismissed window you must use the
View Menu->Toolbars and Windows item to restore the dismissed window.

S x|
Left: Unpinned Right: Pinned
fled 1* sy & o S

oo Window  Help

S'a!uad'o.l d |

ndows.., 3 ResetWindows and Toolbars

Mavigator Window
kain Toolbar
Wiew Toolbar
Design Toalbar
Object Window

Properties \Window

B Coodiis Do

Left: Pinned Windows. Right: Reset Windows command in Menu.

—o4
P (N ) (N

Note: If your system changes, some windows may be moved or hidden. This is easily corrected
using the menu ‘View->Windows and Toolbars->Reset Windows and Toolbars’.




Platform Overview

Platform Overview

This large section describes the overall Embrilliance Platform, which runs several products
including Essentials, AlphaTricks, Density Repair Kit, and StitchArtist. As these platform features are
common to the products, we'll cover them together.

Below is a picture of the Embrilliance window.

14 Embrilliance - Untitied 1 *
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» As with most programs at the top of the window is the main menu, and below the main Menu is the
main toolbar. These two components are always available and handle the most significant
commands of the program.

» The Tool pane is a little different. It will display different contents, depending on what type of task
you are performing. For instance, if you are running the Sewing Simulator, the controls for the
simulator will appear in the Tool pane.

* The Main view displays the current Design Page. A Design Page is a representation of a .BE file,
which can contain multiple embroidery designs, lettering objects and frames.

* More than one Design Page can be open, and these are selectable by using the tabs above the Main
View, just below the Tool Pane. As you save Design Pages, they will take the names you have given
them. Until a page is saved, it will be called “Untitled...”

» The Status bar provides relevant information about what is going on with the program’s current
operation. For instance, if you are measuring items, the text in the bottom right corner of the Status
bar will update with the measurements created by that tool.

» The Navigation view provides an easy-to-use way to navigate around the current design page, and
to control the zoom for it. This is especially useful when you have a lot of objects on a large design
page and you want to go from one place to another without repeatedly zooming and scrolling.
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» The Object view displays Designs and Objects sequential order as they are opened or merged onto
the design page. Each root (leftmost) item in the Objects view is a Design. A Design or object may
be, for example, a lettering design, or perhaps a regular embroidery design.

» The Designs in the Object view can have objects within them. To view those objects, click the ‘+’
which opens up the tree, thereby ‘disclosing’ the objects in the design. With a normal embroidery
design merged into the page, you will be able to see individual colors within the design once you
click the ‘+.” Some designs, like lettering designs, may not disclose their individual objects because
all editing is done via the Properties view.

» The Object view can also be used to select designs and objects, which is useful when objects within
a design are grouped, such as with regularly merged embroidery designs.

* The Property view displays information and controls for the currently selected objects and designs.
For example, if a single-color design such as lettering is selected, you will see in the ‘Color’ property
page only the single color for the lettering. If no design or object is selected, the Color property
page is shown and the colors for the entire design page are shown.

Embrilliance Design Pages

A Design Page is where designs and lettering can come together to form a composition or a scene.
That page is also represented as a single embroidery (or working) file. For example, you may have
merged multiple embroidery designs, added a couple lettering designs, and then surrounded them with a
Library frame. All those individual designs exist on the Design Page. That scene can be saved as an
embroidery file for use in your machine, and it can also be saved as a ‘Working File’ (extension .BE),
which allows for editing later. (Suppose you miss-typed some lettering.)

As Design Pages are opened or saved, their name will appear in the Tabs above the Main View. You
can switch between Design Pages using the Tab View. This is handy for clipboard operations such as
doing a copy and paste between Design Pages.
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Each Design on a Design Page is one of the three types, ‘Embroidery Design,’ ‘Lettering Design’ and
‘Library Design.’ These design types work together to build useful embroidery compositions. The designs
are visible on the Design Page in the Main View, and the sequence of the designs is visible in the Objects
View.

Designs are collections of objects. For example, a merged embroidery design is a collection of color
objects, each of which contains stitches for a single color in the design.

Designs may be ‘grouped’ which allows you, the user, to select and move the design around in the
Main View as a single design. By default, when you merge an embroidery design into the page, it comes in
as grouped. If you want to change one or more colors (or objects) in the design, you have some options:

* Ungroup the design, which makes each object selectable in the Main View.

» Select the object or objects in the Objects View.
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Designs as they appear in the Main View may be ‘Locked’ which prevents inadvertent moving or
editing. The lock may also be used to hide the design(s). The state of the Lock is set using the Objects
View toolbar.

Objects

Each Design on the design page can contain one or more objects, each of which contains colors,
stitches and other information. The only objects you will see are individual color objects within a merged
embroidery design. Each object can be moved, edited, deleted, etc.

Files

Embrilliance uses a few different file types, each having its own file extension. For example “BE’ is a
working file. This file type contains all the Designs and Objects representing a single Design Page. These
designs and objects can be edited, as they have not been forced to become a simple set of stitches, which
is what most machine embroidery files are.

Licensed files, such as fonts will have .BF and .LF files. These are installed by the installer for our
collections. You cannot edit or use these files as a user. The program loads them automatically as needed.

Stitch files, which in the commercial embroidery trade are called ‘expanded’ files such as .PES or
.DST are simply collections of stitches, and if you are lucky, colors.

Saving

When you save a Design Page it will ask you to choose which Stitch File type you want to use. For
example, a Baby Lock / Brother embroidery machine owner will choose .PES as the stitch file type. In
addition, the program will also silently save a working file (.BE) thus saving you the extra step of saving it
separately. As mentioned earlier, the working file allows you to edit your designs including text. If you
want to save individual files (not both stitch and working) you have all the options on the File menu.

Working File Versions

Each design page is given a unique code when it is created. When saving a working file (.BE) which
represents a design page, that code is saved in the file too. Subsequent ‘Saves’ will check the code for the
design page. If it is different, the working file being saved will be given a revision number in its name such
aS “(2)_"

The purpose for this can be explained in the following scenario:

Suppose you create a page with lettering or StitchArtist objects. These objects contain far more
information than stitches. Now you do a normal ‘Save’ which saves the Stitch File and the Working File.
0Ok, all normal so far.

Next, you ‘Open’ the stitch file to see what it looks like, which actually creates a new design page and
merges the stitch file onto it.

Perhaps you make a small edit - color or stitches, etc. You want to save what you've just done so you
click ‘Save’. The program lets you pick a name, but you're happy with the one you've got. Now the
operating system asks if you want to ‘Replace’ the files since the names are identical. You think, “Sure, I'll
replace it,” forgetting that you've ‘Opened’ with the Stitch file, not the original Working file.
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If the program did not check the codes, it would save the ‘new’ working file over top of the original

one, that had all the object data. But in this case, the codes don’t match so you get a new version working
file. The stitch file will be overwritten, as it has no object data to be concerned about.

Open vs. Merge

Files can be ‘opened’ which starts a new Design Page in the Main View so that you can see the open

file. Use Open for .BE files.

If you already have a Design Page open, you can ‘merge’ files, which adds the contents of the files to

whatever you have on your page currently. To merge a file click on the Merge icon on the Toolbar or go to
File/Merge Stitch file or Merge Working file.

Note: When you ‘Open’ a stitch file from the operating system (for instance double-clicking on a
.PES file) you are actually creating a new design page and merging the stitch file into it.




Stitch Files

Stitch Files

Clicking the Merge button found on the main toolbar or selecting Merge from the File menu
will display the Open Design Files dialog. Here you browse for embroidery designs to add to the

Design Page.

Save

Save Ds..

Save Working File..,
Save Working File As...
Merge Working File..,
Merge Stitch File.., %

Print...

Print Preview

Ctrl+3

Ctrl +P

L
|F|' -
s LR

The Merge Design view allows you to browse thumbnails

of your files and select one or more files in import.

» The Size control of this dialog determines the preview size of the design thumbnails (the design
does not have to be selected for the determined size). The 3D control shows the preview in 3D, i.e.

it shows simulated stitches.

» Click Import to bring the selected design(s) into the Design Page. The imported design will be
centered on the Design Page.

Merged Stitch File behind Monogram.
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The Main View

Design pages are displayed in the Main View of the program. There can be multiple design pages
open at any given time. For each page in use, a Tab control is displayed below the Tool Pane. Additional
pages are added by clicking the New button on the Main tool bar, by pressing Ctrl-N by choosing New
Page from the File menu or choosing New from the Window menu:

M Embrilliance - Untitled 1
5O Edit  Utility View Zoom Window Help

New Page Ctri+N
Open... Ctrl+0
Close

A design page is activated by clicking its Tab control or select it from the list in the Window menu.
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The Tab control will display the name of the file associated with the page once it has been saved,
otherwise it is named “untitled x” where x is a running number.

The Main View has a background, a hoop, and rulers along the side and, naturally, the designs you
have placed in the Design Page.

Welcome
Embri!liance

10
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Hoops

The hoop that you will view in the Main View is chosen for the Design Page using the Preferences
Window. See the section under Preferences, called “Hoops.”

Program Preferences | = ||
[=3 Environment it Hoop Sty
#iHooE BE =1 | 6 Nomsl € MiPosiin
Grid Settings 360mm x 200mm %
Calibrate Screen 360mm x 60mm New
240mm x 360mm Dream Mach./T|
Wouse Wheel 300mm x 200mm (Muli-Ndl) Edt
Check for Updates ggmmx;}gmm ==
o 30k
e Dot Mode 200mm x 200mm (Elisimo/Quatirc ===
2 20
122 Files 160mm x 280 L0
2 pining e 15
23 Adjustments 100mm x 180mm (Continuous) ™ Reset Defauits
Sewing Field {w x h;
mmeS&?Pn;T
or 3pProX. 3 X
N
oK e | oply ‘
Left: Hoop selection. Right: What a hoop looks like in the Main View.
. .
Navigation

The Navigation H.U.D. (Heads Up Display) is an ingenious device that keeps navigation

+ tools tucked away, yet readily available for easy access to the entire working area on your
Design Page. To access the Navigation H.U.D. (aka: Nav H.U.D.), click the Compass Rose icon at

the top of the zoom slider in the upper right hand area of the main view.

The Nav H.U.D. is especially useful when working on large designs and/or a small monitor. It quickly
gives you a bird’s eye view of your work area as well as a convenient “you are here” indicator. In the
following image, the area around the mouse’s eyes will be centered on the screen.

As you move the cursor, the ‘+’ indicates the area of focus. The panel lets you pan around the design
page. The benefit is that you can make edits to different design sections while you are still zoomed in to a

comfortable level.

al(slH ) @312
b

The Nav H.U.D works in conjunction with the Pan Tool, which is accessible by holding down the
spacebar.

11
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ST? Hold the spacebar and drag with this cursor to pan.

Whereas the Pan Tool is useful for moving around the area in which you are currently working, the
Nav H.U.D. makes it easy to scroll across the entire page to a specific place in one easy step.

The chosen hoop is shown in the Nav H.U.D. whether that hoop is visible or not. This is because the
size of your workspace is related to the size of that hoop. The selected hoop is a visual reference only and
does not prevent you from designing or saving projects larger than the selected hoop or, for that matter,
larger than your machine can sew.

Therefore if you have a small hoop selected and a design that well exceeds the hoop boundaries, it is
possible that you won’t be able to navigate to the outer reaches of your design. The solution is to select a
larger hoop from the Environment > Hoops option in the Program Preferences panel.

il e 2 Al's H 0-°
' E 3 i
™

\

B =
—*"\ - C—/
L )

5 _
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Same design with the hoop set to 60mm x 40mm with the cursor shown
at the upper left limit. Parts of this design are inaccessible.

Normally, once you’'ve panned or zoomed in the Nav H.U.D. the panel will automatically close when
you release the mouse. If you'd like to leave the Nav H.U.D. open while you move to several locations, click
the ‘Pin’ button just to the left of the close box. Once pinned, the panel will stay open until you click out of
it or click the ‘Close’ button on the top, right in the H.U.D.

l l
Unpinned (default setting) Pinned

Notice on the top of the Nav H.U.D. are three small buttons labeled ‘A, ‘'S,” and ‘H." These buttons
correspond to preset zoom settings of ‘All,” ‘Selected,” and ‘Hoop,” whose keyboard shortcuts are
respectively ‘A, ‘S,” and ‘0.’

Just below the compass rose icon is a zoom slider. Slide up to zoom in; down to zoom out. Click on
the ‘+’ and ‘-’ buttons to zoom in and out also. If you’ve ever used an online map, this zoom slider control
should feel familiar. The slider control also responds to numeric key entry. For example, pressing 5 will
move the slider control to 500%.

12
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Size and Rotate

The lettering, the Library designs and the merged stitch files can all be sized and moved.

Note: Using some of the products, existing embroidery files can be resized with stitch
recalculation. You can resize embroidery up to 250% and down to 50%. If you want to
resize an existing design without stitch recalculation, hold down the Ctrl key while
dragging the handle.

e Ifyou want to resize the design in place, hold down Shift.
e [Ifit's a digitizing object, use Alt to scale each item in place.
e C(lick and drag on a black handle to resize the design.

e C(lick and drag the round blue handle to rotate the element.

Black handles resize, round blue handle in upper right rotates.

Click and drag anywhere on a design element to move it. As the design is moved off the page, in any
direction, the page will automatically scroll if the cursor is in the ruler area of the page.

For finer movements (1mm at a click), the selected design element(s) can be nudged using the
keyboard arrow keys. To move objects one stitch point at a time (.1mm), hold down the control key while
pressing an arrow key.

When resizing, understand that not every design can be recalculated perfectly. Some designs such as
cross-stitch and freestanding lace are not going to resize correctly. Another consideration is the level of
detail. Highly detailed designs radically reduced will lose clarity and crispness as the details become
squished together.

Note: This is one major benefit of the Library designs; they can usually scale and calculate their
stitches for you.

13
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Viewing in 3D

The default setting for the Main View is to display stitches in a realistic 3D, which lets you
3D clearly see where the needles will penetrate the fabric. This can be turned off using the ‘3D’
button on the main toolbar.

Zooming

m Window  F Zooming is handy for edits, and these controls make the process of zooming
Hoop N more convenient. Also, one of the options in the program is to be able to use a mouse
all A wheel to scroll the design page up and down. If you have this mode on, the zoom
Selected 5 slider is an alternate tool. Just a reminder, there are also keyboard shortcuts for

zooming: z’ zooms in, and ‘Z’ (shift-z) zooms out.

1:1 1

a1 3

61 & Zooming can also be accomplished with the Zoom Menu and Toolbar

controls.

» ‘All’ zooms to all objects on the design page.
» ‘Selected’ zooms to selected objects on the page.

* From the Zoom menu specify what should be zoomed: the Hoop, All elements or the Selected
element or choose the amount of zoom.

Tip: Memorize the keyboard shortcuts for the Zooming and Panning; using them can speed your
designing!

&

Use the Zoom slider to zoom on the Main view. Up zooms in, down zooms out.
There are zooming keyboard shortcuts:

* ‘Z’to zoom in

* ‘Z’to zoom out.

* 0=FitHoop

* ‘A’to zoom all

o » ‘S’ to zoom selected

* 1-9will zoom to 100%-900% of real-world scale.

Panning and Scrolling

P !4 S The scroll bars at the right and bottom of the Main View can be used to

scroll the view around, which is very useful when you are zoomed in.

qErrF, There is also a mode that allows you to ‘Pan’ the design, which works like a
scroll, but where you move the view by dragging the mouse. Hold the space bar
down and drag the mouse to pan the view.

|
L
|
|
]
]
]

Auto-Scroll

As you drag on the main view, you may come near the edge of the page. This will cause the page to
scroll, enabling you to drag into a position that’s not in view.
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Rules and Rulers

Rulers exist along the top and left sides of the main view.
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They indicate location from the center of the hoop. You can switch the rulers between metric and
inches using the radio buttons on the Tool pane or by double-clicking in the size window in the status bar.

You can also drag rules onto the Main view. Move the mouse over one of the rulers and then drag
down into the view. If you later want to move a rule, you can drag it. If you want to remove it, drag it back
onto the ruler.

Magnify

) The Magnifier on the Main toolbar will let you change the zoom in three ways after
S :
you click on the button:

» Left-click to zoom in
* Right-click to zoom out

» Drag arectangle to zoom on just that area. (This will also cancel the tool.)

Note: The Navigation window can alter the zoom too, and we’ll cover that in its own chapter.

Background and Grid

You can alter the background of the Main View. Click the Preferences button on the Main
toolbar. This will bring up the Program Preferences window, which allows you to set many
program and Design Page options. Click on the Grid Settings to adjust them.

Show Grid as: Metric Spacing (mm): Inch Spacing:
Basic colors:

Program Preferences El
{=3 Enviranment 00 _EE
-
4
 Lines Horizontsl: | 10 - = Horizartal: | 1 | il Ul 00| |
" Dots vertical: |10 Vertical: | 1 I .
Mouse wheel e
Check for Updates : -
Ghast Mode = ™ Snap To Grid Reset ko Defaults : : : : : : : =
Digiizing
23 Conwersion C L L el h
Fil
g P'?S Custem colors
rinting
(23 Adiustments o Hue:[3 Red[255
o

Sati[280  Greens [257
CortSold |y [527 e [215

oK | ceneel | Add o Custom Colers |

,Tl Cancel I iy ]

To change the background color, click the Color button, which will display a standard color picker:
You can even create your own colors and add them to the custom colors section.

Select a Custom color and click OK to set the new color.
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Adjustments:

» The Grid is adjustable too. You can alter the display of gridlines by choosing between lines and
dots. You can also set the spacing of the grid, and that can be set separately for both metric and inch
settings.

» The arrow buttons, labeled “>>" and “<<,” will copy the settings from inches to metric and vice
versa. Thus, you can set up a grid that has metric spacing for machine /hoop accuracy, but can
display information to you in inches.

* Snap-to-Grid will help align objects to the grids as you move them in the Main View. As you move in
one direction (up, down, left, right) the edge of whatever you are moving will ‘stick’ like a magnet
to the grid as you approach a grid line in that direction. If you want to overcome the snap-to-grid,
you can pass the grid and then come back in the reverse direction. (Which means the opposite edge
will want to snap to some other grid.)

» Grids do not force you to stick to them when Snap-to-Grid is on. Rather, it merely enables the snap
as you get close, which may help with precision alignment as you move things around.

* Using the menu or the Grid button on the toolbar, you can turn the Main View display of the grid on
and off.

Measure Size and Counts (Stitches and Colors)

% The Measure button on the Main toolbar will set the program in a mode that allows you
to measure items in the Main View.

As you drag the cursor, you are measuring the distance you've dragged. This distance is displayed
on the status bar:

13.8mm x 0.2mm, len: 13.8mm, -179°
To cancel measuring, click again on the Measure button in the toolbar or click the Selection Tool

(arrow) in the toolbar. Items that are selected also have their size, stitch count and color count shown in
the status bar. If nothing is selected, the size and counts for the entire Design Page will be shown.

T1.5mm x 24.2mm Stitches: 2232 Ndls/Cols: 171

Selection

b One of the most common tasks in the Main view is to select items. Using the Selection
Tool (Arrow button on the main toolbar) you can select and move items in the design page.
Select items by clicking on them. This will place ‘handles’ and a dotted line around the selected items.
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Transform Controls

You can also see that items are selected by looking in the Objects view. Another way to select items
in the Main view is to drag a rectangle around those items. Anything completely in the rectangle will be
selected. However, if an object is grouped with something outside the rectangle, it will not be selected.

Ghost Mode

Ghost Mode is an option relating to how the Main View displays objects when not selected. The idea

for Ghost Mode is to make it more obvious which objects are selected by fading out those items that are
not selected.

Left: Ghost Mode on Right: Ghost Mode off

nnnnnnnnn
Ghost Made intensity: 10% —-J—-

Cal\brate Screen
Mouse Wheel
Check for Updates
[l Mode

(23 Adjustments

The intensity of the Ghost Mode can be altered with the Preferences.
Transform Controls

Sizing and positioning of design elements can also be accomplished using the Size and Position
controls panel located on the Tool pane. The first control on this panel sets the unit of measure for the
design page. The choices are millimeters and inches.

* mm | *]30.36 IIDDID%EI | | =1E31E]
Cinch % [10zz [1o0.0% [orr m| =l

The width and height of a selected design element can be precisely set by entering the desired value
in the width and height text box and pressing the enter key. If an exact size is not known, the element can

be sized as a percentage of its original size by entering a percent value in the percent text box and
pressing the enter key.
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NIV 85, 2%
35

g5, 2%

These controls are also updated as a design element is moved or re-sized using its handles.

The element is scaled proportionally if the Scale Proportionally control is locked, otherwise height
and width changes are applied individually.

8]

Locked—Scale Proportionally

Unlocked—Scale Height and Width Individually

Note: If you have sized an element and want to return to its original size, simply lock the Scale
Proportionally control and enter a value of 100 in either of the percentage fields.
Embrilliance will remember the original size even when you reopen the design at a
future date.

Mirror and Rotate

The next four controls mirror and rotate selected elements. Mirroring is about the horizontal or
vertical axes. Rotation is clockwise or counter clockwise in 90 degree increments with the pivot point in
the center of the selection. Alternatively, enter a specific value for the degree of rotation. Enter a positive
value to rotate counter-clockwise and a negative value to rotate clockwise.

0.0°

Centering In the Hoop

*7 | Centering in the Hoop can be accomplished by this button, although it is not necessary
because, as a rule, designs are centered when stitch files are saved. This is also available from the
Utility menu.
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Align and Distribute

Alignment of multiple items can be set using the Align button which will open the Align and
Distribute window. Alignment will place the edges or centers of designs all on one line.

Align and Distribute X Align and Distribute 3
dlign | pistribute | Align  Distribute |
[} £l = | | | | | | | |
2 £ & Bl By B Bo
it I oo ter ™ Right [~ Left ¥ Center | Spacing | Right
o
04 T Top ol Top
ED v Center % Extent of Selection
T )
o W Center I Center on Page & - . £ Extant of Hoop
=ai Spacing
0o
B T gottom —~ 5 I Bottom
Apply | Close | Apply | Close |

If you have two or more items selected, you can align them. For example, these items are Aligned
Left:

Distribution is different from alignment. Distribution places designs equidistant across a span. This
is useful if you want to make regular patterns, such as a tiled design. If you would like items distributed
across an area, move the first and last items to the outside areas that you want to fill. In this example, the
(top, left) ‘A’ and the (bottom, right) ‘A’ make the design size. But notice how the ‘A’ designs between
those are not placed regularly? Distribute will make those ‘A’s into an orderly row:

Using ‘Center’ distribution will distribute these letters evenly, based on each letter’s center.

If you choose a different edge to distribute with, for instance, Left, then the distribution will be made
using the left edges of all the designs. This can be useful to create a geometric composition with different
sized designs.
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The Library Window

The Library/Moddie window is used to merge Embrilliance designs into the current Design Page.

Catalog: IBrlTon Leap LI Import catalog (.bx) | Select Al | Cancel |

A
Applique Frames 1 g D

A v b4 Frame 2 Frame 3

5 OA
. Ay

U D
~3NZ
Accents

Frame 4 Frame 5 Frame &

The Library can have multiple catalogs, which are folder-based groups of designs, based on where
they come from and what category they may fall into, according to the person who made them. You select
a catalog by clicking the drop-arrow in the top, left of the program.

Clicking on a collection icon on the left will result in the designs from that collection to appear on
the right. To import a design, select it and click OK. You can also double-click on a design to import it and
close the window.

Note: In most cases, the merged Library design will be placed on the screen to fit the hoop,
whether the hoop is displayed or not. If you have a very small hoop selected, the library
design may be too complex to be shrunk to fit the hoop. Library designs can be resized to
the desired proportions after placement.

Note 2: Whenever you add any design—whether Library, Lettering, or any design file—it will be
placed in the center of the hoop. If for some reason you don’t see a newly added design,
zoom out so that you can see the center of the hoop.
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The Stitch Files Window
The Stitch Files Window

The Merge Files Window is used to merge existing embroidery files into the current Design Page.

& Open Design Files =)

~
% O T =
Size ED]

Close Import

Browse l &
d- | intll . s‘
g ) 1SS |
5.1 John Deer
AG stuff
A stuff

installer sample for brian = ADORLART ADORLART ADORART

B = =

ADOR4ART ADORLPES ADORZPES

Cihlohn Deeryinstaller CD files.zip » »installer CD files/Files Ta A0D to CD/extras/honus_designs/artista-art/200R3.ART

The Browse view on the left side is called a ‘Tree’ control, and it has a ‘Root’ level, which is left-most
and ‘branches’ that open and close using the ‘+’ and ‘-’. You will also see individual .ZIP files as branches,
so you can import designs directly from within those as well.

On the toolbar, there are controls for thumbnail size and 3D display. The ‘Close’ button will close the
window without importing anything. The ‘Sel. All’ button selects all the designs in the view on the right.

To bring designs in, click ‘Import’.

As with most views like it in Windows, the thumbnail view on the right allows single design
selection by clicking on an item. Select a range of designs by first selecting a design then holding the shift
key down while clicking another design. Additionally, use the control key to click on non-adjacent
designs. This is called a disjointed selection.

You can also double-click on a design to import it and close the window.

Status Bar

71.5mm x 24.2mm Stitches: 2232 Ndls/Cols: 111

The status bar is located at the bottom of the program window. Size, stitch count and color count
information appear on the right side of the status bar. If you have no design selected, then the display will
contain information about the entire design page. If you have something selected, then the information
contains the word, ‘Selected’ and represents only those selected items.

Double-click on the size information in the status bar to quickly switch between metric and inches
on the design page and status bar.

The status bar also has a line of text on the left that can provide additional information about an
onscreen control. Hover the mouse over a control, specifically a toolbar button, and the status bar may
provide additional clarification of what the button does.

. .
B A S G Object View

~

1 Wil Letters;
RPN p— The Object view shows the designs that have been opened or merged
21 A Carioner e onto the Design Page and objects within those designs.
22 Vellow
23 Light Blue
24 gy Emerald Green 21

25 Pink

26 Frued Deep Rose >
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Notice that the designs are numbered in the Object view. The designs or objects are numbered in the
order that they have been opened or merged onto the design page. In the illustration above lettering was
opened onto the Design Page first. So, it has been numbered 1. The following merged design is number 2
in the sequence. When re-sequencing objects the numbers will change accordingly.

Using the Object view designs may be selected, sequenced and deleted. The Object view can display
individual objects within designs where allowed. Stitch files (merged embroidery designs) are one
example of a design type that allows the display of individual objects within the design. Clicking on the ‘+’
at the left of the design will expand that design in the Object view. Under that design will then appear the
individual objects.

Using the Object view, objects may be selected, re-sequenced or deleted.

Selecting
@ Using the Object view you can select any number of Designs or Objects,
= ~ regardless of whether or not they are locked, hidden or grouped. This allows for
LT —-— editing of objects or designs without ungrouping. For example, the following design
21 o [ is all grouped so that it can be moved around the page as a single design. However,
22— vl you may want to select just the second color to change it, re-sequence it or even
< delete it.

24 Hged Emerald Green

The toolbar on the Object view also has selection options including ‘Select All’ which is the first

button on the left. If the Main view is active you can also type Ctrl-A to select all or you can use the Edit
menu for this option too.

Reverse Selection

The second button will reverse the current selection. This means that whatever you have selected
will no longer be selected, but everything else will become selected. This is useful when you want to
delete everything except for a single design element.

Range Selection

Using the Object view you can select multiple designs or objects. If a single object is selected, use the

shift key while clicking a second object and this will select a range of objects: Everything in between the
two will be selected.

Disjointed Selection

If you use the Ctrl key while clicking on objects, you can singly select designs or objects. To de-select
an object that’s already selected, Ctrl-click on it. This will reverse its selected state.

Graphical Selection

Drag a rectangle around objects in the Object view to select whatever is in the rectangle.

Note: Dragging enables Auto-Scroll, and your view will move allowing you to select items that
weren't initially visible.
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Object View
Selecting by Color

If you want to select all objects of a given color, select one of the objects as described above. Then
use menu option, Edit->Select by Color. This will find and select all the objects on the page that have
those same colors in them. This is a handy feature to change the color of several things at once.

Auto-Scroll

As you drag on the Object view, you may come near the top or bottom edge. This will cause the view
to scroll thus enabling you to drag into a position that's not currently in view.

Locking

If you want to prevent designs or objects from being selectable in the Main View, you can ‘Lock’
them. Locking an object does not affect its grouping; it only prevents it from being clicked on. The second
button, a white lock with an ‘X’ on it, will not only lock the design or object, but will prevent it from being
displayed in the Main View.

To unlock something, click the third lock, which appears as an open lock icon.

Note: Locking does not prevent you from selecting it in the Object view, where it can be re-
sequenced, copied, or deleted.

Sequencing
oo « The sequence of objects and designs can be changed using the Objects
= °§1 m{im = view. One way is to right-click on a selected item which will cause a pop-up
L ol menu to be displayed. That menu has options to move items earlier or later in
the R —— sequence.
22 m . .
[ poecety You can also drag and drop items in the tree to re-sequence them.
zj N Dropping an item (let’s call it ‘B’) on another (called ‘A’) will place that

dropped ‘B’ item right after ‘A’ in the sequence. If you drag an object onto the
design icon, then that drop will be placed at the head of the design.

Re-sequence selected designs and objects using the ‘Sequence Objects’ command on the Edit menu.

Deleting a Color

Often you will want to delete a section of stitches from a design that has been merged. When those
stitches are all grouped as one color this is easily accomplished using the Object View. Open the design
using the ‘+’ in the tree. Next, select the color you want to delete. Next, choose ‘Delete’ from the Edit menu
or use the ‘Delete’ key on your keyboard.

Below, the first color of the design is selected. Simply press ‘Delete’ on your keyboard to remove the
first color along with the stitches associated with it.

Note: Another way to delete is to use the menu, Edit->Delete.
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one: ————CH x|
ARG ARG
[=] 2 103096 s = 2B 103900 |
21 21 Yellow
22 Yellow 22 Light Blue
23 Light Blue 23 %uge¥ Emerald Green
24 Fge¥ Emerald Green . 24 Pink 3
25 Pirk 25 Fgl DeepRose
Left: Color is selected. Right: Color has been deleted.
The Property Sheet
[Properties 1] When you have design or object items selected, there may be
Cobr | Letters | sich | properties that you can adjust. The Property Sheet contains individual
e | [1con | prefared || iproharty Pages’ that let you adjust the selected items. The pages are
Click below to change individual colors,
1: Madsiia displayed as tabs. Click on the tab to work with the design or object
- . items that are selected.

If nothing is selected, the Property Sheet will display the Color
property page, which in turn will show every color in the Design Page.
This is a convenience that allows you to change colors on the page.

Note: Sometimes, users will confuse the Colors property tab with the Object View. You cannot
select anything using the Colors property page. This page merely reflects what is selected
and lets you change the colors on display.

The individual tabbed pages that you see will depend on the designs and objects that you have
selected, and we’ll cover those individual controls in the respective sections for the design types;
Lettering, Embroidery and Library designs.

Sewing Simulator

The Stitch Simulator lets you see how the design will sew out by sewing on the screen. It is activated

by clicking the Stitch Simulator tool in the View tool bar or selecting Stitch Simulator from the View
menu.

Stitch Simulator controls

100IDars anad Winaows., .

f v Metric

| v Draw stitches in 30
Draw Hoop

| w Draw Grid

|

Stitch Simulator

Hoop Size...

Stitch Simulator Controls
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The controls are easy to use and give complete control of the simulated sewing process.

Player Control: This control lets you sew forward, backward and stop. The right arrow starts
sewing forward. The double bars stop sewing. The left arrow starts sewing backward.

Step Stitch Control: This control lets you sew one stitch at a time forward or backward. Right
arrow: forward, Left arrow: backward.

Speed Control: Use the slider to change the speed of sewing. Move to the left for slower or to the
right for faster.

Manual Control: Click and drag this slider forward or backward to quickly move to a particular
section of the design.

Insert Color Stop: Click the Stop button to insert a color stop in the design. This allows you to

change colors on the fly. Or creatively use this to isolate parts of the design that you
want \ to remove or isolate. When you insert a stop, the color window will appear to let you
pick the color you're changing into. Make sure you pick something different. Once you have

picked a color, the Stop command will be inserted in the stitches at the point of the
simulator, and the new color will appear in the Object view.

Preferences
- There are a number of preferences for the program and design page that can be
adjusted. Click on the Preferences button to reveal these controls.

Embroidery Hoops

In the Preference window, under Environment, you can choose a hoop. Hoops are displayed in a
sorted list, organized by embroidery file format. Most embroidery hoops are made using the metric
system, so the sizes for the hoops are displayed according to the way the manufacturer sells the hoop. An
approximate size in inches is also shown.

There are many hoops that are built into the program, and you can add your own. As the program
updates over time, or if you have edited a hoop, use the “Defaults” button to restore the program to the
hoops provided. The “Default” button will not, however, remove any hoops you’ve added yourself.

Optional by product: Depending on which products are licensed, some multi-position hoops may be
listed - they have “Multi” listed after the size. Designs will automatically split upon the Save and a text
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file will be created with the stitching instructions. See the section on “Multi-position Hoops” for more
information.

Many times you will want to sew a design sideways in the hoop. But rather than laying out your
design sideways, it might be convenient to have the hoop displayed as rotated. Checking the “Rotate 90”
button accomplishes this. Double-click the hoop indicator on the status bar to rotate the hoop 90°.

You can create hoops and edit hoops too. If you use the word, “Round” or “Oval” in the name, your
hoop will be drawn using that shape. When you create a new hoop, it will become

Mew Hoop [z|
Marne: 200rnrn 2 300
Wyidth (rnnn): 200
Height {rrm};: 300

(8] 4 Cancel |

the selected hoop. If you have added a hoop, or if you decide to have the program display only the
hoops that you own, you can delete hoops from the list, using the “Delete” button.

The width and height fields are self-explanatory, and you can name your hoop as desired. Hoop
names should be unique.

Note: Do not create a hoop that is bigger than the sewing field of your embroidery machine.

{3 Environment
% Hoops
Grid Settings
Calibrate Screen
Mouse Wheel
Check for Updates

Hoop Ste:
@ Nomal " Muti-Postion

Ghost Mode
(23 Conversion
(23 Files
(21 Printing
(23 Adjustments

Sewing Field fmx bl
130 mm x 180 mm
or approx: 5" x 7" N

oK Cancel | mopy |

Left: Hoop selection. Right: What a hoop looks like in the Main View.

When you create a new hoop or modify an existing hoop, you are really defining the embroidery
field, not the physical dimensions of the hoop. You must know your machine’s embroidery field as you
cannot use a hoop that is larger than what your embroidery machine can sew, unless you are creating a
multi-position hoop, which we’ll discuss separately in the Multi-Position Hooping section.

Check the status bar at the bottom of the window for hoop information, which displays the selected
hoop size whether it is visible or not. Zoom out to find the hoop (if it isn’t hidden by your design).

Note: If your program is licensed to use it, there is one hoop, the .PES Jumbo 14” hoop, is shown
in both the Normal and Multi-Position section of the Hoop Preference. Using either
selection will create the correct file for use with this hoop, however, the Normal version
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displays it as a single sewing field, and the Multi-Position version shows both fields in

use.

Graphics Scale / Calibration

The Main View is calibrated to a real-world scale for precise display of designs. Use the

Preferences Window to calibrate your display for real-world size:

Program Preferences

i3 Environment
Hoops
Display Settings

Mouse Wheel

Ghost Mode
& Conversion
21 Files
3 Printing
2 Adjustments

[q Graphics Scale / Calibrate

Move the slider until the line is 2 inches long, or 5 c¢m if you have the
‘Metric' box checked. This calbrates your screen scale.

¥ Metric

|
I

Check for Updates | | | | |

Handle Size: 100%

|
I

o]

Hold a ruler up to your screen and adjust the slider until the measurement in the program matches

Cancel | Apply |

your real-world ruler. This will help you better estimate real design size while editing designs.

When digitizing, using a multiple of a real-world scale is very productive. If you operate at a set of
scales that are consistent (typically 3x and 6x) then you will not be tempted to add extra nodes
along your outline, and you can ignore details in the image you are digitizing which would be too
small to digitize effectively.

The DPI set by this calibration is also used to other graphics within the program to display at a
useable size. High-DPI systems like 4K laptops can make images appear very small without this.

On this property page there is an additional scale called ‘Handle Size’. The handles are the graphics
you place the mouse over on the main view so you can drag: Sizing, rotating, outline nodes, etc. It
will also adjust the size of the rulers at the top and left of the screen. The handles will scale with
the main calibration, but this slider allows you to increase/decrease the size of those handles. This
can be useful to accommodate small displays, accessibility issues, hi-res monitors, etc.

Handle sizes can be varied depending on preference, monitor, etc.
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The Mouse Wheel

The Mouse Wheel can be used to zoom the Main View. It can also be used to scroll the page up and
down. We recommend that you use the setting that allows for zooming as this is more useful to most
users. The Zoom and Pan feature will center the view at the point of the cursor while zooming.

Program Preferences

=3 Envi t
nvironmen Mouse Wheel:

Hoops
3 " Adjusts Zoom

Display Settings
Graphics Scale / Calibrate (" Scrolls Window
¥ ® Zoom and Pan
Check for Updates
Ghost Mode
1 Conversion
3 Files
3 Printing
3 Adjustments

File Conversion

Designs can be saved into many different formats. The Conversion Preference allows you to adjust
some parameters when you save in those different formats.

Program Preferences

Format:  |pES - (% se version 5 and laker For real threads

" Farce version 1
Maximum Colars: | 127
Machine specific:

[ Allow 180x 300 haop (PES v6)
™ Write file For & Meedle when required

(3 adjustments

The file format itself may have inherent limitations on the number of colors or stitches, such as the
16 color limit in .PCS. But there are also machine limitations too. Older machines that use the .PES format
had limits of 100 colors, whereas the newer ones can go to 127. To help you save files correctly for your
machine, there are options for some formats, such as .PES.

PES Files have to support two distinct machine types, and also have different data for the support of
card reader/writers that many .PES machines required. Let’s look at the .PES options more closely.

“Use version 5 and later for real threads.” This setting exists because the version 5 of the Palette/PE-
Design software, which invented the .PES file, added support for real thread colors. This was a wonderful
addition for this format. However, if you own an earlier version of the software, and you want to use files
created in Embrilliance, then you need to leave this set to “Force version 1.” The reason is simple: The old
software simply cannot open those version 5 files.

The machine specific settings are for machines like the Ellegante, which takes the 180 x 300 hoop
(while other machines may not be able to accept this hoop, so why write a file for it.) Or the multi-needle
machines that have their embroidery field rotated to a landscape position. So a 200x300 or a 300x200
field, while technically the same size, have different rotational parameters.

Certainly you know if you have a multi-needle machine, or require the use of older software to write
your card. If not, or if you are distributing these designs, please just leave the settings as-is. The program
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actually finds a Lowest Common Denominator in the format that it will output, making the file available
to the widest range of users.

Program Preferences X

(2 Environment R m
f3 Conversion [¥ Center on open
% Conversion Maximum Colors: |0 [¥ Center on save
Stitch Format [+ Return To Origin
[ Files Commands fortrim: |3
(23 Printing
(@ Adjustments [~ Ensure Trims afier. [0 stitch pts.

oK Cancel | Apply ‘

DST and EXP Files have a different type of information contained in them where it pertains to jump
stitches. Rather, those formats have to have some number of “Jump” commands in a row before they will
cycle their thread trimmer. When making a DST file, and converting from something else, these jump
commands need to be translated. As machines differ in setup for the number of commands needed to
cycle the trimmers, we offer this setting in the conversion preferences.

DST files also have the ability to place themselves anywhere in the hoop. By default the program will
center designs when opening and saving, however users of commercial machines may require this to be
turned off. Use the checkboxes ‘Center on open’ and ‘Center on save’ for this purpose.

Some commercial embroidery machines do not automatically return the needle to the start of the
design. The option Return To Origin will add these commands to the end of a DST file.

Preferred Stitch Format

Most embroiderers have one machine or other that they use most for embroidery and that machine
has a format that it uses. To save time, the format that you choose here will automatically be selected
during the save.

Program Preferences El

(2 Environment Format: [pes - | Setthis as your preferred stitch Format, which
=3 Conversion gets saved along with a working file when you
Conversion choose 'Save from the menu,

(22 Files
(23 Printing
(23 Adjustments

QK Cancel I Apply |

Note: Even though you have set a preferred format, you can still choose File > Save Stitch File As
if you need to occasionally save in a different format. After selecting a new format in the
‘Save As’ dialog box that format will “stick,” overriding the Preferred Stitch Format until
you either reselect the preferred one or select a new one.

Note about SHV: Setting the preferred format to SHV does not create the file structure your
machine may expect to see. To create a proper Designer 1 diskette or stick, please read
the section on Creating A Designer 1 Disk or USB Stick.

Jumps / Overlaps

There are several operations that occur during the process of saving a stitch file.
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Program Preferences X

(X Environment
‘3 Jumps / Overlaps
% Jumps / Overlaps

[ Remove overlaps when saving stitch files.
[ Treatobjects labelled "applique pos" as filled.

(C1 Conversion [+ Ensure ties surounding jumps.
23 Printing [+ Runwhen jumps are small.
(3 Adjustments Minimum jump length: ’Wﬂ

Run stitch length: 1.0 mm ﬂ
Prefer hand trim below: 0.0 mm ﬂ

OK | Cancel | Apply |

The ‘Remove overlaps...” setting, better known as ‘Remove Hidden Stitches’ or ‘RHS’ will let the
program run a process to remove stitches in one design that will be hidden by another design.
This does not affect objects within a design, as those would naturally be hidden or not as dictated
by the digitizer.

Removing overlaps allow you to merge designs onto the page with them touching or
overlapping each other. This operation is common in graphics, but stitches are not graphics.
Adding one design on top of another will cause excess density and can break needles, ruin projects
and all the accompanying misery that comes with it. By removing those hidden stitches, using our
patented method, you will find that your composition sews without the density headaches.

Overlapped appliques are even harder for software to handle. Where layering in stitches is a
concern, layering of applique fabric has extra considerations. The program has color settings
where the user can tell it that a certain color is a specific applique step. With this information, the
program can avoid performing RHS on appliques, as necessary.

Jump stitches are created when, within a single color, the needle must travel across the design
without sewing stitches. Jumps are normally trimmed by hand or machine. Sometimes there are
merged designs which have jumps that the digitizer assumes will not be cut, such is the case with
many commercial designs. When the digitizer decides not to cut the jump, they don’t usually leave
a tie-off stitch, which prevents the thread from unravelling after the jump gets cut.

Ensuring that there are tie-offs on either side of a jump will allow you to cut those jumps even
if the person digitizing the design hadn’t planned for it.

Jumps have other parameters, usually concerning commercial embroidery. For instance, an
embroiderer may prefer to hand trim, or have the option to hand trim, small jumps. In commercial
embroidery, these are often left untrimmed.

Sometimes jumps are short enough that the machine can place a stitch or two instead of
jumping. This process, called, “nesting a stitch,” saves the machine operator time by not having to
cut and not having the machine cut, which takes many seconds, cutting production efficiency. The
setting, “Run when jumps are small” allows you to set the size of a jump that may be nested with
stitches and the ‘Run stitch length’ controls how many nested stitches will be created. A short run
stitch, such as 1.0mm, or even smaller, will nest well in most fabrics, but you don’t want a long run
of small stitches, which is why the ‘Minimum Jump Length’ parameter is there.
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Auto Recover

Auto recover will save your file in a separate space every so often. This is adjusted using the slider.
This feature is useful when working on a complex arrangement where a power outage or program crash
(unlikely) or freeze by the operating system (it happens) could force the program to quit and you might
lose your work. If you are working while power-outs are happening, well, turn this on. Please don’t run
your embroidery machine when the power is unreliable, as brown-outs are not good for them.

Checking For Updates

The program can check for updates if it is running on a system connected to the internet. This will
occur once each day, the first time that you run the program. The program does not send your
information or anything about you or your computer to us. It merely checks the current version available
online for your program and if there’s an update, it lets you know. If you don’t want this, you can turn this
off.

You can also check for updates at any time from the option in the Help menu.

Color
e <l Color is surprisingly influential. We may be initially attracted to or
Thead... | [Ldore. | _profomed | repelled by an item or design simply because of its color. The ability to

view e designs in realistic thread colors is an asset to the embroiderer.

2 velow You may want to recolor a design to better suit your tastes, to

2% Lioht S coordinate with the threads you have in your stash, or to color a design
that e you’ve converted from a format that doesn’t hold color settings, such as
'DST' 5 Pink

B Deep Rose When you merge a Library design, create a lettering design, or
merge i a stitch file, the objects come in with the colors and the thread brand that
the designer has assigned—even if you have another brand specified as

preferred (more on that in a bit).

If the merged stitch file is a .DST file or other format that does not hold set colors, then threads
cannot be matched to any thread brand and will simply be a list of generically named colors.

Tip: If you'd like to get an idea of how your design looks on a particular color, you can change the
background of your main window in Environment -> Grid Settings in the Program
Preferences.

Changing colors is done via the Color tab on the Property Sheet, which is the lower panel on the
right hand side of your screen. The color tab displays the thread sequence of the design. Selecting a color
swatch on the tab doesn’t select anything in the design; it simply allows you to select and apply a
different color from any of the thread brands loaded into the program.

When first getting acquainted with Embrilliance, it may be confusing to see what looks like two
color lists. The top list shows a tree-like structure of all the various objects in the current main window.
This includes Library designs, letters, and any merged files. In the sample shown below, a single design
has been merged and the design has been opened in the objects panel so that all the various objects can
be viewed.
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Because this is a stitch file, each object is all the stitches that are contained within a given color. In
this instance, when you compare the object list next to the color list, you'll see that they match. For
example, object 1:6 corresponds to color number six in the following samples.

onec @ Cix
Gy By .rﬁﬁ .rF> Color ] Stitches ]
~ Thread. .. | 1 Colar... Preferred
) R | ""wl-n Oyl recolared = |
Click below to change individual colars,
11 ™My Madeira Thread Chest 1164 Gun Metal Grey 1: Madeira Thread Chest
1001 white:
1.2 Madeira Thread Chest 1127 Pastel Peach

1.3 ™mygme Madeira Thread Chest 1000 Black
1.4 Madeira Thread Chest 1071 Winter White
1:5 "w‘ Madeira Thread Chest 1385 Dark Burgundy

16 Madeira Thread Chest 1001 White

1.7 % Madeira Thread Chest 1164 Gun Matal Grey

U (. T S bt
< | =

The color tab shows the colors of the currently selected object(s). If nothing is selected, the list
shows all the colors on the current design page. Select areas of your design by clicking them in the object
list. Select more than one area by holding down the Ctrl Key.

. OF] T o
cEgEE R G Color | stitches |
-
11 “geen Ol recolored d |Thraad... | 1 Color... ‘ Preferred
Click belaw to change individual colors,

1: Madeira Thread Chest
1164 Gun Metal Grey

R P [Madeita Thread Chest 1164 Gun Metal Grey|

1.2 Madeira Thread Chest 1127 Pastel Peach 2 Maeiia Thiead Chest

1000 Black

B [1adira Thread Chest 1000 Black
3: Madeita Thread Chest

1:4 Madeira Thread Chest 1071 Winter White 0Tt

15 "8 Madeira Thread Chest 1385 Dark Burgundy

16 Madeira Thread Chest 1001 White

Madeira Thread Chest 1164 Gun Metal Grey

W
R . T, - v
< | B

The colors list only shows the colors of the selected items.
Thread Brand and Color

There are three buttons across the top of the Color properties tab:
* Thread... Select a thread library to use and set a preferred thread brand
* 1 Color... Make the design monochromatic (one color)
* Preferred Change the colors to the closest match in your preferred thread brand

To change a thread color, simply click on the color swatch that you wish to change on the Color tab.
The Thread palette will open with the color selected in the original thread brand specified by the
designer. You can select a different thread line from the drop down menu and the program will find the
closest match in that chosen thread line.
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M Thread Brand Conversion

Select a thread brand From the lisk:

1Madeira Thread Chest _v_J Cancel ]

Coats ~
Coats Sylko ~pis thread brand.
Floriani

Gukermann Dekor

and

Hemingworth

Isacord Poly

Isafil Rayon

Kirgstar

Madeira Poly

Madeira Rayon

Madeira Thread Chest

Marathon Poly

Marathon Rayon

Paly-x40

Robison-Anton Polyester
Robison-Anton Rayon

Stickma Palyester =
Sulky Rayon A

Embrilliance includes a wide range of popular thread brands and lines.

Note: In the case of a DST, TAP or EXP file, the Color tab displays a list of generic color names.
This is because these formats have no color information in them. Using Embrilliance you

can color these designs, and when you save the working file, the colors will be saved
therein.

Similarly, PCS, PCM and HUS formats have limited color palettes. Again, saving the working file will
preserve your colorization, and you can print colorized design templates and color information. This is
especially handy for commercial embroiderers.

Clicking one of these color swatches will open the thread brand that you have set as preferred
(Madeira Thread Chest is the default). To change the color, navigate to the desired color and click OK.

oo e

Color |
.. | [icaoe ] metered |
ok below to change individual colors.
1 Black

™ Thread 3]
[Madera Rayon =l 5:""::\'; o |
[e] ©mmber  coc

275 Madesa Fiayon 1171 -

Search:

2Bie

277 Madera Rayon 1109

278 Madera Rayon 1232

273 Madesa Rayon 1031

280 Madesa Rayon 1235

281 Madera ayon 1188

282 Madesa Rayon 1388

-

.DST file shown with generic colors and the thread palette displayed.

Some thread lines only have thread numbers, while others have numbers and color names. You can
search either line by thread number but you can only search by name if the threads have color names.
Type in the color or thread number in the search box and click ‘Go.” Or, you can simply scroll through the
list and pick one that appeals to you. Once the color is selected, click OK to apply it and close the Thread
palette.
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B Thread M Thread

adera Tvesdchest =] 3201 m g o
Search: [1019] EPW Cancel Search: Elf‘m Cancel
14: Madesa Thiead Chest 1110 Medum Rose & 13 Madena Thread Chest 1037 Light Red ~
15: Madena Thiead Chest 1117 Deep Rose 14: Madeua Thread Chest 1110 Medum Rose
16: Madeira Thiead Chest 1309 Hot Pink 15: Madewa Thread Chest 1117 Deep Rose
17: Madexa Theead Chest 1120 Pastel Orchid : Madeua | hread Chest 1309 Hot Pink.
18: Madeira Thread Chest 1107 Coral 17: Madena Thread Chest 1120 Pastel Orchid
19 Madera Thread Chest 1108 Mauve 18: Madeita Theead Chest 1107 Coral
20: Madewa Thiead Chest 1116 Pirk 19 Madesa Thiead Chest 1108 Mauve
1: Madesa Thread Chest 7075 Medum Peach 20 Madena Thread Chest 1116 Pink
22 Madera Thiead Chest 1053 Pastel Mauve 21: Madeita Thiead Chest 1019 Medum Peach
L b

Threads can be searched by number or name.

The ‘Thread... button allows you to change thread brands or to set a preferred brand by choosing a
thread brand from the drop-down list. Once a preferred brand is selected, you can easily change all of the
colors in any design to your preferred brand by clicking, “Use this as my preferred brand.”

B Thread Brand Conversion |g|

Select & thread brand from the lisk:
IMadeira Thread Chest Ll Cancel |

&l selected objects will be corverted ko this thread brand.

Use this as my preferred brand |

A thread brand can be selected on a per-design basis or can be made preferred.

Note: Be advised that while this may be convenient for you, if your design has carefully chosen
and blended colors, converting brands may cause a less than desirable result—especially
if a “close match” does not exist in the new brand.

Left: Original Hemingworth colors. Right: Shown using Brother Flesh Tones.

The color list does not name the areas that are colored. For example, suppose you want to change
the pink shorts on the mouse design to blue. An easy way to do this is to find the area in the Object panel
and select it. The color is now isolated in the Color panel and you can easily click it and select a blue.
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Color
Ell v omeas R T
BhamG DA sG
= 13 lgs00301 - 1& Igs00301

11 Hemingwaorth 1006 Gentle Bush 11

12 Hamingworth 1049 Dried Banana 12 Heminguorth 1049 Deied Banana
| mmm -
14 Hemingworth 1006 Gertle Blush 14 Hemingworth 1006 Gentle Blush
15 "% Hemnguerth 1006 Sweet Pes 15 " Hemingworth 1008 Sweet o
1% Hemingworth 1001 Pure Whits 15 Hemingcrth 1001 Puse Whits
17 %wmﬂmzm 17 %mmmmxw

18 Hamingworth 1049 Dried Banana 18 Hamingworth 1049 Drisd Banans
19 ﬂmlmmm 19 ﬂmmmmmmm
s [roeies S«
Cokor | Cobor |
ik below to change indrvidual colors.

ik below to change indrvidual colors.

1 1
= =

Coloring Letters

Coloring Letters works a bit differently. To color individual letters, click on the center of the letter to
select it. Then, as before, click the color swatch to select a new thread color.

Color |
e = F | |
Y - - N = Chick below to change individual colors.
w ¥ v v Led -
T 1: Madeira Poly
F i k :\. : :}\ N 1675
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Printing

A design template showing the design at full size and with registration marks can be printed. Just
choose print from the File menu.

(3 Environment
(Z3 Conversion
(23 Files

Printing

g Print Setup
(Z3 Adjustments

[v Print with a realistic rendering fwon't show jumps ) [V Print Color Sequence
¥ Print crosshairs [+ Print Applique Outline
[ Design Only o test) [ Print Stitches
I” Selected Colors Only [ Print Applique
[V Mimor fransfer paper)

s

On the left are common options for printing templates. This includes 3D and crosshairs that mark
the center of the design for hoop placement. Also you can choose not to print design information (Design
Only).

Applique printing with Essentials and StitchArtist

Several options have been included for use with Applique. See the Applique section for images and a
description of using the Applique.

‘Selected Colors only’, can be used with machines that will scan and cut. By printing only an outline
you could make it easier for those machines to scan the shape you need.

When printing an applique for hand-cutting you probably want to turn the ‘Print Applique Outline’
mode on so that you have a clean dark line to cut on.

The ‘Print Stitches’ option may be turned off to print a background image, for use with creating a
photograph as an applique via printable fabric or transfer fabric. There, you want to print the image, not
the stitches that will be applied over top.

‘Print Applique’ is a setting that turns on printing of a selected Simulated Fill or photograph (on the
applique tab of the Color Window.)

‘Mirror’ is useful for transfer paper as the image will be reversed.

Other Printing Options

‘Print Color Sequence’ adds a separate page with all the colors. See the following images:
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Print E|®
Printer
Heme: Propetis..
Status:  Ready

Type: Adobe PDF Converter
Where: My Documents

Comment: [™ Print to file

Print range Copies

= Al Number of copies: 1 Eﬁ

" Pages fom: |1 to: - L
CRPCEH

2 1

The template can be previewed before sending the output to the printer. Below is a sample template
with a monogram surrounded by a frame. Note the registration marks.

The second page of the worksheet displays size, stitch and color counts, and a list of the colors used
in the design with approximate thread requirements.

12.53 cm x 4.02 cm : 4180 Stitches, 4 Colors

Color 1: Brother Embroidery Applique Pos.
61 stitches, 1.0 meters
Color 2: Brother Embroidery Applique Mat.
59 stitches, 1.0 meters

) Color 3: Madeira Poly 1710
s » 2779 stitches, 9.6 meters
Color 4: Madeira Poly 1637
W 1281 stitches, 4.5 meters

Printing preferences, found in the Program Preferences window.

Lettering

Creating a simple letter design or monogram is, well, simple! Just click the Create Letters
tool found on the Design Toolbar. This action will place the new lettering in the center of the
design page and display the Letters Property tab.

Design Toolbar
Types of Lettering

The Embrilliance platform supports two types of lettering:

1.) Built-in Fonts
2.) Stitch file collections (Imported Fonts)
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The built-in fonts are based on our software, and offer many features, and are available in
purchased products, such as Essentials or Font Collections.

Stitch File collections are those brought in as a .BX file which installs a font from an outside
digitizing source, such as a font provider on the internet. Stitch File fonts also can be created using our
AlphaTricks product. When using a stitch-file font, your ability to re-size it will depend on what products
you have licensed. AlphaTricks and Essentials will both let you re-size the fonts and recalculate their
stitches, whereas the free Express Mode will not.

This manual section will present the basics of manipulating lettering, which works nearly identical
regardless of which font type you are using.

About Built-in Fonts

If you have a product with built-in fonts, the program gives you significant control over them. The
specifics vary depending on which lettering style you're using, but in general, you can adjust the font,
color, size, aspect, center, rotation, mirroring, slant, kerning, layout, stagger, sequence, envelope shape,
stitching properties including density, underlay, underlay density and compensation (which can be used
to increase boldness) for the design as a whole. Furthermore, you can adjust the color, size, position,
rotation, kerning, aspect and mirroring down to the individual letter. You can adjust the letter sequence
for Monograms so that letters may overlap exactly how you want them. And if you do overlap your letters
within a Monogram, the hidden stitches are automatically removed for you so that the design sews out
nice and flat. For fast and easy Monogram setup, you have 14 Quick Styles to layout your design, including
Vertical, Square, Oval and Diamond.

When sizing letters, your letters automatically switch to a fill-like satin stitch. This looks like a fill,
but unlike a fill, the stitches maintain the beauty of the curved satin column. Another benefit of this is that
fonts can be made far larger than ordinary embroidery fonts - some as tall as 8”.

To make the fonts even more versatile in size, automatic adjustments are made for you to help the
letters sew in a smaller size than they would in other programs. For instance, when you make the letters
smaller, narrow satin stitching is automatically adjusted to keep long-enough stitches to actually sew.
Although some small designs look good on screen, they won’t embroider well. The fonts in the program
protect your stitching automatically.

Multi-Line text offers line spacing options. Circle Text lets you keep on typing, right into a spiral!

The platform can further be extended by adding font and design packs, now available from your
favorite digitizer, sewing machine dealer or online at http://www.Embrilliance.com.

Monograms vs. Letters

Traditionally, monograms were a single letter—“mono” meaning one and “gram” referring to the
letter. Today most monograms are three-letter combinations with the center letter larger than the outer
two.

Fonts or letters styled specifically for such monograms are prefixed with “MGM” to distinguish them
easily from more standard fonts. Of course, you can make a monogram with any font style and use the
enveloping features to shape the design.
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Lettering

Monogram using MGM Diamond

Properties n IE‘
Color  Letters | Stich |

=

Teut: | BB

‘ ABE MGM Diamand j j

g&jﬁ: ‘ABC Marmal

Sewing
Order:

Led Lo |

|a-gc

Slant: —J— ﬂ

Space: J— ﬂ J
Taop: ’—L| — l— -
Battom: ’—L| _J_ ﬂ

Monogram Properties on the Single Line Page

Now, set the monogram to your desired value by typing into the Text box and pressing
the ‘Enter’ key.

lies n @
Letters l Shtch ]
=|—] O
g

Single line of text or Monogram
Monogram

=i

Selecting Letter Type

Although the fonts prefixed with “MGM” are designed for traditional three-letter monograms, you
are by no means restricted to three letters. For example, if you just want the large center letter, enter a
space and the character you want.

Type a space before a letter for a large single letter
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For fun, you can use a monogram font with entire words. This method works best with all capital
letters and fairly short words.

Sample above uses MGM Rounded applied to a word.

Overlapping letters are sometimes needed for your design, and when you do that within a lettering
object, the stitches that are hidden get removed automatically:

Customize the Design

The Letters Property tab provides a number of tools that allow the design to be customized.
There are three basic styles for lettering:

e Multi-Line Text

='| O | + Single line of text or Monograms

* Texton a Circle

The lettering design can switch between these styles using the three buttons at the top of the
property tab as shown above.

Multi-Line Text is useful when you want to enter an entire saying, poem, etc.

This is multi-line text

The little dog laughed
To see such ...

etc
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ABC

Set

ABC =« -7

(" Left ™ Center { Right

Slant:

[ o
5|
Space; Jl ﬂ
wiard Spc: _} ﬂ
Line Spc: _I ﬂ

Text: |.¢\BC

| ABC s |7
uick

gt'fle: ‘ABC Marmal j

Sewing [, -

Crder: |'ﬁ' B-C j

Slant: —J— -0-
Space;  —— |— -0-
Top: Curve v —J— -0-
Bottor: |Curve -« —J— -U-

Lettering

Single line of text or Monograms is useful for entering a single line of text or a Monogram. With a
single line of text there is more flexibility in the shape such as the enveloping feature. With Monograms

there are some fun Quick Styles that re-shape the 3-letter monogram and when overlapping the

monogram letters the Sewing Order finishes the look.

Circle Text wraps lettering around a circle. If you overflow the amount of letters that can fit on the
circle, you will see your text spiral outwards. To see the text on a circle, you will have to adjust the

‘Radius’ of the circle using the slider.

Text: | LEC

[ Place on bottomm

| ABC =+ |7

Radius: 100.0mm = 3 {7 /8"

I
15

Slank: Jl )

Space: Jl ﬂ
Word Spc: Jl ﬂ
Line Spc: Jl ﬂ

Spiral text starts in the center.

0©eS

d
o O o
L O =
e Q

When writing on a circle, you have the option to put text either on the inside or outside; when
embroidering, we usually think of this as text at the bottom or top of a circular patch or badge. To switch

this, use the checkbox labeled “Place on bottom.”

Monogram Font and Quick Style

The font and style are changed using the selections in the Font and Monogram Style boxes.
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Color  Letters | stich |

—=lol
Text: I.msc
{ EHB MGM Diamond L| j
gtl;f: ’ABC Normal j

Sewing
Order:

= Wertical
H TEN

Slant:
Space: AE Square Left

Top: EA Square Right

Bottom: ABc Oval v

Monogram Quick Style menu

When lettering is initially placed on the page, the letters are automatically kerned (letter spacing)
for a good visual effect. Note that these styles are designed to accomplish traditional monograms, and
therefore some only work properly with two or three letters.

Characters in a Font

Some fonts may only have uppercase letters. If you're using a font and not seeing the desired
characters, clicking the ‘7’ button to the right of the Font box; it will display all characters available in the
selected font along with size recommendations.

Available Characters @ Available Characters

9 Block 9 MGM Diamond

</ </
ABCDEFGHIJKLMNOPQRSTUYWRYZ ABCDEFGHIIKLMNOPQRSTUVWRYZ
abedefghijlkimnopgrstuvwncyz Minimum recommended size:  20mm
0123456789 Maximum allowiable size: 200mm
I"#$%RE () +, - ) <=2 @]~ _{}
Minimum recommended size:  Smm
Maxirum allowable size:  7Smm

Characters available shown with recommended size ranges.

Navigating the Font list

Color  Letters | sttch |

E=lo]

ABC

| ABC s |2l
RBC achd test o
({Mg # adine Script 10mm
ABC s

Baushaus

Block

Typing 'arial r’
will put you here

Some of you have a zillion mapped fonts. Great! But you have the long list to scroll through. Click the
arrow to pop-up the list of fonts. Now, type the first few letters of what you're looking for. You can type
and even backspace.
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Slant and Space

The slant of a monogram and the spacing of the monogram letters are controlled with the Slant and
Space slider controls. If you use these controls and want to return the monogram to its default settings,
simply click the zero control. This will restore the default setting. The Slant gives an italic effect to the
monogram.

Enveloping

The envelope (containing top and bottom outlines) of the lettering (single or multi-line) can be
individually customized. The Envelope Type box and Envelope Slider control the envelope. There
is an Envelope Slider control for the envelope top and there is an envelope slider control for the
envelope bottom. There are four styles of envelope: Curve, Grow, Peak and Shrink.

If you use these controls and want to return the lettering to its default setting simply click the zero

control.
[ ]

Enveloping Curved Top and Bottom Envelope

Enveloping can produce a variety of creative designs, especially when you begin breaking up the
words into segments and enveloping each one separately.

o_n

Sample above uses two envelopes and a lower case “0” resized for bubbles.

Changing the Color of one Letter

Change the color of a single letter by selecting that one letter. To select it, first make sure the
lettering object or monogram is selected, then click on the green handle that appears centered over the
letter you want to change. Once a single letter is selected, change the color(s) of just that one letter using
the color property page as described previously.

For more information on threads and colors, see the section on Color.
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Monogram Sewing Order

On the Letters tab there is a Sewing Order box. Choose the order in which the letters are sewn from
this control. For a simple monogram you probably do not want to change the default order. However, if
you want to overlap the center letter on the others, you could choose the ‘ACB’ order (second choice).

Properties
Color  Letters | Stitch |

=l—o

Texk: | BEC

| ARk MGM Diarnc
Lick
gtyle: ABC normal
Sewting (o o
Order: A-B-C
Slank:

Space:

Stitch Properties

The Stitch tab contains controls for the actual stitch generation of the Lettering.

Note: This is the tab for built-in fonts. See below about imported fonts.

Properties L x |

Color ] Letters Stitch lNotes]

¥ AutoFil: | Tatami |

[+ Remove Hidden [¥ Ne
Satin Underlay:
[+ Edge Run
Inset (0.1mm): 8 :
[+ Satin

Density (0.1mm): |18 i‘
Use Defaults

Satin Density Control: This control ranges from 3 to 20 with each tick representing 0.1mm. So the
range in millimeters is .3 to 2.0 mm. The smaller the density number the closer together the satin stitches
will be. Normal is 0.4mm.

Compensation: This control ranges from 0 to 10 with each tick being 0.1 millimeter. As the value
increases the stitch length increases, in effect ‘fattening’ the stitching. This is useful on fabrics that have a
loft or nap, and can also be used to make a font appear bolder.
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Remove Hidden: When selected, stitches that are completely hidden by top stitches will be
removed. This process allows the design to sew with less density. Note that this only affects stitching
within the monogram itself, for instance where one letter is positioned on top of another letter.

Nearest Point: When this is available, it allows the lettering to adjust the entry and exit points for
each letter to minimize travel to its neighbors. This will also work for alternate sewing sequences such as
center-out or right-to-left. Not all fonts have this ability, so it is up to the digitizer.

Edge Run: When checked, this adds a running stitch underlay. This setting is the amount of inset for
the edge run and ranges from .1 to 1.2 mm. A normal edge-run amount is 0.8mm (about the width of a
typical needle)

Satin: When checked, this adds a satin underlay. When checked, it applies the density value, which
ranges from .3 to 2.0 mm just like the satin stitch.

The Set Defaults button restores each of these controls to their default values.

Note: This is the Stitch tab for imported fonts with a licensed product such as Essentials.

Properties R x |
Color lLeﬂers Stitch l
Density adjustment:

Satin: 0% 7J7
il 0% —]}—

Comp: 0 pt —J—

I Remove Hidden Stitches
Limit satin length:

pom |

Light Anchor
Heavy Anchor
Lenath Limit

Split

Imported fonts are really just merged stitch files, with a few extras built-in for alignment. These
fonts may have been added using a .BX-format installer or with the Import Font window if you have a
product such as AlphaTricks.

Because the stitches already exist at whatever density the digitizer created them with, all you can do
to the density is modify it - and you do that with a percentage. Likewise, if any of the stitches are
recognized by the program as fills, we can adjust the percentage of the density here too. Sliding the
sliders right, for example to 10% will add 10% more stitches, while keeping the size of the lettering the
same. More density provides more coverage, but too much density sews thick and noisy and can pucker
the fabric.

The compensation tool, “Comp,” is used to slightly fatten the lettering. This can be useful for a better
look on the font if it is too thin or is being sewn on a pile fabric. If you make the font too fat though, you
can move to far from any edge run that may exist, which would alter the look at the edge of the satin.

The Remove Hidden Stitches function allows you to position one letter on top of another and have
the program remove hidden stitches underneath. This also works with applique lettering, where the top-
stitch will be removed, but Position and Material runs will be left intact.
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The ‘Limit Satin Length’ option is used to help prevent looping on top of the fabric and reduce ‘snag-
ability’ from long satin stitches. There are several options to choose from when the lengths are long. An
‘Anchor’ is a simple run that’s placed every other line of stitching. This allows the alternating satin
strokes to cover the added needle penetrations. The result is a reasonably smooth stitch, almost as
smooth as a satin, but well tacked down, and not likely to snag or loop. ‘Length Limit’ is one traditional
look to anchor the satin, and it will simply drop the needle whenever the stitch is too long. ‘Split’ will
insert a needle land in the middle of any stitch that’s too long, which results in the look of a split-satin, or
columnar appearance.

Text Path

You can manipulate text to form a shape or path. Each letter has several handles to
accomplish this. Click on a letter’s center green handle to select that letter.

The center handle will move that letter.

The green pennant handle on top of the center will stagger the letters from that one
forward:

Over the

o
Q
]

The blue handle at the center rotates the letter and all subsequent letters. The green pennant
under the center handle will move that letter and all the letters on the line following it.

Using these handles, you can make your letters into virtually any shape.

A Closer Look: You can manipulate text to fit virtually any kind of path using the handles for the
text design as well as the individual letter and rest-of-line handles. The letters have additional control
handles that display when the monogram is selected:

46



Lettering

®
" " Letter Size and Rotation: As with any design, the letter itself has
+ four black handles for resizing, and a blue handle at the top, right used
to rotate the letter on its own.
End-of-Line Handles: Note the Center Green Handle in each
[ letter.
"
This handle that appears in the center of a letter when the
[ [

lettering design is selected and it is used to move the individual letter.
Simply click on it and drag the letter to the desired position.

Clicking the center green handle also allows you to change the
color of that letter only, leaving the others untouched. Use the Colors page in the Property Sheet to
change the letter color, as you would change any color layer in a design.

Clicking on the green center handle displays three additional handles. These handles give a wide
range of control over the positioning of the letters. The handles work on the selected letter and all letters
to the right of the selected letter. Let’s take a closer look at these handles:

Top Green Handle: The handle over the center handle is a line
stagger. This handle staggers the letters vertically and changes the spacing
simultaneously. The example shows a stagger upward.

Bottom Green Handle: This handle is the kerning handle. It can be
used to move letters beginning with the one selected to the end of a line.

This handle moves the letters to a new location without affecting the
spacing on anything from the selected letter forward to the end of the
line.

Center Blue Circle Handle: This
moves all text until end-of-line. This
around the center of the selected letter.

handle is another tool that
handle rotates the letters
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Lettering Templates

You can design templates for lettering to use in name drops, word walls, subway art, etc. Templates
are interactions between two different elements: A lettering design, and a template object. To
accommodate multiple template designs on a page, the template and lettering items are named using a
numbering system that will match them together.

4 Subway.be * [J 3
~

The lettering works with the built-in fonts or any .BX fonts. The templates work with lettering of a
normal single-line style only. Template objects must be native objects from the Create Mode of the
platform, and the stitch type must be Line, not Run or other stitch type. Template objects may be drawn
if you have the tools, or if a .BE working file has template objects within it, you can use those.

There are three types of template objects: Namedrop, Envelope and Baseline. Use the object tree to
name the shape with one of those names, followed by a number, ex: namedrop 1

To associate a lettering design with a template, add the matching number to its name, ex: letters 1

Once you have the names matching, use the letter properties to generate the letters - type or hit
enter, or adjust one of the properties on the page to cause the lettering to regenerate. When the lettering
generates, it looks up through the design layers (earlier in the design) for matching template objects.
Once found, the template and the lettering work together.

The template object must be in a design that comes before the lettering design. When the lettering
design gets updated, it only looks backward to see if there is a matching template for it to use.

— Design
11 namedrop 1

2ABL Letters -c 1

Lettering used with templates has optional parameters, depending on the template object. You can
add the parameter to the lettering name, ex: “letters —c 2”. This example will cause the lettering to use the
template object with a number 2 at the end of its name (ex: “baseline 2”) and also will center the design.

You can place all your template objects in one design, which is customary. As long as that design
comes before the lettering designs in the sequence, the template items will be found. You do not need to
have the template objects in any order; the sequence of the lettering designs controls the sewing order.
All that matters is that the index numbers in the names match.
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Namedrop

The simplest of the template forms is a namedrop. It is a simple 2-point line, running left to right,
which controls where lettering will be placed.

Namedrops have the options: —c (center), -1 (left), -r (right), -j (justify), -m (middle), -t (top). These
options inform the template where on the line to place the lettering. The middle and top options refer to
vertical placement.

Your Name Here

Your Name -M
Your Name -B

Your Name -J

Namedrop shapes can be named using the options along with a number, ex: “namedrop —-cm 1” will
cause “letters 1” to be placed in the center horizontally and middle vertically. If the letter name specifies a
different option, that will override the template name.

Once the lettering is linked with the template, most of the normal lettering handles still do all the
regular operations such as move and rotate. The only difference is that the lettering will always stay on
the template line.

w E?
A C
N N
Na DA

If you have StitchArtist, information about drawing namedrops can be found in the ‘Drawing
Lettering Templates’ section of this manual.
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Envelope

Envelopes can yield effects from simple placement to re-shaping of the lettering.

é\s ‘ ‘NQ

The options for envelopes are: —c (center), -1 (left), -r (right), -m (middle), -t (top), -b (bottom).

ABC-tl ABC-tc ABC-tr
ABC-ml ABC-mc  ABC-mr

ABC-bl ABC-bc  ABC -br

SHELD Ford-Sh

ABC-L ABC-m
ABC L ABCT

-R aBc-s
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These options control placement of lettering within the template. If no options are specified, the
template will stretch the lettering design to fill the envelope.

As with namedrop, envelope shapes can be named using the options along with a number, ex:
“envelope —cm 1” will cause “letters 1” to be placed in the center horizontally and middle vertically. If the
letter name specifies a different option, that will override the template name.

Envelopes have a unique ability: They allow editing as visually normal letters when selected. To see
the lettering in the envelope, click off the letters (de-select them).

If you have StitchArtist, information about drawing envelopes can be found in the ‘Drawing
Lettering Templates’ section of this manual.
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Baseline

Baselines provide a means for lettering to follow on a path, whether open line or closed shape.

wis 15 @ bag eline

Lettering with baselines have the options: -m (middle), -t (top), -b (bottom), -c (center).

Note: The lettering design gets named with the option, not the baseline. Baseline names would be
simply “baseline” followed by a number, ex: “baseline 1”.

\,eﬁgﬂ\te )
""’“‘M\m‘

There is an additional option for closed shape baselines: -1 (lower) or —u (upper).

Baselines have pre-determined default settings which can be overridden by the lettering options. An
open baseline will initially place the lettering at the left start of the shape. Closed shape baselines will
place the lettering at the top, centered.

The control handles for lettering work slightly different on a baseline. The center handle, used to
select a letter, also will allow the letter to be placed anywhere both vertically and horizontally on the
baseline.

The lower pennant handle causes the lettering to move along the baseline, and to have all the letters
to the right of it follow. The pennant handle above the center causes the letter to move above or below
the baseline and all the letters following will do the same.

The rotation handle connected to the center handle causes the letter to rotate and all the following
letters rotate in place to match.
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The middle and top options describe how the lettering will be placed vertically along the baseline.
Top indicates that the top of the lettering design will be placed along the baseline. Middle places the
lettering design centered vertically on the baseline. Bottom is the default, so no option is required unless
using the -1 (lower) option.

When using a closed shape, such as a circle, it is often desired to place lettering both above the top
and below the bottom of the circle. This can be accomplished with two lettering designs, one for the top,
and one for the bottom. This allows each line of text to have its own settings, even a separate font. When
specifying that the lettering will go to the bottom of the shape, and the -1 (lower) parameter. The

template will switch the default placement to -t for lower shape lettering. You can change this using -m
or -b.

-‘-umw
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You can achieve any letter placement with a baseline. Even ‘wavy’ vertical text can be
accomplished using a vertical line and rotating the letters using the center rotation handle.

If you have StitchArtist, information about drawing baselines can be found in the ‘Drawing
Lettering Templates’ section of this manual.
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Monogram Placement Guide

Towels

General Instructions: The placement goes on the opposite side of the fabric and at the opposite
end from the label. This allows a traditional triple fold to display the monogram. Folding the towel as you
would display it helps visualizing and marking the correct placement.

Bath Towel: The bottom of the monogram should be 4” above the hem or 1” to 2” above the dobby
border, if present. The monogram should be 4” tall.

Beach Towel: The bottom of the monogram should be 5” above the hem or 2” to 3” above the dobby
border, if present. The monogram should be 5” tall.

Golf Towel: The monogram should be centered horizontally with the top of the monogram .5”
below the grommet. The monogram should be 1” to 2” tall.

Hand Towel: The bottom of the monogram should be 2” above the hem or 1” to 1.5” above the
dobby border, if present. The monogram should be 3” tall.

Sports Towel: The bottom of the monogram should be 1.5” above the hem. The monogram should
be 1.5” tall, and may be placed on a 45-degree angle.

Wash Cloth: The bottom of the monogram should be 1.5” above the hem or 1” above the dobby
border, if present. The monogram should be 1.5” tall and may be placed on a 45-degree angle.

Bedding

General Instructions: Don’t annoy your sleeper. Placement and thread can affect the comfort of the
item. Spread out the item as you would see it on a well-made bed to help with visualizing and marking the
correct placement.

Top Sheet: Top Sheets are placed on a bed upside-down and the top (wide hem) is then folded back
to right-side-up. This means that the monogram is apparently embroidered upside down. Looking at a
made-up bed will help you visualize this. Place the bottom of the monogram 2” from the wide hem,
centered. The monogram should be 3” to 4” tall. Embroidering inside the wide hem is sometimes
preferred, and when doing so the design is sized to fit.

Pillowcase: Embroidering inside the wide hem is generally preferred, and when doing so the design
is sized to fit. If the font allows it, the monogram should be 2.5” to 3” tall. Placement is centered,
monogram facing toward the opening.

Pillow Sham: Center the design on the sham, facing the long edge as if it were a pillowcase with an
opening. The monogram should be 2.5” to 4” tall.

Blanket: Centered on the top like a sheet or facing into the bottom, right corner at a 45-degree
angle. The monogram should be 4” tall.

Duvet Cover: Centered on the top. The monogram should be large, up to 12” tall.
Home Decor
General Instructions: None. This is all according to taste, fashion and style.

Napkin: Embroider 2” in from point of corner. Distance may need to be increased if there’s a border
or hem. Place opposite of label or tag. The monogram should be 1” to 2” tall.
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Placemat: Top-right corner, 3” diagonally from point of corner. The monogram should be 1” to 2”
tall.

Table Runner: Embroider matching designs 4” from end. The monogram should be 4” to 5” tall.

Table Cloth: Embroider 4” from corner, with design facing into corner at a 45-degree angle. The
monogram should be 4” to 6” tall.

Garments

Coat Lining: Embroider on the right side at the waist level, 3” from the seam. Monograms should be
1” to 1.25” tall.

Collar: Embroider on the left side, above buttonhole if present. Monograms should be 3/8” tall.

Golf/Polo Shirt: 7.5” to 9” below the shoulders left seam and 4” to 6” from center. Depending on the
design, you can also look for a line down from where the collar meets the shoulder seam, and look over
from the 2nd buttonhole.

Long Sleeve Shirt: Top and center of wrist, which is about 1” to 1.25” from the center toward the

buttonhole. The bottom of the monogram should sit very near the top stitching of the cuff. Monograms
should be 3/8” tall.

Robe: Draw a line straight down from the shoulder seam 4” to 6” for women and 7” to 10” for men.
Find the center of the armholes from the armpit to the shoulder, and draw line straight across toward the
center of the robe or go across 3” to 5” from the center.

Shirt Placket: Center the design between 2nd and 3rd buttonholes. The design should be 1/4” to
3/8” inch tall.

Shirt with no pocket: Draw a line straight down from where the shoulder seam meets the collar
seam. Find the center of the armholes from the armpit to the shoulder, and draw line straight across
toward the center of the shirt. The center of the design is marked where the lines intersect. If the
armholes are deep, the line can be made too low on a woman'’s shirt, so keep that in mind.

Shirt with pocket: Center the design on the pocket hem, with the top of the design 1/4” below the
top of the pocket. Monograms should be 1/4 to 3/8” tall. If pocket has button in center, shift design to the
right.

Shorts Leg: Halfway between center-front and side seam. The bottom of the design should be 1/4”
to 1/2” above the hem stitching at the leg hole.

Short Sleeve Shirt: Center design 1/4” to 1/2” above the hem on the sleeve. Monograms should be
1/4” to 3/8” tall.
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Product Features

Several Embrilliance products make use of the feature sets in this section. These features are not
universal in the platform, but may appear in various products such as Essentials, Enthusiast and
StitchArtist. The specifics are noted with each feature. For current feature information you can also refer
to the Embrilliance website.

Open Library Folder

The Utility menu is available only with purchased titles. It adds certain convenience features,
depending on the products licensed. One that’s always available is the Open Library Folder. This allows
you to browse the file system in the folder in which your designs, motifs and fonts are located.

Note: When making changes to this folder, it is best to close the program.

Most of these files are licensed products, such as imported fonts. As such, you cannot simply rename
them in the operating system folder. You can delete those files if you wish to remove the font from your
system.

To backup your fonts, designs and motifs to another computer, simply copy the entire folder to
something like a USB drive. Then you can copy those files onto the new computer, if desired.

Applique (Essentials, StitchArtist)

When you select a color by clicking on it in the Properties window, you see the color window
appear. This has two tabs, the first of which is to change the color, as discussed in the prior section.

The second tab is used to set applique states on the selected colors. This information is used by the
program when removing overlaps, and adds other features such as saving a file for use in applique
cutting machines.

Color  Applique |

Style: AppliqueF'usiﬁon vI oK, I Cancel |

— Fabric View: Cutting:

% None /Clear © Single Image Inflate: IU-U mim ¢||

" Simulated " Tiled image

Save | Save All |

—Image:

Image... | I:Il ﬂl ";.l .;"l Saueaslmage...l

Essentials includes the ability to have the Simulated Fabric View.
The StitchArtist version of this window is shown, which includes the use of images.

When a color is assigned as ‘Applique Position’ or ‘Applique Material’ then that color becomes
exempt from having its stitches removed. They are likely to be hidden, but they are necessary when
sewing the applique design.

Colors can be assigned as applique position or material in three ways:
1. Use the drop list on the Applique tab of the Color Window.
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2. Right click on the color ship in the Property window and use the context menu.

3. Name the object in the Object Tree as Applique Material or Applique Position. The
words can be abbreviated: “Appliq Mat” or “Appliq Pos” are acceptable

Material

The ‘Material’ layer is used strictly to prevent the removal of stitches - first in the sense that the
material stitches themselves are not removed, but additionally that the fabric inside the applique can
obscure earlier stitches. As it is not good to have bulky stitches underneath an applique, those are
removed. By way of example, you might want to overlap two or more appliques, and where they overlap,
you want the minimum stitches necessary. Note that some designs do not have a separate material tack-
down color. That’s okay to leave off in most cases.

Position

The ‘Position’ setting is always to be found in applique designs - otherwise they would not be
applique. The position of the fabric is sewn down, and then the applique is applied.

Using this information we can do some additional things in the software:

Generate a fabric simulation: The fabric is simulated using the chosen color of the object. You can
change this setting, and the color itself ‘live’ in the window to preview the results. When you find a
suitable setting, click ‘OK’.

If you have StitchArtist, you can do more, as described in the section, Photo Applique.

IMPORTANT NOTES:

The type of stitching is important for the operation of the applique discovery process in the
software. Generally, applique position steps are made from single running stitches, which may jump to
other sections and/or holes. Most digitizers will do this simple run, and then add tie-off stitches at the
beginning and end of each outline. Sometimes the outlines will not close perfectly, but the software
overcomes this, as well as the tie-offs. But if the digitizer uses some other stitch, it is possible that the
process will not be recognized as an applique when you want it to. The easy way to check is to turn on the
fabric simulation. If that looks correct, you are good to go.

Also note that the program is not converting filled sections into appliques. That must be done by the
digitizer who created the design. This applique discovery process is to make using existing applique
designs easier and more fun.

Preferences

The Program Preferences have a setting under “Files->When Saving” that can be used to turn on/off
the use of applique in the removal of hidden stitches.
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Also the use of the Program Preferences under “Printing” can allow selected colors to be printed.
This can be useful for machines that scan in a printed output for the purpose of cutting, such as the Scan
‘N Cut.

Saving Cut Files

The software analyzes the shapes created by the Position stitches and then creates a simpler output
for the cutters, and saves it to their file. .fcm for Brother Scan ‘n Cut and the .studio Silhouette products,
along with .svg and .plt files can be saved. Nearly every cutter can make use of one or more of these
formats.

Save the cut file and send it to your machine according to the manufacturer’s instructions.

The ‘Save All’ button will merge all the Position stitches on the design page, whether or not those
objects are selected, and the resulting cut file will have all applique elements in it.

Generally speaking, applique steps are;
1. Set the colors as needed.
2. Save the cutfile.
3. Save the design file (working and stitch)
4. Cut the applique.
5. Embroider the design.

Alternately, you can still use the image in a print process, and pre-cut the applique by hand. There
are a lot of options!
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Photo Applique (StitchArtist)

1. Use an image such as a photograph or fabric swatch inside the applique shape.

2. Create a print that is cropped to the outline, making it easy to hand-cut pre-cut
appliques.

3. Print the cropped image on printable fabric or transfer paper for the effect of combined
photography and embroidery.

4. Inflate the shape of the outline. When digitizers create a design that will be hand-cut in
the hoop, they know that the embroiderer won’t cut exactly at the line of stitching. So
when they make the ‘Material’ run, they often simply duplicate the ‘Position’ run - same
size, etc. This creates an issue for Pre-Cut Applique as the ‘Material’ stitching will not
catch the applique - it is exactly the same size. Using the ‘Inflate’ when saving for
cutting machines will create an applique that slightly hides the ‘Position’ and can be
held in place by the ‘Material’ stitching.

5. The ‘Position’ is usually a simple enough set of stitches to be processed into output for
an automatic cutting machine. These machines will take a file and use that to cut the
fabric. Having cut the applique beforehand makes the embroidery process much more
rewarding.
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The Thread Editor (Essentials, Enthusiast, StitchArtist)

The management of threads is a challenge for every embroiderer, and every embroiderer handles
this differently. Some people are very organized and will colorize designs with only colors they actually
own. Others resist changing threads at all. And, of course, commercial embroiderers ignore colors
onscreen entirely and just run whatever colors the job calls for.

The Thread / Palette Editor provides a place for you to manage which threads you own, create
smaller palettes for specific projects, and even share those palettes with others.

When choosing colors in the main program window, you are given the choice of picking colors from
thread lines or palettes. The reason for this is to allow quick access to a current set of project colors,
rather than taking the time to scroll through a long list of threads and their complete color lists. Often, an
embroiderer is working with a set of colors repeatedly and selecting through a long list when you, “Just
want that blue I'm using,” would be tedious. For this reason, there is a checkbox that is used to determine
whether the color list is shown as a thread or a palette.

x|

FEEEER :
|k | BX
Coats and Clark Pol S
Mame: | Coats and Clark Poly = Sort: & Color " Nurmber © Name

Display: [ Hidden
Motes:

Note: For the purposes of discussion, the term “thread line” and “palette” are considered
synonymous, except when discussing the above checkbox.

The program ships with data for many thread lines, including some that may not be available to you
in your area. If you would prefer not to have those threads show up in your list (while changing colors in
a design), you can check the box labeled, “Do not display.” This does not hide the thread in the Thread
Editor, only in the Thread and Color properties when working with designs and objects.

The ‘Notes’ box can be used to enter any useful information about a particular palette. For instance,
you might create a palette of colors for a particular job or project and enter information such as “The blue
design matches the print on the front of the shirt.”

Each thread brand or palette is stored as a file on your computer. As such, the toolbar has options
for you to create new thread palettes, save a palette that you're working on, and even delete a palette
that's no longer needed. These actions are performed by the left three buttons on the toolbar.

Merging Color Palettes

The next button, ‘Merge’ will open a thread window that lets you select one or multiple colors to be
merged into the current palette. Also, there is a Delete button that removes any selected threads from the
current palette.
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M Thread X

Wiew: |Madeira Thread Chest j oK

@& Threads | sorty & color  Name ¢ Mumber |
" Palettes Cancel
Search:

3: Madeira Thread Chest ~
1386 Dark Chestnut

4: Madeira Thread Chest
1181 Baybery

5 Madeira Thread Chest
1381 Dark Mulbemy

E: Madeira Thread Chest

163 Magenia b Multiple selections can be
7: Madeira Thread Chest . .
1713 Mecium Burguncy made using the Ctrl and Shift
e oread Chest keys while selecting with the
?;M}?ﬂei’? IThr_fead Chest v mouse.

When merging colors from another thread or palette, the ‘brand’ for those colors will take the name
of the current thread. This is one difference between a thread and a palette. If you merge colors into a
palette (the palette box is checked) then the colors will keep their original thread names.

Sharing Palettes

If you would like to share or import a palette, use the two buttons on the right of the toolbar.
Sharing a palette is useful when you are making a project that others will make too.

Thread Inventory

You can mark threads that you have in your personal inventory using the ‘Check’ and ‘Uncheck’
buttons:

B Thread / Palette Editor X

SEEEAE

Colors

+ | Coats and Clark Pol
fame: | t ﬂ Sort: B Color ¢ MNumber  Mame
Display; [ Hidden Selection: | Check r-\l Uncheck| Delete |

Mokes:

= 1: Coatz and Clark Poly ~
5 Copenhagen

o 2 Coats and Clark Poly
510 Radiant Blue

Creating colors (Essentials+Enthusiast, StitchArtist)

These products add the ability to create your own colors and add them to thread lines and palettes.
To create a new thread or palette, click the ‘New’ button on the toolbar.

Click the ‘Add Color’ button to create a new color entry in the current thread / palette. Type in its
name and thread number, if those exist, then adjust the color itself.

Using the ‘Sheen’ setting, you can alter how the thread will display when 3D rendering is turned on
in the main display. You can also input up to four variegated colors on a thread. Using the ‘Var’ drop-list
(short for variegated) you select the number of colors used. There will appear a set of buttons ‘V1’-‘'V4’
each of which allows you to select and set the color for that particular variegation.

The color grabber tool lets you click in any window and pick up whatever color is under the cursor.
This is very useful when you are building a thread palette from a document such as a .pdf or a thread
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manufacturer’s webpage. If you want to adjust the color visually, use the HSV (Hue, Saturation, Value)
sliders until you get a color that you like.
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Left: A typical thread list.

Right: A variegated color in a user palette.

Importing .CSV files (Essentials+Enthusiast, StitchArtist)

# . Thread / Palette Editor

[=s] a2 %[ =
SO .

Display: [~ Hidden [~ Palette

Notes:

Add Color
Color:

Name: | White
Number: | 10000 Sheen: | Normal

Var: |Normal -
| 2]

Colors
Sort: @ Color (" Number (" Namae

Selection: Check | Uncheck | Delete

1: Fil-Tec Glide
10000 While
2: Fil-Tec Glide
80812 Hope

3 Fil-Tec Glide
80177 Pepparmint
4; Fil-Tec Glide
70183 Pink

5: Fil-Tec Glide
70812 Hot Pink

6: Fil-Tec Glide
70182 Cotion Candy
7: Fil-Tec Glide
70211 Flamingo

8: Fil-Tec Glide
91787 Lip Stick

9: Fil-Tec Clide.
70217 Pink Lemonade

AN FilTar Rlida

File of type .CSV (Comma delimited text files) can
now be imported. Use the rightmost button on the
toolbar. Name the file with the brand name of the
thread, and it will import using that name. You can save
it later as anything you like, of course.

The format must be as follows, for each thread, each
thread on its own the line.

Thread Number, Thread Name, Red, Green, Blue

If no thread name is available, leave it blank, but
always have the four commas.

1000,,0,0,0

The red, green and blue values should be in the range of 0 - 255. Most manufacturers have
RGB codes and they’re always in this range.

Multi-Position Hooping (Essentials, Enthusiast)

SO, YOU SAW IT ON THE INTERNET AND HAD TO HAVE IT.

BUT IT’S TOO BIG FOR YOUR MACHINE...

Essentials and Enthusiast have our patented design splitting technology built into it. This system
automatically splits designs into multiple positions for sewing as separate designs that tile together to
make a larger design. In the past, splitting a design took hours of editing by a person schooled in the

process.
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Our splitting feature drastically reduces the visible ‘seams’ that occur from manually splitting files
using an editor. In most cases, the final product is indistinguishable from one created on a larger-field
machine.

Note: StitchArtist has multi-position hoops for the sole purpose of digitizing to accommodate
them. You can digitize the design as a whole, and then separate designs and add
alignment lines as needed. StitchArtist does not include auto-splitting of designs.

Some hoops have multiple positions. This means that you only hoop the fabric once and generate
the design by sewing it in those multiple sections. However, you can achieve the same result by re-
hooping the fabric multiple times to create the design. We call this a “Virtual Hoop.” The Essentials
version of the program comes with many hoops and virtual hoops pre-defined. The Enthusiast version
has creation and editing of these hoops as well.

When sewing designs in multiple sections, often the question of alignment comes up. This is
accomplished automatically with multi-position hoops, but to make it easier for regular hoops, the
program will add basting stitches that will align the designs. To choose a hoop, click the preferences
button on the toolbar, and the Hoops window will appear:

Program Preferences @
23 Environment
% Hoops PES = Hoop Style:
Grid Settings SePeeiFsid | Nema & Muli-Postion
Calibrate Screen 130 x 300 Jumbo Hoop
Mouss Wheel 100 x 172 Large Hoop New
Check for Updates Ellageo x 2
Ghost Mode Elegante x 2 Ed
s Digitizing Embroidary Professional x 2 Delete
onversion Haop-It-All 300x500
1 Flles Haop-It-All 300x400 ™ Rotate 90
23 Printing Hoop-1t-All 300x300
21 Adjustments Defaults
The design centers are offset from each other:
10,00 em, Left to Right.
”T‘ Caneel I Apply ‘

The Multi-Position hoops are separated from the Normal hoops, and you click on the Hoop Style to
select the list you want to see. Here is the Jumbo Frame:

S poagng gz ! ! P gt s
R R i i M L U T S L Tl S S R L U "L SR

&

Sewing Multi-Position Designs

You'll notice that this hoop has two rectangles that overlap in the middle. Each of these represents a
sewing field. To make it more obvious which lines represent which field, the inside of each rectangle has a
dotted line indicating the inside of the field.

If you are combining designs to make a composition, it is always going to give the best result if you
keep whole designs into one region. This produces a split that will have the least effect on the actual
stitches on the design. Of course, this is not necessary, however, as the design may be split even if it lies in
the middle of the hoop, but some splitting would have to occur.
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The ‘+’ marks shown indicate the centers of the sewing fields.

Note: If you look at the Hoop in the selection window you will see a note that the design centers
are offset from each other. This means that when you sew the two sections, the centers of
each design will be separated by that amount. This is your initial placement method for
each design.

The design centers are offset From each other;
10.00 cm. Left to Right,

In order to position your design, it is always advisable to print an actual template of the design. This
helps you visualize what it will look like once embroidered, and it will help define the center position of
the design on the fabric. Once you have the center of the overall design, then you will want to mark the
centers for the individual fields. In the example above, this would mean that you mark the fabric 5 cm.
from the center on both the left and right of the design center. This places the two designs 10 cm. apart.
This basic positioning will help you get the result onto the fabric where you want it to go.

Multiple Hooping

Multiple Hooping is the process of creating a large embroidery design by re-hooping the fabric
as you embroider each section. Multiple Hooping is an art that requires a complete understanding
of what you are doing, as well as an excellent ability for placing your fabric in the hoop. Itis nota
method that should be practiced by the timid. You can split designs for Multiple Hooping by
creating your own hoop:

Suppose you have a design that is 9 inches high and 8 inches wide. Also, suppose that your
machine will embroider a region 9 inches high and 6 inches wide. (These are typical values for
today’s machines.) What you want to do is to create a two-position hoop to accomplish the split.

Create a hoop that is 9 inches high, with two positions. The separation should be set to allow
the greatest possible overlap between the two regions: 8 inches (desired) - 6 inches (a single hoop
width) = 2 inches.

A separation of 2” would be the smallest possible for the desired 8-inch width, and would
provide the greatest overlap of the regions.

Note: The use of columns allows side-by-side multiple-position hoops. It’s a lot of
embroidering, but it looks good and can easily fill a jacket back.

It is very important to mark your fabric before embroidering. When the fabric is re-hooped it
must be parallel and centered to the first hooping. Also, the distance between the centers needs to
be precise. (This is 2 inches in this example.)

If it is possible, we encourage the use of ‘Floating’ techniques for hooping: not actually hooping
the material itself, but rather hooping a stabilizer and attaching the fabric to it with adhesive
and/or a basting stitch. This will provide the least distortion in the fabric while the overlapped
regions of the design are being embroidered. One easy method, if your material can handle it, is to
use carpet tape (double-sided and very sticky) on the bottom of your tightened hoop. This can
then be perfectly aligned and pressed into place. (The adhesive comes off with a lot of water-
soluble solvents and even soapy water will usually work.)

Remember:
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It is a really good idea to take a class on this type of process to get the hang of it, and practice
before moving on to an actual project!

Output Files

When you save your files, the output files represent each region of your design.

The files are automatically given names indicating their stitching order as well as the position
within the hoop. For instance, “Rose.Pes” may split into “Rose Top #1.Pes” and “Rose Bottom #2.Pes”.

Additionally, you may get a text file that explains the color sequence for your new files. In many
designs, a color is only needed in one region. Where this is the case, that color will not exist in all the
output files. To help reduce this “Color Confusion”, a text file is created with a table. The following is text
from an example file:

“Roses.Pes
Your original file had 3 colors.
The program has split your file into 2 segments.

This cross-reference has been created for you because some thread colors in the original file were
not needed in some of the split segments.

File: C:\Roses Top #1.PES
Color 1 = original color 1
Color 2 = original color 2
Color 3 = original color 3
Color 4 = original color 4
Color 5 = original color 5
File: C:\Roses Bottom #2.PES
Color 1 = original color 1
Color 2 = original color 2
Color 3 = original color 3

Happy Embroidering!”

As you can see, the table is easy to follow. Since this is a text file, you can also edit it (double-click to
launch Notepad), print it, etc. It is a good idea to add any real thread numbers or names if you have them.
Often, the digitizer of a design will supply a real-color thread list for this purpose.

We cannot stress enough the fact that the order of embroidering the files is important.

The files will overlap each other as they sew. If you embroider out-of-order you will get overlapping
that is incorrect, and parts of your design will not be visible!

Region Naming

On hoops that have three positions, the regions are named for you: Top, Center and Bottom. On
hoops that have more positions, the other positions are given numbers, starting at the top. Hence, you
might have a hoop with: Top, Pos. 2, Center, Pos. 4 and Bottom. Columns have names like “Left”, “Right”
or “C2".
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Getting Best Results

To get the best results, there are some things you should know.

First is that you should trim your jump stitches as you go, if your machine does not do it
automatically. This is true in the course of normal embroidery, but somewhat necessary when
embroidering a split design. When splitting a design, it is natural that the machine will have to go from
place to place a little more frequently. This results in extra jump stitches. We have made every effort to
minimize the amount of effort that it takes to split embroidery files, and apologize for any inconvenience
this may cause, but please accept our assurance that your finished product will have a nicer appearance if
you clean the jumps from the design.

If you are using an appliqué design, you will need to embroider each color in each region before
moving on to the next color. This will ensure that the full appliqué can be applied without incorrect
oversewing by the other colors.

There is a compensation control in the Hoop Properties window. This control is available on all
hoops, even the factory-defined ones. Compensation is the amount that each region will overlap the
neighboring regions. This is used to correct for the fact that fabric will shrink as it is embroidered.
Additionally, an imperfectly hooped project will allow registration problems to occur. If you are not able
to hoop your fabric, ‘Drum-tight’, then you may want to increase the compensation setting for your hoop.

Important: If you are increasing the size of a design, please don’t increase the size more than you
will actually need for your hoop.

Note: There is a very important phrase in the computer industry: “Garbage in, garbage out.

66



Product Features

Editing the Hoops (Enthusiast)

When you click the “New” or “Edit” button in the Hoops Available window, you will see this
screen:

Hoop Properties %

Hoop Mame: |"-"F'3 tMega Hoop by Color
FileT ppe: VPR3 w | Overall Size: |150 mm = 360 mm Cancel

Individual Field Size [mm): 0

I

2%
Lo

s ‘150 " |24EI Compensation; ™y
Jul |

Offzet iz how much bigger the hoop gets for each additional row ar calumn,

Rows: |3 _%I Offzet: [mm] (B0 [v Color-by-colar [Megahoop)
Colurnz: |1 _%I Offset: [mm] |0 [ Right-ta-Left

[v Hoop Inverts betwesn positions [v Add basting alignment lines

[+ Preserve centeroffset (Mot Gigahoop) Baste Length: |2 _I;I

EXPLANATION OF FIELDS:

The first field in this window is the ‘Hoop Name'. This is just what it sounds like. Type in whatever
name you want.

Next, choose the ‘File Type’ of the machine that this hoop works on. The list contains the file types
that can be saved.

The ‘Individual Field Size’ is the size (in mm) that your embroidery machine can create with a
single hoop position. If you are unsure about this size, consult your dealer.

The ‘Rows’ field specifies the number of vertical points at which the hoop can be attached to your
machine. For most multi-position hoops, this number is three. For sliding hoops such as those
made by Hoop-It-All, you will have to determine how many sections you want to embroider in. In
so doing, however, keep in mind that there should be a good overlap between adjoining sections.
Use the hoops we’ve provided as examples.

The ‘Columns’ field specifies the number of points at which the hoop can be attached to your
machine sideways. For most hoops, this number is one, but there are exceptions on the market.
These are usually described as “Double-Wide”. You can also use the columns to indicate that you
want to divide the design into horizontally-tiled segments.

The ‘Separation’ fields specify the distance between the hoop positions. (For example, the distance
from needle-center of the top position to the needle-center of the middle position.) This can be
measured physically if you do not know: hoop a piece of paper and drop the needle through it, in all
hoop positions, measuring the distance between the holes. Alternately, most manufacturers’
software will show a grid behind the hoop on the screen. You can count the grids (usually 1 grid =
10mm) between the region marks to get the separation. It is very important that you correctly
assign the separation; otherwise the design will not be split accurately.

The ‘Right-to-Left’ field is used for multi-column hoops (‘Double-Wide’). It indicates that the initial
direction the program will split the design will be right-to-left, as opposed to the standard, left-to-
right. The use of this depends on the machine and hoop. Some manufacturers have wide hoops that
start by sewing the left side of the design upside-down, then you turn the hoop halfway around and
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embroider the other side (now the right side, and the design is right-side-up). Hence, the default,
‘Left-to-Right.

NOTE: You can tell if your separation figure is correct! The manufacturer of the hoop will
definitely provide you with the number of positions used as well as the full size of the
embroidering region of the hoop. As you adjust the separation, the field, “Overall Size” is
calculated. If this matches the figure given to you by the manufacturer, you have
correctly set your separation.

» ‘Compensation’ allows the final regions to be slightly increased in size. This forces the regions to
overlap each other. This is useful because as the machine adds stitches, the fabric gathers slightly.
It is entirely possible to have a gap between regions if no compensation were to be used. The
amount of compensation required depends on several factors: The size of the hoop, the fabric being
embroidered, the number of stitches, the quality of the stabilization, etc. We have chosen some
settings for our factory hoops that have worked well in our design testing. Please embroider some
test designs with the desired hoop before tackling a project. This will ensure that you have a
reasonable setting for your compensation.

» ‘Color-by-Color’ denotes a different type of file splitting. As of this writing, only the Viking Mega
Hoop™ allows for this type of design splitting, so as a general rule, never check this box. The Color-
by-Color method is for use in machines that can sew each color in all of the hoop regions before
going on to the next color. When the machine operates this way, it will stitch in its current region
until it no longer can. It will then stop and ask the user to reposition the hoop, whereupon it will
continue stitching. In the case of most designs, this will cause a lot of position switching as a color
typically stitches objects out in a random fashion all over the design. The program will ‘sort’ the
stitch objects to reduce the number of position-switches required.

* ‘Invert Alternate Column’ is used for ‘Double-Wide’ hoops that get turned upside-down for their
second row.

* ‘Add basting alignment lines’ will provide a basted line of stitching to each output file. These lines
of stitching will have their end and/or center points line up on the fabric when you go to stitch out
the designs. If the lines do not line up, then adjust your hoop/fabric position until they do.

» ‘Baste Length’ sets the size of the alignment line stitching, in mm.

Once you have finished creating or editing your hoop, simply click, ‘Save’ to save it.

If it is a new hoop, it will appear in the Hoop Available window.

Split Into Hoop (Enthusiast)

You can split the design using “Split Into Hoop” from the Utility menu. This opens a new design page
with the split files so that you can preview them or do other work before saving.

v uw'\w'u,"u‘g: - e e SR T TR ‘a.pi EETT .
ERPS Y- | ; & [a NGy en
# :‘&\ln

‘
= :

% ‘

o |

Left: A single design placed on a 100x172 hoop. Right: The design has been split.
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In the example above, the 100 x 172 PES hoop was chosen, and the design was centered in it. Then
the menu item, Utility->Split Into Hoop was chosen. This created a new design page, represented by a

new tab. In that page there are two designs, one for the top hoop section, and one for the bottom. Using
ghost mode, we show the designs separately:
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¢ - ep § e e
+ 2‘ Eottom #2 ‘4-
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Left: The top design is selected. Right: The bottom design is selected.

When you save this page, multiple stitch files will be created, as described in the next section,
“Output Files.”

Stitch Properties (Essentials/Enthusiast)

The stitch properties tab appears when a stitch design is selected. There are controls where
you can add or remove up to 25% of the stitches by increasing or decreasing the density of the

selected items. The slider controls will separately allow the adjustment of satin stitching and fill
stitching, which allows very specific control.

Properties

Color  Stitches ]

Density adjustment:

Satin: 0%

Fil: 0% —_]—

If you are a DRK user, there are additional controls that also tie in to the Project Advisor and the
Project system.
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Product: Essentials

The idea behind Essentials is to include the features, which are essential for every embroiderer, yet
not to overwhelm the user with unnecessary extras. It is designed to be simple and easy, yet powerful
enough to accommodate the person who wants to do more than simply using existing designs. The
feature packs are additional programs that you may purchase to add on to your Embrilliance Essentials to
make it YOUR software. No need to learn a new program! You simply add new features and functions as
you want them to your existing software.

The Essential Features:

* 12 Fonts for multi-line text, monogramming and circle text.

» Sample designs, which are scalable and recalculate their stitches as you interactively transform
them.

* Unlimited lines of letters or monograms and embroidery designs can be combined.

* You can mix and match fonts and sizes.

» Merge existing embroidery files into your design.

* Overlap designs - even appliques - and have hidden stitching removed.

* Browse and Merge designs in folders and from inside .ZIP files.

* Resize existing embroidery files with stitch recalculation. You can resize embroidery designs up to
250% and down to 50%.

» Colorize any embroidery design. You can change the colors one at a time, or convert the entire
design or any selected part of it to your preferred thread brand with just a few mouse clicks.

» Simulate the sewing of any design. The simulator can play in 3D, play forward and backward, and
has variable speed. The simulator also has a slider so that you can manually scroll forward and
backward through the design to any point without waiting. You can even insert a color stop in the
sewing process.

» Convert any design from one format to any of the supported types, which include:

« Read: ART, CND, CSD, DST, DSZ, EMD, EXP, EXP+, GNC, HUS, JAN, JEF, JEF+, PCM, PCS, PEC, PES,
PHC, SEW, SHV, TAP, VIP, VP3, XXX, EMB.

» Write: CSD, DST, DSZ, EXP, EXP+, HUS, JEF, PCS, PES (v1-9), PCM, SEW, SHV, TAP, VIP, VP3, XXX.

* Designer 1 Disk Utility for floppy and USB machines.

* Split designs for several multi-position hoops, including the Brother/Baby Lock 100x100 machines, and the
14” x 14” Jumbo Hoop.

* Project Advisor, a patented expert system with guidance to help successful embroidery on all your projects.

* Install .BX files, the industry standard for distributing fonts in a ready-to-type format.

» Create working files (.BE extension) to save your design as an editable and merge-able file. Your
working file is saved for you automatically when you save a stitch file so you don’t have to ‘Save’
twice every time you make some changes—once for the stitch file and once for the working file.

* Embrilliance has an advanced program interface that’s super easy to use yet offers features
normally reserved for very expensive programs.

* Real Scale zooming allows you to view your designs on screen at the actual size that they will stitch
out.

* Navigation Window that provides instant control over the zoom and scroll in the program’s view.

» Sewing Order control allows you to re-sequence the designs to sew in the order you want them to
sew.

 Color Sorting control to intelligently reduce the number of extra color changes.

» Adjustable Mouse Wheel attribute for Zoom or Scroll.

» Simple centering in the hoop plus advanced alignment.
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» Thread Palette creation and thread inventory system.
» Basting designs.
* Automatically check for updates.

Resizing

Essentials has a technology known as a stitch processor that lets you resize existing stitch files
upward to 250% and downward to 50%.

This recalculation of the stitches allows even lettering designs that have been added with a BX font
or AlphaTricks to be scaled and stitches recalculated.

When sizing using handles in the Main View, stitches are recalculated - if you hold down the Ctrl key
while dragging, recalculation is disabled for that drag (which can be useful to very simply lighten the
density in a design a bit).

The process of recalculation is to add more ‘lines’ of stitching in the satin and fill areas of a design.
They may even be curved fill lines, or lines with carved areas such as pattern fills. The sizing engine will
preserve the look of the fill while keeping the density the same as it was when the design was at its
original size.

You can size, resize and resize again in Essentials, as the original design is kept behind the scenes
and is always re-referenced when creating a new size.

When sizing with the handles in the Main View, the upper and lower limits of percentage are limited
to help prevent overly-distorted designs. You may override this using the size boxes on the Tool Pane
which let you specify a size.

Sizing Properties

When you resize a regular stitch file, the density would normally get more or less dense, but
Embrilliance will recalculate the stitches for you automatically.

Program Preferences g]

(23 Enwironment
(23 Conwersion Sensitivity: 11 —Ji v Gap Reduction
(C Files
(23 Prirting ¥ Min. Length: 0.3 mm W Max, Length: 7.0 mm
==t =i
hi] |
g Sizing
I¥ Min, Sat. Length: 0.3 mm W Max, Sat. Length: 7.0 mm
I Min. Fill Length; 0.3 mm ¥ Max. Fill Length: 7.0 mm
—] =it
Ji| |

oK | Cancel ‘ Apply |

That recalculation process is complex and difficult, so there are some settings you can adjust to
achieve optimal results.

Use the Preferences button on the main toolbar to adjust the sizing settings.

The sensitivity slider is used to control how well the program discovers fills and satin stitches. If you
have a design that has a lot of manually created stitch effects, then you may want the sensitivity higher,
whereas normal designs that are digitized with objects like fills probably don’t need so much sensitivity,
especially if there is blending going on.

* Gap Reduction is a function within the software that helps adjacent areas lessen gaps that might
be exposed or widen during increases in size.
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* The stitch length filters are used to prevent loopy stitches on the fabric from stitch elongation,
and in the other direction, small stitches from gathering on the fabric making too many
perforations or simply bunching up the fabric.

The settings are broken out by stitch type because the handling of satin stitches is special and you
may want to achieve a split-satin look at a certain size.

Color Sorting

The “Happy Birthday” design has 6 unique colors but 13 color stops. To make it more efficient for
sewing, you might like to optimize the sewing order to reduce extra color changes.

Because letters added together are considered one object, you can’t selectively rearrange them in
the object tree. Fortunately, there is easier method accomplished via Color Sort, which can be accessed on
the toolbar just to the right of the Undo and Redo buttons.

Use the ‘Color Sort’ choice on the Utility menu, which displays the following dialog window:

B ' Color Sort [ X

The design page has been reduced by 7 color changes. New View
Cancel

¥ RHS Pre-Sort

Force Applique:
[¥ Position
[ Material

Tolerance:

s

Notice our design has been reduced by 7 colors.

At the top of the window, you’ll see the result of the sort. Notice that color stops may be reduced
(the basic reason for sorting) but you can also wind up with a sorted applique design that keeps the same
number of stops. In that case you may see a message, “The design has been sorted but not reduced.” Read

more about ‘Keep Color Stop’ below to understand this.

Click ‘New View’ to open a new design page with the sorted result. This is useful to check what
you're done before saving the design.

Click ‘Save It..." to save the color sorted file as a stitch file. If you don’t change the name, the program
will append “_sorted” to the end of the current file name. Your original working file (.BE file) is preserved
and not changed.

There are some additional controls available for more precise handling of the design page during
the sort process:

e ‘RHS Pre-Sort’ will process the Remove Hidden Stitches function before sorting. This is
the same as if you hit the RHS ‘scissors’ button on the main toolbar. It is useful to do this

72



Product: Essentials

sometimes, as those stitches being removed could have affected layering. By removing
them, the chances of the layers moving together are greater.

e ‘Force Applique’ will make the applique Position and/or Material steps sort together
regardless of layering issues. This is used on things like lettering designs where
overlapping can occur, but you want to run all the positions or even add the materials
to all the letters in one stop.

e ‘Tolerance’ controls how much overlap will be allowed in order to sort. While it’s not
really a percentage, it is okay to think of it that way, and the value goes from 0-100.
When you set it at 0 then you are saying, ‘Do not sort if the layers will change at all.’
Conversely, a value of 100 means, “Sort the colors together no matter what it looks like.’

Keep Color Stop

Normally, when two colors that are the same follow each other, the stop in-between those colors
can be removed: It lets the machine continue sewing without bothering the operator.

Certain designs, such as appliques in particular, will require that the machine stop so the operator
can do something, such as lay down an applique. For this purpose, there is a setting on every color called
‘Keep Color Stop’ which is accessible by right-clicking the color chip in the Color Properties.

Properties npg
Color |
Thread... | 1 Color... ] Prefemed |
Click bedow to change indnidual colors.

1: Madeira
1080 Crchid

2 Madeira

1080 Orchid

¥ Mot Applique
Applique Position
Appligue Material

v Keep Color Stop

When sorting, the program is aware of applique colors and will sort them together, but will add a
‘Keep Color Stop’ flag on the color if it seems to overlap or touch the previous applique step.

Color sorting can be useful in designs like this or designs that have poor sequencing. Color sorting in
this program is intelligent, meaning it doesn’t indiscriminately combine all like colors together. It looks
for layering and knows that some colors simply must be repeated.

Note: Do use caution when color sorting. Some designers have intentionally added extra color
changes either for design flexibility or to optimize registration. For this reason, always
save the Color Sort with a different name (or save the .BE file) just in case you want to go
back to the original!

Fit to Hoop

@ | Design elements can be scaled up to the design page by selecting them and clicking the Fit

Hoop tool. This will recalculate stitches wherever possible. There are limits, though, such as with
regular embroidery designs, which can only be sized up to 250%. This button will scale your design as
large as it can go, up to the built-in limits.
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Remove Hidden Stitches

H-EI‘;J When designs are overlapped, there may be stitches that are hidden, which you would like
to have removed. This process is automatically done when you save a file (controllable by
preferences) but you may want to preview the results before saving. The Remove Hidden Stitches will
run the process on those stitches so that you can evaluate the result. The result is temporary, however, so

if you change anything on the design page, the stitches will return. This happens because changing a
design will almost always regenerate its stitches.

For applique designs, use the applique tab on the color properties to tell the program that certain
colors are applique steps. The position and material steps will not have their stitches removed, as it is
considered likely that you will need those stitches. However, the applique material would naturally cover

over other stitches, and the material fill is used in the removal of earlier stitching. This is controlled by
the Preference “When Saving.”

Project Advisor

The Project Advisor is a patented expert system, a form of artificial intelligence, which helps
you select stabilizer, needles and hooping techniques for many common projects.

The system also provides instructions, helpful how-to advice and some words of caution
when necessary. First, you select a project from the list. If your exact project or fabric is not listed,
there are enough choices available where you can choose something very similar. Next, you can tell the
Advisor if your fabric has more or less stretch, and you can adjust thickness. The Advisor takes your input
in account as it makes its recommendations that are displayed as text in the window.

DRK users will also have the Project system, which extends the Project Advisor settings to actually
adjust your designs’ stitches for the chosen project.

Project Advisor @
Flease select a project/fabric type: Recommendations:
Cotton/Poly/Lycra ¥|  Needle: Embroidety, size 11-12

‘You may also modify the settings: Thread: 40 wt.
Fabric thickness: | Medium  w| Backing: fusible tear-away or water-soluble

self-adhesive
Fabric stretch: A Lot .

Project Notes:

There are many variations of this blend on the market. Some have no polyester, whereas some are just poly/lycra
blends. This particular fabric group is usually made for workout clathing. If this is what you are doing, then also see
the section on Lycra. If your intention is to have the fabric worn or used in a more relaxed state, such as with a skirt or
loose-fitting top, then these instructions are more appropriate. Note that if you use a stabilizer with adhesive, try a
titanium needle, as the residue from the adhesive will not build up as easily on it.

Hooping suggestion: Tightly hoop the backing, then baste the fabric and topping to it.

Both the backing (under the fabric) and topping (on top of the fabric) stabilizers are
recommended.
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Creating a Designer 1 Disk or Stick

TN view Zoom Window If you have a Husqvarna Viking Designer machine that uses either a USB
h stitch or a 3.5” diskette, you can create the proper files and file structure via

Utility -> Designer 1 Disk Utility.
When the Designer 1 Disk Utility window opens, you choose whether you

Designer 1 Disk Utility... want to write to a diskette or a stick. Next, choose the menu you on which you
want to store the designs. Designs are imported to only one menu at a time.

Align and Distribute. ..

Threads... |
] T T T T Al i Al T T
B Designer 1 Disk Utility X

(¢ Diskette ( USB Stick Drive: |C:\ | Read | Write

_m Get Designs. ..
Menu 2 _
Menu 3 Save— il
Menu 4 Remove Selected

Remove All
Grid: 3x2

Note: If you want to add files to a previously created Designer diskette or stick, you will need to
first read in the designs and then add the new files to one of the menus. When a Designer
disk or stick is written, it replaces any matching file and folder names.

Click the ‘Get Designs..." button and navigate to the desired designs. You'll see the now familiar ‘Get
Designs’ window where you select individual designs or the entire folder to import.

Note: Each menu can store up to 36 designs. If you select more than that to import, only the first 36
will be imported.

M Open Design Files

B oW

Close el Al | Import

Browse ‘
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2 Apps s
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) Revisions

D) EmbrosderyWorks11025etup-1.2ip ».
Revisions 2ip

C:\Documents and SettingsiOwneriDesktop|MyDesigns|Ragdoll Crittersligs00301 PES Size: 95.00 x 86.20(mm), St: 12650, Col: 9

The designs are imported with their original file names and file types at this point. To finish the
process, click the ‘Write’ button. Navigate to the desired destination and click ‘Select Diskette.’

Similarly, Designer diskettes and sticks can be read into Embrilliance by clicking the ‘Read’ button.
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M Designer 1 Disk Utility g]

* Diskette ( USB Stick Drive: |C: - Readl Write
Menu 1 lgsD0301.PES
Menu 2 Igs00302 PES
Menu 3 Igs00303.PES

i Igs00304 PES
Menu 4 Igs00305. PES
Igs00306, PES
Igs00307 PES
Igs00308 PES
Igs00309 PES
Igs00310,PES
Grid: 4x3

Remove Selected

Get Designs. ..

Save Designs...

Remove Al

When you view the newly created Designer 1 media, you'll see the files are renamed appropriately
and all the necessary support structure is also created.

Tip: You are not required to write to an actual diskette. If you create folders ahead of time, you
can actually “write the diskette” into a folder on your hard drive for copying onto a

diskette later.

Basting Around a Design

WETEN view Zoom  Window

Center in Hoop
Align and Distribute, ..
Color Sort...

Designer 1 Disk Uitility. .. below.

! Threads...

Ll b b B s S B B B B S B b e |

M Embrilliance - Untitied 1*
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Individually selected designs can have a basting stitch added automatically.
This is useful when you want to add a layer of stabilizer or some other material
before the sewing of a design. The baste is always placed intelligently so that it
runs immediately before the selected element(s), as shown in the screen shots

0

z

1

(PP RNRRARERE RN AR SRR AL N R

 am | 0.0% 8 s|e| ol

Tich 0.0% 3 n|3[%|

4 Unbitled 1* ] -

TG 7 S A e G C U T | g

= & + 1

. -2 Kgb00703
- a + 3 * po0Toe
= 4o ala woos
A + 5 Igb00714
: b Qe

T
N

Zoom: 60% Curscr: 113.0mm x b1 e

Hoop: 300mm x 300mm ___180.9mm x 162.5mm Sthches: 19162 NobsjCois: 1425

All elements were selected (Ctrl-A) before applying baste.
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Product: Essentials
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Various elements selected individually and together before applying baste.

Notice where the baste stitches are placed in the Objects View.
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Here an initial baste is applied and then various areas.

Basting stitches can also be used to secure a layer of topping stabilizer in place before any designs
are sewn. A typical use of this is to add a layer of water-soluble topping to a towel, which keeps the

stitches from becoming embedded in the terry cloth loops during sewing. It can be hard to hoop a towel,

and the topping stabilizer will want to slide around before the stitching happens, so basting it first can

make the process easier.

The basting stitches are added to the start of the design or file, and are added as a separate color;

naturally you can use any color you want to sew the basting stitches.

77



The Embrilliance Platform

Product: Enthusiast

Once you have mastered the Essentials, you might be ready to play a little bit more, explore more
advanced functions, and take on a little more challenge. If this is you, you might be an enthusiast. We
named this program after you!

e Stitch editing

You can select stitches in your design using Lasso and similar tools; move, delete, copy paste, split,
and more. Repair gaps in stitching. Adjust compensation, change stitch type from satins and fills, select
and correct stitch types, including cleaning up jumps, ensure tie stitches before and after jumps.

e Multiple hooping

Many built-in multiple position hoops pre-loaded. Split AUTOMATICALLY using our patented
feature. Use Mega Hoop, Plus Hoop, Jumbo Hoop, Dream Hoop, etc.

e Baste Hoop
Beyond basting a design, sometimes tricky fabrics and toppings require an extra bit of help.
e Precise Position

Accurate positioning of any design on the page. Use this advanced customizing feature for perfect
layouts.

e Mirror X4
Take corner designs and perfectly set them in all four corners of the hoop.
e Instantrepeat
Repeat a design across and down. Make a nice effect.
e C(Carousel
Create a circular composition out of your designs.
e Scatter
Unique effect to create copies of your designs, including lettering, for neat effects on large spaces.
e Advanced Thread editor

Beyond the Essentials palette creator, the Enthusiast editor lets you make your own thread brands,
and pick colors right off web pages or PDFs.

e Advanced Stitch properties
Control satin and fill density within each color layer in any stitch file.
e Save Image utility menu item

Create a transparent .png file of the current design page for use on the web, etc.
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Stitch Editing

|%| The ability to edit individual stitches is a very useful tool. Sometimes there are parts of a

_ 1 design that you simply do not want. Other times, there are jams of stitches that simply cannot be
removed any other way. In still other cases, you want to add a few stitches to get rid of gaps or increase
coverage in an area that’s not necessarily a fill. Maybe you just want to make a pocket topper?

To begin editing a design’s stitches, click the Stitch Edit button on the toolbar. This will cause the
Tool pane to display the Stitch Edit controls, and the main view will show the stitch points.

Stitch points can be turned on or off from the View menu. They help identify the individual
needle penetrations in the design.

Selecting Stitches

Stitch selection is accomplished two ways:
1.) A range of continuous stitches.
2.) A graphical section of stitches (lasso, rectangle, brush selection).

You can select a range of stitches by clicking an ‘Anchor’ stitch, and then use the keyboard to select
additional stitches. (See the keyboard reference at the end of this section.)

Here you can see that we’ve selected a range of stitches inside the golf ball, but we've skipped the
satin stitches that go around the edge. If we hit delete on the keyboard, we can remove them!
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Another way to select stitches is graphically. You can drag a rectangle or a lasso around stitches to
select them. You can also use the Brush selection, which selects anything the cursor touches, or with the
Ctrl key, the brush can de-select points. Selected stitches can be deleted with the ‘delete’ key or split using
the ‘Split’ button.

Select stitches for an entire object or design using the Object View. While in Stitch Edit mode, simply
select objects in the tree and the corresponding stitches will be selected.
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Left: Lasso. Right: Selected

You can also select a single stitch by clicking on the line representing the stitch itself. Make sure no
other stitches are selected first, and then simply click on a stitch line. The stitch point at the end of that
line will select. This makes it easier to select a single stitch out of a jumble of stitches that may exist near
each other.

Converting Stitch Types

Right-click to bring up a context menu that will give you the ability to switch stitch types between
Jump and Normal stitching. For color stop inserting, use the Sewing simulator.

When you convert a stitch to a Jump, you have the option of ensuring the stitches on either side are
tied off. If you choose this option and the stitches are already tied off, then no stitches will be inserted.

Ensuring Ties

If you have a stitch that appears not to be ties down, and you will want to cut it, you can ensure ties
using the context menu. Simply select the stitch (as directed above) and then right-click for the context
menu.
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Splitting a design

Once stitches have been selected, you can delete them or split them, To split them,

c : click the ‘Split’ button. This will create a separate design for the selected stitches. It will
also remove the stitches from the current design. If your design is lettering or a Library design,
this process will convert that design to stitches so you will not be able to adjust that design the same as
before.

Above, the design has been split, and the crown was copied and pasted.

(@]

When splitting, no new stitch points are added. If you want to use the selection shape you’ve made
to actually cut the stitches, which will insert new stitch points, use the second button to split the design.
This is useful for something like a pocket-topper where you want a clean line of stitches instead of what
might otherwise be a feathered-edge.

Ordinary Cut, adding
Split stitches

Insert Stitches

If you have a stitch selected, right-click to get a pop-up menu that will let you insert stitches.

Notice that you can see the direction of the stitches when you are zoomed in. This helps determine
‘before’ or ‘after’. The arrow on each stitch points toward the next stitch as the design would sew.
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e ey

Insert Before
Insert After
Delete

Left: Right-click to select the Insert mode.
Middle: Inserting stitches.
Right: Stitches have been inserted.

Converting Stitches

Using the ‘Satin’ Drop-down box, you can convert selected stitches to a satin stitch, a choice of split
satin stitches, or even add a fill effect to an existing satin stitch.

Adding Compensation

Once stitches have been selected, you can add compensation, which makes the outside stitches of
fills or satins a bit longer or shorter. This is useful when you have gaps in a stitch-out and you would like
to ‘stretch’ the stitches together, thus reducing or eliminating the gaps. You can also use compensation to
adjust the width of lettering you may have imported.

Left: a typically gapped design. Middle: The stitches around the gap are selected. Right:
Compensation has been added by moving the slider to the right.

Allow Re-Generate

If you have edited a native object, such as one of the built-in lettering designs, the object still
retains its original digitizing data. However, as you have edited the object, the ability for the
program to generate stitches on that object has been turned off. You can re-enable generation
using the the normal Select Mode, select the object, right click > Allow Regenerate.
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Product: Enthusiast

Left Arrow:

Right Arrow:

Up Arrow:

Down Arrow:
Page Up:

Page Down:
Home:

End:

Delete:

Shift Left Arrow:
Shift Right Arrow:
Shift Up Arrow:
Shift Down Arrow:
Shift Page Up:
Shift Page Down:
Shift Home:

Shift End:

Precise Position

Select Backwards

Select Forward

Select Forwards 10 stitches

Select Backwards 10 stitches
Select next command (jump or color)
Select previous command

Select First stitch

Select last Stitch

Delete selected stitches

Range select backwards

Range select forward

Range select forwards 10 stitches
Range select backwards 10 stitches

Range select next command (jump or color)

Range select to previous command
Range select to first stitch
Range select to last Stitch

You can precisely position designs using these buttons. The three buttons on the (top, left) control
the display of the x-axis position. There are Left, Center and Right, which means that when you have the

Left button set, the display will be of the left edge of the design.

i [
o s

Similarly, the bottom three buttons control the vertical axis, top, center and bottom respectively.

The position controls are very useful for creating tiled patterns.

Your best friends will be the top ruler and left ruler along the edge of the Design Page. You will
notice that center of the ruler is “0”. To the left of “0” is -. To the right of “0” is plus. Let’s place a design on
the design page and get started with Precise Position!

1. Decide what size embroidery hoop you are going to use and open it onto the Design

Page. You will notice that there are four quadrants inside the hoop.

2. Open a design onto the design page.

3. Place the design in the top left quadrant. Note the numbers in the x and y location
boxes. (-47.17 and 50.25)
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4. Select the design and right click to copy and then right click to Paste the design.

5. Click on Flip Horizontally .

6. Delete the minus (“-“) from 47.53 and hit enter. This will move the copied design to the
right top corner.

7. Select the design and rigt click to copy and then right click to Paste the design.

8. Click on Flip Vertically.

9. Place a minus (“-“) next to 50.14 in the y location box. (-50.14)

10. Hit enter. The design moves to the bottom right corner.

R
| 0 B %

e T

11. Copy and paste the design in bottom right corner.
12. Click on Flip Horizontally.
13. Place a minus (“-“) next to 47.53 (-47. 53) in the x location box. Hit Enter.

14. Your frame is now complete!
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This is a great way to align your designs without the frustration of where you placed the first design
and how to get the others to follow suit.
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Instant Repeat

From the Utility menu, select “Instant Repeat.” This opens window that lets you create a pattern of
designs, copied from the current selection, and pasted in rows and columns.

To change the values, click the arrows next to each value, or type in a value and then click on
another one to set it.

As you change the values, you will see your result on the main view.

Click OK to accept your new designs.
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Above: An example of a repeated design.

Notice how the preview enables you to see the pattern as you adjust it, which helps if you're trying
to fit an area, for example the hoop.

Note: The initial design will be the (top, left) design, and the copies will go to the right and down.
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Mirror X4

From the Utility menu, select “Mirror X4.” This will call up a window that lets you create a pattern of
designs, copied from the current selection, and pasted in mirrored corners.

To change the values, click the arrows next to each value, or type in a value and then click on
another one to set it.

As you change the values, you will see your result on the main view.

Click OK to accept your new designs.

o

Mirror x 4

Horiz. gap

Vert. gap

Above: An example of a Mirror X4 design.

Notice how the preview enables you to see the pattern as you adjust it, which helps if you're trying
to fit an area, for example the hoop.

Note: The initial design will be the (top, left) design, and the copies will go to the right and down.
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Carousel

From the Utility menu, select “Carousel.” This will call up a window that lets you create a pattern of
designs, copied from the current selection, and pasted in an elliptical fashion

To change the values, click the arrows next to each value, or type in a value and then click on
another one to set it.

As you change the values, you will see your result on the main view.

Click OK to accept your new designs.
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Carousel

Width

Height

[ Invert alternating

Rotate:

Rotate All:

Count:

Above: An example of a Carousel design.

Notice how the preview enables you to see the pattern as you adjust it, which helps if you're trying
to fit an area, for example the hoop.

Note: The initial design will be the (top, left) design, and the copies will go to the right and
around.
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Scatter

From the Utility menu, select “Scatter.” This will call up a window that lets you create a pattern of
designs, copied from the current selection, and pasted in random locations based on your dialog box

selections.

To change the values, click the arrows next to each value, or type in a value and then click on
another one to setit.

As you change the values, you will see your result on the main view. Click on New Pattern to
generate a new random pattern based on the selected values

Click ‘OK’ to accept your new designs.
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Sizes are

Width

v Auto-rotate
[v Random Mirror

Min size

Max Size

Spacing

Above: An example of a Scatter design.

Notice how the preview enables you to see the pattern as you adjust it, which helps if you're trying
to fit an area, for example the hoop.

Note: This is a way to get a random repeat of similar designs.
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Add Knockdown Stitching

Center in Hoop When sewing on terry or any fabric with loops and nap, generally a
Align and Distribute... topping stabilizer is used. These can be helpful, but have a limitation: They do

;:i:er;z:gn not hold down the nap past the actual stitch, which means outlines can be lost
Project Advisor... in the surrounding fabric. Using the menu Utility->Add Knockdown Stitches you
Designer 1 Disk Utility... can create a global underlay for the entire design. The underlay extends a few

SaveImage... millimeters past the edge of the design, which helps the overall effect.
_Add Knockdown Stitching % i

Save Image

You can quickly save a transparent .PNG file of your design page with this item, found on the Utility
menu. The image is created at 600 DPI. You can use any image editing program to adjust size or save as a
different image type, if desired. This utility is useful for putting designs on the web, in print, etc. The
images above were created with it.
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Baste Hoop

With Essentials, individually selected designs can have a basting stitch added automatically. This is
useful when you want to add a layer of stabilizer or some other material before the sewing of a design.

But with Enthusiast, a basting stitch can be added to the hoop, which allows for a layer of topping
stabilizer to be basted in place before any designs are sewn. A typical use of this is to add a layer of water-
soluble topping to a towel, which will prevent the terry cloth loops from coming up through the
embroidery. It can be hard to hoop a towel, and the topping stabilizer will want to slide around before the
stitching happens, so basting it first can make the process easier.

The basting stitches are added to the start of the design or file, and are added as a separate color;
naturally you can use any color you want to sew the baste.
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Product: AlphaTricks™

There are many great fonts in the world, and lots of design companies are digitizing fonts as regular
stitch files. The difficulty with these comes in using them: The letters have to be imported one at a time,
there is no baseline, the sewing order can be messed up if you copy and paste; sizing and color sorting are
issues to be managed too! Plus it would be nice to use the envelopes and text path tools that are used for
the built-in keyboard lettering fonts.

Use Designs like a Font

For this reason, we have created AlphaTricks. This window is brought up from the Utility menu
item, “Import Font...” and it lets you import fonts as well as manage ones you've already imported. Let’s
take a look at this Import Font dialog box as it contains the mapping shortcuts as well as other useful
information and tools. The following numbered picture is shows you the tools and buttons in groups as
they will be described below:

] Import Font n_
Font: |.-'-\ Font &ﬂ Letter Space (%) |4 ﬂ e [ Hide this font e New Font...
MName: | A Font Word Space (%): |25 ﬂ Baseline: | j Save Font |

@ﬂﬂ Letter: IE]_ MGM: | Center °Map: A-Z | az |Aa-22| 0-9 | Add Designs | Delete Font

Top: 24.4mm, Center: 11.8 mm, Bottom: -0.8 mm
a X Y rz 0 1 Q 2 3 4

Y

KE| = |

1. This shows you the name of the folder that you have selected. Below this is name of the font
as it will be shown in the font list in your program. You may change the font name and this
information will be saved with it and displayed in your font list.

2. We have set the default spacing between letters and words which will be perfectly fine for
most fonts that you map. If you find that these settings need adjusting, you may do so here and
these values will be saved with your font.

3. Here we have the buttons for adding a New font, Saving you mapped font, Deleting a font you
have previously mapped and Add Designs to an existing mapped font.

4. The trashcan button allows you to remove the current letter from the mapping process. The
Letter: shows you the name of the current design - once it has been mapped, this field will
show you the character on the keyboard that corresponds to the currently viewed letter.

5. The MGM pulldown is for mapping monogram alphabets - is the current letter a Left, Center,
or Right monogram letter.

6. The Map: buttons are “quick mapping” tools that you can use for fonts that have been named
sequentially and are displayed as such in this dialog.
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7. The key mapped is labeled above the design. Also the size of the currently selected design is

shown. You can use this information to consistently position letters on the baseline, or offset
from it while dragging.

8. Ifyou have alarge number of fonts, you may want to hide some of them temporarily from the
font list in the properties of lettering designs. Check ‘Hide this font’ to do so.

Let’s get started. Click the button ‘New Font...” This brings up the window that allows you to browse
and import design files. Since you are importing a whole font, find the folder with the font and click ‘Sel.

All’ to select all the designs. If your folder contains designs that are not specifically part of the font itself,
you might want to use the ctrl-click to de-select those files.

% Open Design Files e
KO % E &
Size 30 Close
Brows:

e |

/07

9 2 4

ZADocuments\Designs\My Fonts\BoldAndCursive\l pes Size: 1280 x 18.20(mm), St: 164, Col: 1

It is important that all the files for the font are together in one folder for easier and complete
mapping. If you discover that some files are missing, for instance the “0”-“9” designs, you can open this
font at a later time, choose Add Designs and resave your font.

Mapping Letters

Once you have the designs loaded into the window, you will have to map them to keystrokes. The
field marked “Letter:” lets you type a character on your keyboard which will map to the current design.

The current design is boxed in by black lines in the view on the right. In the picture at the start of this
section, the number ‘0’ is selected.

o Import Font ﬂ

Font: | Font ~| Letter Space (%): |+ j [~ Hide this font New Font...

femes |’I”:DHt Word Space (%): |25 ﬂ Basehne:l j Save Font
@ 4 | ¢ |Letter |0 MGM: | Center = Map: A-Z az | AaZz| 08 AddDesigns‘ Delete Font ‘

Top: 24.4mm, Center: 11.8 mm, Bottom: -0.8 mm
X Y Z 0 1 2 3 4

[« g 0

If you have a set of designs where all the letters or numbers line up next to each other, you have
some shortcuts provided for you to map the keyboard to the designs. You'll see the buttons “A-Z”, “a-z”
and “0-9.” As an example, click on the design that is the letter “A” to select it. Then click the “A-Z” button.
This will automatically map the A-Z letters to those 26 designs.
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If your designs are organized in some other order then you will have to manually type those keys to
map the font. Select each letter, then type its key in the ‘Letter’ box.

Adjusting Baseline

Lettering has a ‘Baseline’ which is an imaginary line where all the letters line up so that they are
readable. The text you are currently reading has a baseline at the bottom of most letters. Some letters
such as ‘j, y, pand q" have ‘descenders’ that extend below the baseline. Sometimes a font, particularly a
monogram, will use a baseline not at the bottom of the letters, but at the top (or more likely, center) of
the text. Use the ‘Baseline’ drop box to change the baseline if you are importing a monogram font that
should be centered vertically (center) or align at the top (Top).

Sometimes individual letters require adjustments for their baseline. In the view, the pictures of each
letter are shown, with a black line representing the baseline. Click on a letter to select it, and once
selected, drag the letter up or down as necessary to place it relative to the baseline as you like.

Some things like apostrophes always need adjustment, naturally, but letters with descenders like “g”
or “y” will usually need adjustment also. To move more slowly, hence more precisely, hold the Ctrl key
while dragging.

Spacing

The spacing of letters between each letter and each word can be set using these boxes. The spacing
is always a percentage of the font height.

Letter Space (%): I 10 j
Word Space (%): | 15 j

Editing Fonts Already Imported

. 4
# | Import Font -5
Font: |[Bold And Cursive | Letter Space (%): | 10 j New Fant...
Mame: |ADaisyDayAlphabet PES 1] . =1
Wardspace (: [15 ] save Font
- Chrome QESD -
W7 | L{EL 3 Curly font az | Aazz| 09 |  AddDesigns| [ DeleteFont |

Embroidery Network Swirl Script PES BW
F5F Boo Font Pes LV

F5F Free Stack Small ART

FSF Not So Girly Whirly Font ART

F5F Turkey Mono <x4 ART

Rosewater

______ Upsy Large

Upsy Medium

Upsy Smal

Windstar Embroidery Rosewater

1

Use the Font box to select a font that you want to edit. Once the font loads, you can make
adjustments to the font, such as remapping letters, adjusting sizes or positions on baseline, etc. When you
have the font how you want it, click “Save Font.”
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If your font is missing letters that you have now located, use the Add Designs button to open the

Import dialog box to select and add the missing letters. You will need to map these new letters and save
the font.

Note: Fonts must be named uniquely. If you accidentally name a font the same as an existing on,
it will get a (2) added to the name.

Another Note: Long font names may run past the visible space on the font selection in the Letter
properties, so we recommend shortening the font names using initials or abbreviations.
Do this in the Name line under the Font list box.

Using Imported Fonts

Properties
Color  Letters | Sitch |

= =9
set]
| ABC == ||
ABC Block

l.rc DR
ALBEG vokdcusive
',! S8  cvomeoesd
A B C Comedy
'IJ ABE EL 1 Curly font
'Il ﬁB@ Embroidery Metwork Swirl Script PES BW
I ABL,  FFooofontresty

When you create a lettering design, you can now use the font that
you’ve imported. Imported fonts are indicated with a needle overlaid on
their icon, as seen on the picture to the left. These fonts can do almost
everything that the built in fonts can do, such as make monograms,
circles and even be shaped. When these letters get sized, the built-in
sizing technology will recalculate their stitches.

There are however, no stitch properties for these fonts, as they are
stitch-files, not our digitized objects. So removing of hidden stitches,
underlay and density cannot be changed, for example.
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Product: Density Repair Kit™

Welcome to The Density Repair Kit, the most sophisticated density adjustment and analysis tool
available for the embroiderer! DRK does the following:

* Removes hidden stitches from within a design so that it will sew thinner, cleaner, and with less
thread (and needle) breakage.

* De-Clumps design areas. These are areas that are over-sewn repeatedly with the same color.

* Filters small stitches from your designs that would otherwise create thread build-ups and jam the
machine.

* Reduce the density in designs that were shrunk to fit a hoop.

* Increase the density of designs for better coverage.

* View the density of designs to see how they’ll sew before expending time and thread on a trial.
* Limits the density of your designs based on the fabric and thread that you are using.

* Informs you of how best to embroider the project or fabric that you are working on. It
recommends stabilization, hooping technique, needle type and size, and thread weight to help your
project succeed.

* Saves you time and money. Reduced stitch counts save enormous amounts of time and thread
usage. Proper density adjustments allow projects to complete successfully. With DRK, project time
and thread savings of 15%-30% are common!

Why The Density Repair Kit?

Have you ever had a design come out bad? Of course, we all have. That’s why DRK was created. DRK
cleans up embroidery designs that are too dense or poorly digitized for your project.

How? Like its name implies, DRK has a set of tools to adjust the density of embroidery designs.
These tools help you embroider with greater ease. You can alter the density of any design, and make that
design work on virtually any project or fabric type.

It does this by asking you what you are going to be sewing on, and then it analyzes the density of
your embroidery design and adjusts it.

Now, you're probably wondering if it takes an embroidery instructor camped out a week at your
house to get you up and running. No, it doesn’t. You can have the program do everything automatically or
you can control it manually. Running DRK is easy.

A Side Effect of DRK

By reducing the number of stitches that are in a design, DRK saves you an incredible amount of time.
Even with today’s fast-stitching machines, 10,000 stitches is still around ten minutes. The thread savings,
the number of bobbins saved, and the frustration of failed embroidery all add up! Imagine tackling a
project and knowing that it will sew okay before you even start!

If you're intrigued please read on.
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The Density Map

m The Density Map is a graphical display of the density, or stitches-per-inch in your designs. To
see the Density Map, click the button on the main toolbar. This is useful to see if a design is not

going to sew well. For instance, this is a design that has been overlapped, thus its density is very
high.

Where the design shows bright red in color, there are six layers or more of thread, which
undoubtedly will produce poor embroidery results.

The Density Map can be used to illustrate when a design (probably from the internet) is dangerous
to sew on a project without test sewing it first. And it also helps identify when you would want to you're
the Remove Hidden Stitches function or even the Sweep. Those features will remove stitches that are
likely to cause poor design production, while maintaining the same visual design. Here is the same design
after a Sweep is performed:
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Wireline View

The WireLine Density Map is like a x-ray of your design, allowing you to see through the layers of
stitching to analyze those under- neath. It helps to see the relationship of padding stitches, as well as how
a design has been compensated. You can view the whole design or individual colors to better see what'’s
going on inside your design. Zooming in the WireLine allows you to get up-close and personal with the
stitches to see how they were digitized. When determining which colors to remove hidden stitches from,
the Wire- Line Density map is your best analysis tool. And, in addition to all the above, it looks really cool.

Stitch Properties

The DRK version of Embrilliance allows for more control of the stitches using our Project system.
The Stitches property tab adds controls to use the project settings from the Project Advisor to remove
stitching, De-Clump, and limit the density.

Properties

Color  Stitches

Density adjustment:

Satin: 0% _,
Fill: 0% 13

[ Prevent Sweep

Filters:

[ Use Automatic Settings

[ Limit Density (Based on Project)
[ De-Clump

[ Remove Underlap (intra-design)
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Density Tuning
DRK has a density tuning control that lets you adjust the stitch
count of your file while keeping it the same size. As the program
adjusts the stitches it will also keep the pattern fills intact.
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By moving the density tuning control slide + or - 25% you can
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easily adjust the density.
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After reducing a design to fit your hoop, DRK can alter the
density according to the new size of the design.

Another use for the density tuning is to increase the coverage
that a design gives. For instance, using puffy foam under an area of
satin stitches in a design that wasn'’t originally intended for it can
now be accomplished by increasing the satin fill density for that
color. Or if you are embroidering a towel, and want better coverage
to keep the loops in the terry cloth from popping through, simply

increase the Density Tuning slider.
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Filters
Use Automatic Settings: makes use of the Project Advisor project to identify the fabric

[ ]
density, thickness, stretch and material being used. The needle penetrations are then
adjusted accordingly.

e Limit Density: Certain combinations of fabric and stabilizer have limits on the number of
stitches per square millimeter. More than that causes poor stitching or puckered fabric.
Using the Project Advisor, the limiter will reduce the stitch counts in the affected regions.

e Remove Underlap (intra-design): Often a design has color layers that have some overlap for
the purposes of registration. However, many times these regions are a result of auto-

digitizing and poor results follow. The so-called, “Bulletproof Embroidery,” is an example.
When stitching enters an area within a design that will be covered by a later color, those
stitches can often be removed, and that is what this does.
e De-Clump: Within sewing a single color, areas sometimes get too many stitches overlapping
in small groups. These areas form clumps of thread on the back of the fabric which can
become entrapped in the needle plate. Sometimes this traps the embroidery in one place

and cause loss of registration. De-Clump reduces these stitches.

Limit Density
Some designs are simply digitized too dense for certain projects. Other designs work well except for

particular areas in the design that are too dense. When you select a fabric density and thread weight in
the control group “Automatic Density Adjustments,” the Density Limiter creates a minimum-allowable
density for your project. The Density Limiter will analyze each section of your design, looking for stitches
that are too close together. It will then selectively adjust the density of those areas that need it. Only areas
that are too dense for the project and/ or thread are affected. This filter is very helpful when you
increase the thread weight. Fabric stabilization needs to be radically increased with heavy thread. By

reducing the number of stitches, heavy threads can be better supported with less stabilization. Also, this
99




The Embrilliance Platform

filter will help preserve a clean look to your designs when working on loose fabric. Because the fibers in
the fabric are farther apart, stitches will tend to clump in one needle-hole, rather than fanning out evenly.
This gives a ‘pinched’ look to the edges of the embroidery. If your design is too dense for some fabrics,
your needle can actually cut the fabric, leaving you with a hole and a patch instead of embroidery.

Remove Underlap

Now you can combine designs and have them overlap! In the past you could not do this because the
area where they overlap would have too many stitches. This tool can automatically find those overlapped
areas and cut out the stitching underneath so that the design can sew flat!

Here’s a great example for the use of this tool:

Suppose that you want to create a drop-shadow for text. Duplicate your text, and change the color.
Then position the top color slightly up and to the left. Remove Hidden Stitches to flatten the result so that
it will look nice and sew easily.

What about areas that were digitized without ‘hole-sewing’ mode turned on?

Say an area of color has another color sewn in the middle of it. Remove Hidden Stitches will ‘flatten’
the area under the second color by converting the hidden area to a satin fill. This makes it less difficult for
the needle to penetrate the fabric as the top color is sewn.

In some designs more than one color is used to create padding stitches for the entire design. In this
case you will want to turn the “Keep Padding Stitches” feature on in the Preferences Window. These
stitches are technically hidden and will be removed otherwise.

Maybe you want to do this. But the first eagle’s wing is a problem:

The under wing needs to be removed. Select Remove Hidden Stitches to remove the under
wing of the eagle:
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Your design is ready to sew. (And it will!)

Note: This is different from removing hidden stitches created by overlapping separate designs,
such as in a composition. This filter works within a single design.

De-Clump

This is a variation on the Remove Hidden Stitches filter. De-Clump will analyze a color and remove
stitches that are hidden within that single color.

When a color sews repeatedly over itself, it can create a thread build-up that prevents the design
from sewing nicely. Too much thread will distort a design, causing the fabric to ripple around the edge of
the design. De-Clump helps to thin the design by reducing the number of thread layers.

We're certain that you've watched a design sew in-place a dangerously long time. If you're like us,
you hate watching it because you just know it’s going to jam up. De- Clumping takes the worry out.

Another benefit from De-Clumping is that you can get rid of excessive padding stitches from poorly
digitized designs, as well as those annoying sections where a design sews over itself. HINT: A topping,
such as a water-soluble stabilizer, provides most of the support your design needs. This can help in
situations where the padding was poorly implemented. NOTE: Designs that have padding stitches
removed by the De-Clump filter will sew out differently. You will encounter more jump stitches nested in
the design.

It is okay to cut away the jump stitches while sewing. If you prefer, however, you do not have to
since all these stitches will be sewn over later.

The Sweep

The Sweep function, which is run from the button with the vacuum on it, will remove
hidden and nested stitches within designs, as well as removing hidden stitches where designs
are overlapped.

These patented filters operate on the colors of a design to help reduce the stitch count,
removing excessive overlays and stitches that tend to ‘ball up’ on the underside of the fabric.

Removing hidden stitches occurs as the program examines the design, looking for color layers that
overlap more than is necessary for compensation. If stitches of one color layer are on top of the stitches
for another color, and those stitches are not visible, they can usually be removed. Stitches that would be
overlapped at the edges of the colors are important for the design so as not to have gaps, thus they are
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not removed. What you get is a reduction is stitch counts, a reduction in sewing time and a reduction in
puckering.

Note that the Sweep is different from the process that removes stitches from overlapping designs.
The Sweep operates within a single design, whereas overlapped designs are ones that are merged in
separately and then laid on top of each other. The processes are similar, but different in that way.
Another difference is that the Sweep filters are not temporary; they are re-run on the designs as they are
adjusted (for instance by sizing.)

De-Clumping is a process where stitches within a single color are eliminated if they will gather up in
small areas. These clumps of stitches can often prevent the hoop from moving freely by forming a ball
under the fabric, which can anchor the needle in one area. When and if the hoop finally pulls away, the
user often hears a ‘clunk’ sound and their project will probably have a gap, as registration may have been
lost.

Occasionally one of the sweep filters will leave an undesirable result, which is visually evident. As a
rule, these filters do a great job, and if the design looks good on the screen, it will sew nicely. However, if
you see something onscreen that you don’t like, you can prevent the Sweep from running on individual
colors using the Stitch Properties tab.

Note: You can also prevent Sweep operations for occurring on certain objects or designs when
you want to.

Project Setting

Project Advisor

Fleaze select a project/fabne twpe:  Becommendations: StitchPerfect: Mo curent setting

Meedle: Leather, zize 14
Thread: 30 wt.

Set Project Mo Project ‘

Y'ou may alzo madify the settings:

When you have chosen a project in the Project Advisor, the program lets you set that project on the
design page so that the Stitch Perfect filters can use it.

If you would like to clear your project, click on ‘No Project.’

The Project system stores information such as Fabric, density, stretch and stabilizer to help the
filters for stitch files minimize the pucker and gather that occurs when designs are used on lighter fabrics
than for which they were digitized.

Where DRK Gets Fooled

Remember that it’s just a program running on a computer, and that’s the same type of system your
bank uses to lose your credit card payment. Computers don’t know anything about you or what you are
doing. They are only taught to handle basic general parameters. We've tried to make the automated tools
work well for most designs, but please look at the result before sewing. This will save you a lot of time.

Here’s a for-instance: Cross-stitch designs sew over themselves a lot. De-Clump sees this as a no-no
and tries to lighten the load. This will result in extra jump stitches, and you'll be mad at us. We haven'’t
figured out how to teach the computer to know that you are doing cross- stitch yet, so you’ll have to keep
that in mind. A little common sense (yes that can be an uncommon thing) will help a lot. Overall though,
we think you’ll be amazed and happy and dance.
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Welcome

StitchArtist is a program designed to allow embroiderers to create stitch designs from scratch using
existing artwork or by ‘drawing with stitches.” It has been described as an object-based digitizer. You
draw and control the shapes, set the stitch type and properties, and StitchArtist generates stitches for
you. When you want to create stitches, that’s what it does.

StitchArtist comes in levels that suit different skill level embroiderers.

Note: Each topic in this manual may have notes for different levels. This allows for continuity in
the learning process. As you progress, you can purchase additional levels whenever you
are ready.

Level 1

Level 1 is designed for a hobby embroiderer who needs to be able to create stitches without going
into debt or spending much computer time. Level 1 offers a limited set of stitch types and, more
importantly, properties for those stitches, so that the user can simply ‘create.’ Typical projects for Level 1
are applique designs, running stitch designs and simple filled shapes, backgrounds or unifying elements
for design compositions etc. It is not designed for logo work or publishing, unless you’'re working with

applique.

Level 2

Level 2 includes Level 1 and is designed for basic skills training for those who would like to create
more sophisticated designs, as well as a basic set of tools for logo creation. It will allow the user to learn a
wide cross-section of stitch types and properties, and have enough freedom to create virtually anything.

Level 3

Level 3 includes Level 1 and Level 2 and is designed for someone who either loves to create designs
or works commercially in the embroidery field. This level includes advanced items such as QuickStyles,
adding user-created motifs and designs, graphical operators such as Reconstruct, Outline Stitches, Inflate,
Cut, AND, Union and Break, extended Vector support and more.

Note: Illustrations in this manual are shown with Level 3 enabled unless otherwise
noted. Feature differences in other levels will be discussed in the text.

What StitchArtist is ‘Not’

StitchArtist is not an attempt at fully automatic design creation. It will not attempt to ‘convert an
image’ into embroidery; It does not contain photo-to-stitch for example. These are all reasonable tasks,
but are not the same as what StitchArtist is.

It is also not a ‘customizing’ or ‘editing’ program for the manipulation of existing embroidery
designs. You may load designs so that you can add stitches to them, but they are not alterable in most
ways.
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A Note about “Digitizing”

Embroidery designs have been created with computer programs since the late 1970’s. The
hardware used by artists at the time came from the CAD/CAM industry (Computer Aided
Design/Manufacturing) and consisted of a CAD “digitizing” board (like an architect desk) and a mouse-
like ‘puck.’” As no one thought to change the CAD term, the word “digitizing” has been with us in the
embroidery craft ever since. We prefer the term “Design Creation” though for two reasons: 1: Because it
really is more accurate. And 2: Because the term “digitizing” carries negative connotations of difficult-to-
learn software. Therefore “Digitizing” and “Design Creation” are interchangeable in this manual; however
our product is a change in the user interface, and is easier to use. Just wait, you'll see.

The Dual Learning Curve

Design creation is a two-fold learning process. First, there is the software. That is the set of buttons
and sliders that make objects to be stitched. That’s pretty easy to learn, especially for anyone who
understands drawing programs or even has general computer skills. Whereas digitizing software in the
past had been developed in its own little world, and the graphics programs went their own ways, the two
are now converging with similar tools and operations in both. Do not be misled into thinking that
embroidery and graphics are at all similar though, as designers can get away with all kinds of things in
graphics that simply are not possible in embroidery. The level of sophistication in an embroidery creation
program is much higher than a graphics program, generally speaking.

That brings us to the second and more difficult part of the learning curve - the knowledge of
embroidery itself. Embroidery involves thread and fabric. Both are flexible, usually stretchy to some
extent and operate differently in different combinations. In graphics you can do things however you
want: In any order, at any place, or jump from point to point without regard. And the result will always
look the same. With embroidery all those assumptions are false. You need to understand which stitches
will go down first, and why they go there, and you need to really think about where the machine is going
to go as it stitches the design. Generally there are three areas of thought that need to be part of your
process when you create a design:

* The material, thread and project combination. This dictates certain items such as the amount of
coverage you need, the maximum number of stitches within an area that can be added to the fabric
before it puckers, and how it will be stabilized so as to mitigate somewhat the inherent limits of the
fabric.

» The path the machine will take as it creates the design. You don’t want to leave thread trails all
over, and you don’t want to have to cut those either. Even if the machine does that for you, you still
have to spend the time on that process. And if a design always sews in a given direction, you wind
up pushing the fabric around so much that the later stitches won'’t align or ‘register’ with the earlier
ones.

» The types of stitches used. This is the topic that is easily understood, but can take a lifetime to
master. The basic stitches are pretty obvious, but the quality of the output comes from clever usage
and combinations of elements.

Learning with this manual

This manual covers the usage of the program itself, and attempts to interject some knowledge of the
embroidery process as well. However, we very much recommend the reader take educational programs
on design creation from others. There are a number of wonderful educators for digitizing in the
marketplace, and their fees are generally well worth the knowledge you will gain. With respect to those
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instructors, please humbly accept that any differences you find herein with regards to your teachings, are
not intended to be the ‘only way’ someone ought to do something, nor necessarily the ‘best’ approach, but
perhaps is what we ourselves are comfortable teaching. We all have our own styles, and those differ from
time to time.

If you have never embroidered before, take some time to learn the use of your machine and the
basics of embroidery. Your local sewing machine store will have classes that you can attend to help you
get going. We must assume for the purposes of this manual that you understand the ordinary hobby
aspects of embroidery — what a hoop is, what stabilizer is, what a ‘design’ is etc. Hopefully you have at
least stitched something successfully.

You do not have to be an artist. Really -- let’s say it again --you do not have to be an artist.

The reason is that embroidery creation is more of a ‘color-by-numbers’ process. You may be an
artist, and that’s great. You can even create your art within the program. However the process of laying
stitches on top of your art or image is a mechanical, methodical and logical process, provided that the art
is suitable for embroidery. And there too is a reason why we ask that you have at least done embroidery -
it will provide you some insight as to what's possible with embroidery, and what simply isn’t. Naturally
an artist can alter a complex image to be more suitable for embroidery, and a person with some
experience creating designs may be able to do that intuitively as they work. It all comes from the learning
process and involves much trial and error along the way. You won’t learn to paint overnight, nor learn to
play Chopin the first time you sit at a piano, so please don’t expect to be creating complex designs well
the first time either. But with a bit of persistence, creating designs is a much faster and easier learning
curve than those other endeavors, and you can begin with simple things and start sewing in practically no
time.

Reminder about Levels: Illustrations in this manual are shown with Level 3 enabled unless
otherwise noted. Feature differences in other levels will be discussed in the text. Some
sections have information pertaining to multiple levels. We have indicated the minimum
level for which the text is relevant. Where practical, we have added higher-level
information toward the ends of sections.

The Interface

The interface in StitchArtist is different in some respects than programs that have come
before, especially digitizing software. We’ll define all these terms as we go, but if you're familiar
with them already there are some things you should know now...

When creating embroidery, you normally will be doing several types of tasks:
1. Loading artwork as the basis for the design

Creating stitch-generating “objects.”

Editing the “shapes” or “outlines” of those objects.

Editing the “properties” for those objects.

Moving objects around on the design page.

Sequencing objects for sewing order.

Adjusting the “entry and exit points” for sewing objects.

® N o oA W

Colorizing objects.
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In StitchArtist these different types of operations do not require any program ‘modes’. Generally
speaking there are only two modes that you'll run into during design creation: The normal ‘Selection’
mode when the program starts, and the ‘Creation’ mode that you’ll use while creating the designs.

You will not need a separate tool to reshape the outline of designs, nor need to switch modes to size
or move objects. All the tools for design creation are accessed from either the ‘Create’ menu or the
‘Create’ Tool Pane, which is shown using the ‘Create’ button on the main toolbar.

All selected objects have their properties adjustable at all times, and the properties can be set on
any number of selected objects simultaneously, causing immediate generation of the selected objects.

There are also virtually no “Apply” buttons or ‘Enter’-key requirements - stitch generation is
automatic and immediate.

The Embrilliance Platform

There are a number of features in the platform that are consistent across the products including the
Navigation HUD (a compass rose in the top, right corner of the Main Window), the Zoom Slider, the Edit
Menu, Zoom keys, etc. Please review these areas in the program help so that you’ll know the basic
navigation of the program.
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Design Pages, Designs and Objects

Objects are usually shapes that have stitch types and properties associated with them. The object
may for instance be a Run, or a Satin Column or perhaps a Fill.

Objects +d Objects can contain lots of information: Outlines, holes,
L & inclinations, breaks, images, stitches and colors. Thus a single
=1 _@ Design ~ object could contain an applique - the shape of the applique, a
picture you want to print cropped in the outline, the stitches that
‘- Fill are generated to sew the applique and the colors for the position,
material and topstitch sewing, and even more. We'll discuss all
(R O Run that separately, so please keep reading.
1 3. A Fill Designs are groups of objects that are collected together.
This might be an individual design that you want to sell, or a
T:4 57 Run smaller piece that you'll reuse as an element in other designs.
Designs let the user work within a section of an overall
1:5 Fill composition without being encumbered by the whole. This is
e Fill similar, but not equivalent to, a term used in some graphics
programs as a “layer.”

When observing the relationships between designs and objects, see that the Object View, normally
docked on the right of the program screen, has at its ‘root’ level the designs, and when you expand a
design, you'll see the individual objects that compose that design. If you select a design, by clicking on itin
the Object View, you will be selecting all the objects contained in that design as well. If you select all the
objects in a design, selection of the design itself is optional. This is useful for copy/paste operations.

When creating new objects, you have the ability to choose where they go - into which design, and
even where in that design they are created. We'll talk more about that in the ‘Creating Objects’ section.

The top level of the program uses what is called a Design Page, which is related to a document or
file. The Design Page is stored as a .BE file on your computer, and can contain any number of designs,
each composed of any number of objects. You can have as many open Design Pages (or documents) as
you like, and each is represented by a tab at the top of the main view.

4 Untitled 1 Untitled 2 Untitled 3 3
LllJ.I_I_I_I_I_I_LLL11]J_I_I_|_I_LLL|.L1lJ.I_I_I_I_I_LLLLlJrJJ_I_I_|_I_L
Sem 8 T B
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Properties

The interface has a Property Page, usually visible on the lower right part of the program window.
The size of the Property Page can be adjusted using the splitter bar that lies at the bottom of the Object
View. You can also drag the splitter bar that lies on the right of the Main View if desired. For general
interface adjustments, please review the user interface section of the program help.

When you select objects their properties are shown as tabs in the Property View. If you have more
than one object of a given type, the properties of the first selected object of that type are shown.

Properties B
Color  Fil lSatin Eh:un:ler] Run ]

Toodimle| |

The controls for the properties mostly exist in five forms:

1. A setof buttons that let you choose which properties you are adjusting.

2. Adrop-list that lets you select from a set up options.

3. An editable text field that lets you adjust a value.

4. A pop-up slider that lets you set an adjacent text field by dragging its value.
5. A check box that lets you turn a property on or off.

If you adjust a property, all the selected objects of that type will have that specific, and only that one,
property adjusted. Having adjusted the property, the stitches will generate automatically. You should see
the change in the stitches of the object immediately.

Color

Color is a property of an object. Objects have one color each, except for appliques, which by
definition need to stop the machine. When exporting stitches, objects of the same color that follow each
other will not cause the embroidery machine to stop unless there are applique steps involved.

When no objects are selected, all of the colors for the page are visible and changeable. To change a
color, simply click on it in the list.

Calor ] n Thread n-‘
Thread... | [ 1Coer.. | Prefemed | | color | Appique | I
Click below to change individual colors. View: W = Thread H
= . @ Threads | ot 5 Color © Name © Number ‘ Color ]Appl\que]
1: Brather Embroidery FS ol
Light Blue PatEs | conrehy vew:— [Fommarramt El—
— Eifsfg}:L Erbroidery ;gfﬁﬂiugmeéﬁzbmidew ;::I’::‘b‘:: Sort: @ color " Name  Number —_——

78 Brother Embiodery Search:

013 Sky Blue 4: Brother Embroidery A

73 Brother Embroidery Telos
420 Electric Blus |

3 Brather Embroidery
Blue

4: Brother Ernbroidery
ellow

5 Brather Embroidzn
80 Brother Embroidery Flesh Fink

704 Pewter "% Brothe: Embroid

) . nther Embroidery
5: Brother Ernbroidery #1: Brather Embroidery Light Blue

Beige 007 Frussian Elue

7- Brother Embroidery
E: Brother Ernbroidery hd 82 Brother Embroidery Elue
< >
% Brother Embroideny
Light Lilac

Design creators often need to utilize a palette of given colors. S =
customer’s job requirements, and other times it is merely a matter of needle assignment for the
embroidery machine. You can create palettes at any time using the menu Utility->Threads... And you can
choose to use any palette as you adjust the color properties.

]
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You can also create a palette on the fly while creating your design. If you wish to switch to an
already-used color on the current page, select the ‘Palettes’ button in the color window and you will see
in the list, “*Current Page.”

The Tool Pane

% The tool pane is located below the main toolbar. When you click the toolbar button to create

stitches, you'll see this tool pane, which is divided into sections.
imoges: y E’E’E‘%‘ Draw: RK" \f ﬁ Q ﬁ J Stitch: E i %‘ g - Path: :‘ [i] @ J
Vector... Qh‘ l‘ﬁ 2l Vsl E O “ ﬁ g %{ % % @" i

The first section is used to bring existing images or artwork into the program. You can load a raster
image (Bitmap, Jpeg) or a Vector image (Metafile, Adobe Illustrator) or even use a TrueType font as
artwork for your creation.

-
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The next section contains view and mode options. You can hide the background images or the
stitches while you are creating your designs. You can also re-sequence the objects in a mode that lets you
click on them one after the other on the Main View.

The drawing tools are next. These let you create shapes, open and close outlines, add inclination and
carving lines, etc.

The Stitches section is used to apply stitch types to selected objects.
The Paths section is used by illustrators to convert images into useable embroidery shapes.

When using tools such as the Magic Wand, another section becomes visible as needed to allow for
adjustments to the current process.

Panning the screen

Sometimes you want to pan the screen - in other words, move it around - while not changing your
zoom, or using the scroll bars. The easy way to do this is with the spacebar key. Hold the spacebar down,
your mouse cursor will change to an image of a hand, and then drag the screen with your mouse.

Automatic Panning

While drawing shapes or dragging during edits, it is quite common that you will need to move to
part of the image that’s not on the screen. Rather than use the scroll bars, which you can, you can also
move the mouse to the edge of the main window. When you get within a few pixels of the edge, the view
will scroll for you in the direction of the edge your mouse is over. When not dragging, the screen will not
scroll automatically.

Guide Lines

Sometimes you want a reference line that is not on the main grid. Place your mouse inside the area
of either ruler - horizontal or vertical at the top or right edge of the Main View. Then, drag, using the left
mouse button and you will then be setting an guide line. You can drag these guide lines wherever you
like, and if you drag one back to the ruler area from which it came, it will be removed from the page.

Show and Hide

| Sometimes the view of the artwork makes it hard to see what stitches you have created.
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You can quickly toggle the images on and off using the Image Toggle button on the tool pane or using the
‘b’ key.

The stitches are usually kept in view so that you can see what they are doing. However, sometimes
you want to see only the outlines, and hide the stitches. This is done with the ‘Stitch View’ toggle button
on the tool pane or with the ‘n’ key. This is helpful especially when editing.

Note: Stitches are not in view while drawing or scrolling.

Continuous View

EI The Continuous View is used to see how items will connect when embroidered in a continuous

hoop, or as a repeated pattern. It creates a set of duplicate images that let you see how your design
will connect or interact with an identical copy. The image is not an actual design - it is just an image for
reference.

Continuous View n

I Show Vertical

Offset up/dn (mm): 0 =

¥ Show Horizontal S —
Offset leftfright {mm){ <4 le

Offset O Offset -4mm

The offset setting allows you to inset a repeated element, instead of the default, 0, which aligns
the image of the copy with the outer edge of the design.

Working at a particular scale/zoom

Some digitizers advocate getting used to a particular scale or scales while you are creating a design.
This allows you to learn what a useful distance in the real world will look like on-screen. The
Embrilliance platform has a Preference that lets you calibrate the display to a Real Scale (See the program
help on User Interface for details). Once you have done that for your computer/monitor setup, it does not
need to be done again.

To get to a particular ‘zoom’ level, use the number keys. ‘1’ is a 1:1 ratio of the size of things on-
screen to the real world. 3:1 and 6:1 are popular as well. If you use the number key ‘0’ you will be zoomed
to your hoop.

Using a consistent set of scales is useful. Once you become well used to seeing design work at those
scales, you'll be able to know what the stitches will look like without having to sew them out. If you are
zoomed too far in, you will likely be creating more detail than the design will need which slows the design
creation process and can even negatively impact the sew-ability of the design.

If you are editing a design, feel free to use the zoom slider or other keys such as ‘A’ (All), ‘S’
(Selected) to work at a comfortable level. Generally speaking, unless an object outline is very large, you
should be able to see the whole object on your screen while editing. Zooming in extra close can be useful
to make the nodes line-up perfectly, but that is not necessary for a great design.

Note: If you have any objects selected, using the “s” key is a quick way to center the Main View on
them for editing.
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Using the Library

{% The Library button on the main toolbar will bring in design collections that have been
published in the platform. There are several collections included which allow you to use them in
your own work - saving you time in drawing these shapes. When bringing in a library shape, the program
uses the current page’s view center and zoom level to determine where it will come in. Once it has been
brought in, you can size and place it as needed, even edit its outline, as if you had drawn it yourself.

The Library has been extended to include hundreds of outlines that you can use with StitchArtist to
make your own designs. They are even royalty-free!

Catalog: |[Embriliance: Outines ~|  1mport catalog (,bx) select Al
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Working with Designs

Designs and objects will create themselves as you begin drawing and as a result of copy/paste
operations. But there are some options you should be aware of.

File Edit Utility | Create | View Zoom Window Help

Outline ¥

Design J .Begin Mew Design

Publish ] Set Current Design L‘}
TrueType...

Auto Entry/Exit
Auto Seq by Color

Auto Sequence

Beginning a New Design

Each design page, which is represented by a working file (.BE) is selected using the tabs at the top of
the main window. Each page can contain any number of designs. Sometimes it is useful to break up your
work into discreet areas that can be managed as a unit. Designs are the mechanism for this. For example,
suppose you make a nice rose. Now you want a bouquet. You could make the rose as a single design, and
then place it in multiple positions and sizes to complete your image.

If you have no designs on the page, one will be created for you when you either bring in artwork or
begin to draw. However if you wish to switch to a new design to begin drawing a separate piece, you use
the menu Create->Design->Begin New Design.

Setting the Current Design

If you are working back and forth between multiple designs, when you draw new objects you will
need to decide where they go. To do this you have options:

1. Select the design in the Object View, and then use the menu Create->Design->Set
Current Design.

2. Select an object in whichever design you wish to work, and begin drawing. Your new
object will appear in the sequence following the object that was selected.

Working with Images

In computer graphics there a two basic ways to create an image and those are called “bitmap” and
“vector.”

Importing Background Images

Image There are buttons to allow you to bring in artwork from files. To use an image file such as
1" a .bmp or .jpeg as a backdrop for your design, click the “Image...” button.

Once you have selected an image, the program will automatically begin a design for you (if you
haven’t already), and place that image as a new object in the design. The image is selected and can be
scaled or rotated, squished, etc. The images used for backgrounds generally are preferred to be semi-
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transparent, and that is also set for you. You can do whatever you like with the image at this point to help
you begin creating stitch objects on top of it.

Once you begin making other objects, the image itself will lock into place. This means you will not be
able to accidentally select or move it while you are creating your design. You can still edit it by selecting it
in the Object View. There, you can even unlock it. Generally, once a stitch object has been placed over an
image, you don’t want it moving around.

Note: The Image button works for pixel-based images such as photos and scans. Files created
using vectors are not pixel-based images, and do not load using this function. See the
section on Vectors for information about loading those.

Bitmap Images

Bitmaps are also known as “raster” images, which might be more technically correct though the
terms today are used interchangeably. Bitmap images are composed of different colored dots. Images
such as photographs fit into this category. Bitmap representations of art are the preferred type to create
stitches from; they come in as background images over which you will create stitch objects.

Resolution

When using a bitmap image, there is the issue of “resolution” which refers to how many dots called
“pixels” are being used. The more pixels, the better the clarity of the image and fewer pixels make for an
image that has little stair-steps in it when you zoom in. One might think that more pixels are better.
However the program has to do a lot of work while you are drawing your design and an image with a lot
of pixels makes it take that much longer to do each step while you are working. So it makes sense to use
an image that is not super-duper-hi-resolution.

When deciding what resolution you want to use, or how many pixels should be in the image, it is
worth considering how that will match up to the embroidery design itself. In an embroidery design the
most common density of a stitch is about 0.4mm or 4 stitch points. This equates to a resolution of 64 DPI
(Dots Per Inch) and that means that a typical 4” (100mm) square design would only need an image of 250
pixels on each edge. The normal smartphone will give you thousands of pixels on an edge, so any photo
today probably has more than enough resolution for what you need.

We recommend, for simplicity, that you keep your image to around 1000 pixels on either edge. You
can go for more if you're making a super large design, naturally, but otherwise this is a good number. A
lot of graphics that exist on the internet are 1024x768 or 800x600 because these are common web sizes.
And those images have plenty of resolution for you to create embroidery. If you are making a 14” design,
you might want to bump that to 1500-2000 pixels on the widest edge. But remember more is not always
better.
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Vectors (Level 2, 3)

Vector... Vector files are artwork themselves. These files are brought in as objects. The user must
realize that graphics files contain objects with outline weights (thickness) and all sorts of color
properties that are inapplicable to an embroidery design. As such, when importing vectors, the outline
and its color are all that are brought in. For some designs, this saves the user the work of having to re-
draw the image.

Vector images are outlines filled with color - think of a company logo, cartoon, comic or coloring
book.

As vector images already have outlines in them, and embroidery objects have outlines too, it might
seem reasonable that starting with a vector-based image is better for this purpose. You would have little
to draw because the art is already there for you. Simply set the stitch properties and you're done, right?
Well, you can, and we do import them for that purpose, but...

...In actuality that is rarely the case.

Vector artists can do things with their objects, such as ‘overlapping,” which makes embroidery of the
outline completely impossible. Also the shapes can be directly adjacent, which will leave gaps in
embroidery. And vector artists jump from color to color and back again very casually. You don’t want to
attempt this with embroidery. So, while the allure of using vector files is there, it actually can take more
work to make a vector-based image work for you than simply creating objects over top of a bitmap image.

Another common problem using vector based images is that of the original source. There are a lot of
clipart companies in the world, and they offer their product in a variety of file formats. When an artist
submits an image that was created as a bitmap, the company then uses a program to ‘auto-trace’ the
outlines in the image so that you, the customer, can get your ‘vector’ version of it as an EMF or WMF or Al
file, etc. Those files are almost universally the worst thing to use for the reason that they contain as many
as one hundred times the number of outline nodes as needed, and they are often ‘line’ nodes, which
means the stitches that will be generated will have to stop at each node.

Given these inherent difficulties, Level 3 has added features that let you overcome these problems.

However, for all these reasons we suggest you always use a bitmap picture - .bmp, .jpeg, etc. That is
unless you yourself are the artist or whoever is creating the vector files as the original format and have
done so with embroidery design in mind.

TrueType Fonts

y TrueType fonts exist as single-color outlines in your computer. As many logos began life as a

TrueType font, you may want to use one as the basis for your design. There are many free-to-use
fonts available on the internet, although some require payment if you use them. Check the font’s license
to be sure, especially in commercial circumstances. For this purpose, let’'s assume you have either
permission or freely licensed fonts.

When you select text in a given font, the computer provides that in outline form. Each outline is
given as an object. For example the lower-case letter ‘i’ will usually have two objects; one for the dot and
one for the stroke. You can use these outlines as stitch types anyway you want. You can make them
outline designs by applying a run, or you could use the art for satin stitches. You could even make them
huge and set them to a fill, cross stitch or applique. It’s just a piece of art as if you had drawn it yourself.
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Working without Images

You may use the drawing tools in the program to create your own art. There are enough tools there
to do it, however, graphics packages will offer more flexibility in terms of things like pen nibs and
gradient colors, but those are very different in embroidery when compared to graphics. Therefore the
drawing tools in this program are geared toward stitch generation - you are literally drawing with stitch-
generating shapes, making you a Stitch Artist.

Object Basics

As we explore the process of design creation, we need to get some terminology out of the way. If a
word stumps you while reading halfway down a page, your brain will get stuck there and not retain
anything else you've read. So let’s do some vocabulary, and at the same time, learn a few things.

Objects

Objects are the building blocks of the design. There are different types of objects, and their order or
“sequence” is the order in which the embroidery machine will sew them. Let’s look closer at what these
really are.

Object Types

Objects contain outlines, colors and stitch properties. As such we usually refer to the object by its
stitch type, for example we may say it is a “Run object” or simply a “Run.”

When you have selected an object you may want to change its stitch type. You may at any
time change any object from any stitch type to any other.

Some stitch types make use of the shape of the outline itself - for instance, the shape of a Run is
where the run will be placed - along the outline. In contrast, a Fill would place stitches to cover the inside
of the shape. When a stitch type is used that fills a shape, the outline will need to be “closed” and this
happens automatically.

Objects have one stitch type. In StitchArtist, you are able to apply any stitch type on any object. Thus
you could copy and paste an object and change its stitch type, thus having a ‘Fill’ and a ‘Satin Border’
around it. This allows you to adjust the outlines for each: In the real world of stitches on fabric, shape
adjustment of the outline will need to happen in all but the most simplistic of designs.

Image Objects

When loading artwork for use as a backdrop for stitches, you may load as many images as you want.
Each will be added to its own object. Ordinarily the first thing you would do when creating a design is to
load the artwork, position it on the design page, perhaps select a destination hoop size, and then resize
the image to that size. You can also rotate, stretch and mirror the image as needed. The image will display
with a default transparency that can be adjusted using the “Bitmap” property page for the image.

Once you begin creating stitch objects on top of that image, the image will “lock” automatically in
place. This is the same as if you lock it using the Object View toolbar buttons. A locked object means that
it cannot be selected by clicking on it in the main view, if it isn’t already selected. Any locked object can be
selected using the Object View. So it is possible to move or alter the transparency of the image even after
you have begun to add stitches, if you care to do so.
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Working with Objects

Beginning an Object

The platform is designed for the greatest flexibility in design creation. This is to suit amateurs and
experienced users alike, but that flexibility requires some minimal explanation before you set off.

Input Mode or Stitch Type first?

This is a chicken or the egg question. Any object may have its stitch type set to anything. And that
can happen during drawing, or after drawing. What this means is that you can draw an outline, and then
assign it a stitch type. Or you can click a stitch type and then click a drawing mode to begin. There is a
catch with this order of operation though - If an object is currently selected, and you click a stitch type,
that selected object now becomes the new stitch type.

Stitch Type First

To clarify, if you want to begin a new object by setting its stitch type and then setting the input mode
for drawing, make sure you don’t have anything selected first. Click on the design page background to have
no objects selected.

Input Type First

If you prefer, you can select an input type, for example Point input mode, then select the type of
object it will be, for instance a Fill. When you complete the outline, and the stitch type is set for Fill, the
program knows that you will also want to draw an inclination line to set the angle, so it will automatically
put you into that mode as soon as the outline is complete.

Some of you will prefer first to make your artwork as ‘Line’ objects with no stitches present, and
then later set the stitch types. This is perfectly acceptable. Simply begin drawing. If there is an object
selected, the new object type will switch to ‘Line’.

Repeated Object Type

Often you will create a series of objects that are all the same stitch type, for example: Run, Run, Run.
In this case, after your first object, make sure to click off it so that it is not selected. When you start
drawing the object type will be picked up from the previous object. Alternately type ‘q’ to begin drawing
an object using the input method and stitch type of the last-drawn object.

Duplicating Prior Object Types

The creation of objects is also likely to cover one or two object types, repeated, one after the other.
For example: Run, Satin, Run, Satin, etc. Or, another example: Run, Double, Run, Double.

For this circumstance, you can quickly begin creation of an object with two hotkeys: ‘q’ and ‘w’.
These let you begin creating an object using the exact method of the last object (‘q"), or the one prior to it
(‘w’). These hotkeys will not only select the object stitch type, but also the input mode as well - you can
begin drawing immediately. For more keyboard shortcut information, please see the Keyboard Shortcut
section.
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Creating Objects in the Middle of a Design

Normally when you begin to draw a new object, it will be placed at the end of the current design. If
you wish it to be created in a specific place, select the object that will sew before the object you are about
to draw, and then begin drawing your object. This is useful if you wish to go back through your design
and create connective runs between segments, or if you simply forgot a piece.

Finding Objects in the Object View

Often you will have a lot of objects, and sometimes you’ll want to find a selected object in the Object
View quickly. Select it in the Main view by clicking on it, and then use the context menu option, ‘Reveal in
Object View'. This will work only for the first selected object, if multiple objects are selected. The Object
View will scroll to position and expand the design containing the object.

Drawing

Drawing is the main bit of work used to create a design. This section will let you know about various
drawing methods.
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(Level 3 shown)

Object Outlines

Objects are usually shapes called “outlines”. The outlines are created by you, the user, drawing on
top of a piece of artwork, importing a piece of artwork called a “vector file” or with the assistance of a
Magic Wand (if you prefer not to create the shape yourself). An object’s outline may also contain one or
more “holes,” also interchangeably called “voids.”

Objects will usually contain stitching of a certain kind, for instance a satin-stitched column.

The outlines are shaped using points on the shape called “nodes.” There are different kinds of nodes,
and there are many things you can do with nodes to change the shape of the object. When you click on a
node, you are highlighting it and its appearance will change to show that highlighted state. When the
program sees that you have highlighted a node (or nodes) it will change what it does with your input
based on that fact. For example, using the ‘delete’ key on an object that has no nodes selected will delete
that object. However if you have selected nodes, then the delete key will delete those selected nodes.

Note: You do not need to switch modes to reshape an outline. You click an outline node to
highlight it. If you wish to work with the object as a whole, either ctrl-click the
highlighted node, or click off the object and then back on it. When none of an object’s
nodes are highlighted, you are able to move and re-size the object using the handles that
appear.

Introduction to Bezier

The underlying implementation of graphics in the platform uses Bezier curves, named after the man
who first made use of them to design car bodies. Why do we use them here? Because the world has
adopted these annoying-but-useful little curves; and all drawing packages, CAD packages and design
software understands them, so there are a lot of people who have been trained in their use. Are there
better solutions? Well, yes, but let’s not get into that right now, lest we upset the Math Police.
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The idea of a Bezier curve is fairly simple. You have a start point and an end point, and a curved line
that runs in between them. If you have a series of these, you can draw any kind of shape. The fun part is
that the curve between the two endpoints is controlled by two ‘Handles,” one connected to each node. In a
simplified way, the first handle (which is connected to the start point) will determine how the line will
curve as it takes off from the start. Likewise, the second handle will determine how the line comes in to
the end point.

The benefit to embroiderers using these curves is scalability; Size does not matter. So if you make a
Run stitch object using a curve, those stitches will generate nicely on that path at virtually any size, and
the sewn result will be a nice clean curve even when made large.

Handles vs. Spline

a When creating and editing outlines for shapes, you are always creating a Bezier form. For
beginners who are inexperienced with Bezier there exists an option to work without “handles,”
both when inputting a shape and when editing a shape. When the Bezier handles are hidden on an object,

you can edit the outline by moving, adding and deleting nodes. This type of outline is known as a ‘spline’.
The limitation is that you cannot change the shape of the curve between outline points. That is where the
normal Bezier handles come in. You can switch any object at any time between spline and Bezier, just be
aware that when you go to spline, your edits between nodes will be lost. Generally we always recommend
that you learn the Bezier and we have made every attempt to ease you into that.

Note: If you want to quickly reshape a Bezier curve but don’t understand the handles, we have
added a feature that lets you drag on the outline, between two nodes, and the outline will
follow your mouse, adjusting the handles automatically. This is also very handy when you
want to quickly draw with a very minimum of nodes, (very good for re-sizing later).

Outline ‘Nodes’ or ‘Knots’

‘Nodes’ and ‘Knots’ mean the same thing as used here, and that is they refer to the outline points
that are drawn and selectable.

Some things you can do with nodes on an outline:
e Select a node by clicking on it.
e Editnodes by dragging them around.

e Add nodes by double-clicking where you want one to appear, and you can double-click a
node to remove it.
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e Drag around a set of nodes, in which case you will select all the ones in your “lasso”.

e Right-click while nodes are selected and change properties and do other things with the
outline.

Lines, Curves and Cusps

When a shape is drawn, it goes from one node to another. It can either form a straight line to the
next node, or it can form a curve going ‘through’ that next node on its
way to the one that follows. The advantage of curves is that when you
scale the design up in size, the result is a nice smooth outline. If you
draw with all ‘lines’, as many have done in the past, you are severely
restricting the useful size of the outline you are creating. For this
reason, we normally draw with curves, and you can switch to a line as
Curved you enter points (for example by holding the ‘ctrl’ key) or you can do it
after the design is created.

Cusp oy

Line If you think about it, straight lines are not ‘natural’ except in
math; only people create things in the real world with perfectly

straight lines. So curves and cusps are very useful, unless of course you are making a geometric design.

Notes: ‘Curved’ and ‘Line’ node types refer to the path coming toward the node. The path leaving
the node is controlled by the following node.

A ‘Cusp’ allows two curves to go in different directions away from a common node, whereas a
‘Curved’ node creates a smooth line through the node, transitioning between the two
curves smoothly.

Here is an example of a curved node in the middle, and a hard point at the end. See how the path is a
flat line going toward the final point. The path shape is defined by the node it is going toward.

O_

A straight line does not have handles. There is no need, as there is nothing to adjust. If you want to
make it curve, change the node type.

On any path, there is a green node that indicates the start, and a red node that indicates the end of
the path. A closed shape will naturally have the end positioned over the start, so it appears red.

Smooth Curves

If there are only two nodes in a path, you have a section. The section can be a line or a curve,
depending on the later node type. If you add a third node at the end, and that one is also a curve, now you
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have a choice as to what to do with the curve as it passes through the middle node. It can be smooth-
flowing, in which case the curve looks like one continuous line. Or, it can be disjointed, making two
distinct curves, in which case it is called a ‘Cusp’.

O_

This image shows a selected curved node in the middle of a 3-node path; its handles coming in and
going out indicate the travel of the stitches. The handle coming in is in a line with the handle going out,
thus the curve is quite smooth at the node - it is almost like the node is not there, other than to direct the

path.

Remember, smooth curves are created by at least three nodes: an initial starting node, a middle
node that the curve runs through, and an ending node. You can click a long smooth curve that runs
though as many nodes in the middle as you want, but naturally there’s always a start and an end.

Cusps

The alternative to a smooth curve is to have a node that comes ‘in’ from one direction, but leaves in
another. This is a ‘cusp.’ Cusps are important, as they make the hard turns where curvy bits intersect -
such as the top of a heart or in shapes of leaves, or almost anything in nature.

A cusp allows you to have two curves come together on either side of a
point. For instance the apex in the top, center of a heart-shape is a cusp.
Traditionally digitizers would make a curve that falls just short of the cusp and

% then make a line to the cusp, and then they would begin a new curve going off to
e C the other side. This has the negative effect of that hard line being visible,
k especially when scaled. It also produces a needle penetration where it isn’t
needed. We’ll discuss more on this later.
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Minimal Nodes

Use nodes where the path switches from turning left-to-right or vice versa. And then when turning,
place a node at the ‘widest’ point in the turn if you need an additional node. This will yield the fewest
number of nodes needed to make the shape. Remember you can add nodes later, or adjust the curves, if
you need to refine the shape.

It is good to use minimal nodes to complete your shape, and then go back and edit the curves to get
the shape you want. The result will be a nicer object shape and better embroidery. It takes practice, but
you’ll find that you can quickly analyze a shape and create it in very few clicks, and then the edits
required will be much easier.
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Open and Closed Outlines

Normally in graphics a “Closed” shape or outline means that its start and its end meet up visibly. A
shape that is closed can contain stitches within, and can also have “holes.”

Closing an Outline

ﬂ When drawing a shape for embroidery, you may wish to have the end-point meet up with the
start-point without calling the shape “Closed.” For this purpose, there is a button on the tool pane
that lets you specify that a shape is closed or not. Only closed shapes can contain holes.

Opening an Outline

You can open an outline by clicking the ‘Close/Open Outline’ button up. You will not see a change in
the shape, but you can now move the head and tail nodes away from each other. The tail node will be red.

If you have a node selected when you open the outline, that node becomes the new head/tail of the
outline.

Point Input

The Point Input method is the most commonly used method, and for most people, it is the easiest.
Click the Point button in the Tool Pane and then start clicking along the line you wish to make.

M As you create your shape, you can create curved nodes with a normal left-click, line nodes are
made by holding the ‘Ctr]’ key during a left click, and cusps are made by holding the ‘Shift’ key down
during a left click.

You can use the ‘backspace’ or ‘Delete’ to remove points you have entered. You can cancel the
drawing using the ‘Esc’ or ‘Escape’ key.

When you have completed your shape, you can end it by right-clicking. If you wish to end the shape
and also close the outline at the same time, hold the ‘ctrl’ key while right clicking.

While entering points along the outline, you do not need to worry about the Bezier handles - they
are created for you using some ‘reasonable’ values. Once you have created your shape, if you want to
adjust the handles, you can. Or you can ignore them entirely if you prefer. We'll talk about that shortly, in
the ‘Editing Outlines’ section, subtitled “Working as Spline/Bezier”

Freehand Input

8 This sounds like the most fun input method, and it is, but it is far from accurate. The freehand
input lets you doodle. You hold the mouse down and drag around. Where you went gets smoothed
out and turned into a curving path. You can click for a line to a point, and then drag along some more. You
can drag and release any number of times to create lengthy and intricate paths if you wish.

This is useful in practicality only with the Run stitch type. Drawing freehand on a computer requires
practice, and the more fluid your input is, the better the result will be. Do expect to spend some time
cleaning up your handwriting!
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As with other input methods, right-click to end your input. Holding the ‘Ctrl’ key when right-clicking
will close the shape.

Arc Input

When you want to create a curve that is perfectly circular, the Arc input can help. This input uses
three points, clicked with the mouse, to create the arc. The first and second inputs should be on the arc
o v‘ that you want to create. After the second click, moving the mouse will draw a circular arc between
those first two points, running through your mouse cursor. Once you have the desired arc, click the
mouse a third time, which ends the arc input.

This program, like most drawing programs, allows Bezier forms to take up to 90 degrees per node. If
the circular arc you create goes around more than a quarter of a circle, multiple nodes will be added.

You can edit the nodes which the arc input creates as you would any other.

Shapes Input

The Shape button activates a mode that creates a shape by dragging the mouse on the design page.
The down-pointing arrow next to the image on the button makes the shape selection panel appear.

o kO oo @]

To change the shape, click on a button to select the shape that the tool will create.

Click the shape button, and then drag on the design page. The size and orientation (rotation) of the
shape is controlled by the length and direction of your drag. Let go of the mouse button and the shape
will appear on the page as a new object.
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Shapes that might be useful in rectangular proportion, such as rectangles and polygons, will follow
the drag from the top, left diagonal corner to the bottom, right corner. If you wish to make things
perfectly square, hold the Shift key down while dragging.

Some shapes have properties to adjust details of the shape, such as corner roundness, number of
corners, density of a spiral, etc.

Shapes, as objects, have these special properties for the life of the shape and can be adjusted at any
time. The shape’s outline can be edited by converting the shape to an outline. Right-click on a selected
shape and choose ‘Convert to Curve.’

Copy
Reveal in Object View
Convert To Curve
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I
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Whether it is used as a shape or converted to a curve, the object can have stitches applied.

Bezier Input (Level 2)

M The professional graphics industry has adopted this method of input and it takes getting used

to. Select the Bezier Input method using the button on the Tool Pane. To begin, click and drag. This
will create an initial Node and a Bezier handle. The next time you click and drag, you will be creating the
points needed to complete a Bezier curve section, and also begin the next one.

If you simply click, you will create a flat curve - a line.

To create a cusp, hold the ‘ctr]’ key down when you click and drag.

Right-click to end your input. Holding the ‘Ctrl’ key when right-clicking will close the shape.
Editing Outlines

We have made the editing of outlines work in two modes, Bezier and Spline. To understand spline,
imagine something flexible, but with a little bit of spring to it - in the original context a spline was a light
piece of wood that could be shaped around things. In this use, it is a line that flexes around ‘Nodes’ on the
screen (where you have clicked). The more clicks you give, the tighter the spline will have to bend in
order to conform to the shape you want.
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' Bezier

Bezier lets you adjust the curves using handles, as we have discussed. Now you get to decide how
you will perform your edits.

Working as Spline/Bezier

e The Spline/Bezier button on the Tool Pane will toggle all the selected objects to either show

their handles, or hide them. Remember, if you switch handles off, the outline will change to its
automatic shape, and you may have to add some nodes in order to recover the curves. Spline mode will
almost always require more nodes than Bezier.

If no objects are selected, this button also sets how your next objects will be treated, once drawn.
This button also acts as a program preference, so if you choose to always work with Bezier, the next time
you run the program this will determine the state in which you start.

Selecting Nodes

You can select a node by clicking on it. You can use the Ctrl key while clicking to select multiple
nodes. If a selected node is clicked with the Ctrl key it will be de-selected, as is typical with virtually all
computer systems.

You can also select nodes by dragging around them. First, select the object that you would like to
edit. Then drag around the nodes you want. When you release your mouse button, the nodes inside the
area you dragged will be selected.

You can also operate on holes, carving lines and breaklines in this manner - drag around the nodes
you wish to adjust.

Adding and Removing Nodes

Double click on the outline to insert a node. Double click on a node to remove it. If you have a node
or nodes selected, you can also use the ‘Delete’ key to remove them.

Changing Node Types

You can switch the type of any selected nodes by right-clicking, which will bring up a pop-up menu.
The node types are Curve, Line and Cusp, as we have discussed. Remember that a curve will allow
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stitches to pass through it without forcing the needle to stop at the node, but by necessity of the shape,
lines and cusps will cause the needle to land on those nodes.

Moving Nodes Near Inclinations (Level 2)

Sometimes an inclination line will be made very near a node. If that node is moved so that the
inclination line is left in empty space, the incline will be removed automatically. We suggest you adjust
your outlines first, then go back and add and adjust your inclination lines.

Reconstructing Outlines (Level 3)

Sometimes you will obtain a file that claims to be in vector form, but is actually an auto-traced
image. These are common from clip-art websites, even the big ones. This leaves a series of nodes touching
each other as they go around the outline. Use the menu ‘Create->Outline->Reconstruct Outline’ to
simplify the artwork.

Left: before. Right: After Reconstruct Outline

Spline Mode Editing

Spline mode has the ability to insert and remove nodes to adjust the shape. If the curve is too far
away from the outline you want, simply add more points on the outline where the shape you have is
‘most different’ or furthest away from the artwork.

[t is often best to begin with minimal nodes in the outline, only basically representing the shape you
are drawing. Then, go back and insert only the nodes that are needed to pull the outline into shape. Doing
it this way, you will use a minimum of nodes.

Why use a minimum of nodes? The stitches being generated have to look at all the nodes on your
shape. If you insert hard nodes or cusps, the needle will penetrate at those nodes, so you get less
desirable embroidery and an increased stitch count. Another reason to use minimal nodes is for editing
purposes. Suppose you test sew your design and realize you need move overlap for registration issues -
the fewer nodes, the easier and faster the edits can be accomplished.

Bezier Mode Editing

Editing paths with Bezier handles exposed is not hard, and is very intuitive once you get past the
first few minutes or so.

Editing is accomplished by dragging the handles, which adjusts the curve as you drag. You can also
drag the outline itself into place, which will adjust the handles for you. When dragging the outline, the
closer you are to a node, the more that node’s handle will be adjusted, rather than the one you are farther
away from. Because this can make your handles go ‘wild’ we do not let the outline drag if you grabbed it
within 5% of the ends of the outline in either direction. It is best to grab the curve somewhere in the
middle and drag it, then adjust the handles to perfect the shape.

125



The Embrilliance Platform

Note: Sometimes art will have the handles ‘hidden’ under the nodes. Drag the outline and the
handles will move, exposing them so you can drag them around as needed.

Here’s a step-by-step example of making use of minimal nodes while drawing, and good use of re-
shaping: Make a heart, starting at the bottom, using all Cusps (Shift key). You only need four points! Ctrl-
right-click to close the outline:

Next, hover your mouse over the curve in between the top left two points as shown, and drag the
curve up. You will see the shape beginning to appear. Repeat the drag for the other side. In the example
above, we’'ve made the sides smooth too. Do any editing desired for the overall image, and you have a
low-node-count shape that looks great!

There are also some tricks that we would like to share.

Trick 1: A favorite old movie of ours, Ghostbusters has the line, “Don’t cross the streams!” In the
movie, it implied that ‘Bad Things’ could happen. What we’re saying here is, “Don’t cross the handles.” It's
not that you cannot cross the handles - you can - but certain object types will not understand what it is
you've done. So we discourage it.

Trick 2: Another thing to consider is that the handles should generally be in the direction of the
travel of the path. If you have your handles pointing away from the travel of the stitches, then the stitches
may do a “Two-Step” which you might not want to happen.

Trick 3: Sometimes you will inadvertently wind up with a handle hidden under the node it is
attached to: it is a handle with no length. You can recover these by mousing-down in the middle of the
curve and dragging the outline, which reorients the handles for the curve you are dragging. Once the
handles are exposed, you can position them as needed.

Trick 4: Use nodes where the path switches from turning left-to-right or vice versa. And then when
turning, place a node at the ‘widest’ point in the turn if you need an additional node. If you have extras,
you can delete those and adjust as desired.

Working with Outlines

Holes

& Holes or ‘voids’ can be added to artwork for stitch types that use them such as Fills.

In order to be able to add a hole to a shape it must not only appear closed, but actually be
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closed. You can tell by looking at the ‘Close outline’ button on the Tool Pane when the object is selected. If
the button appears depressed, the shape is closed. If not, you can click the button to close the shape.

Not all stitch types allow holes. When it is allowed, the ‘Add Hole’ button on the Tool Pane will be
enabled. You can push this button and then begin drawing the hole. Right click to complete your drawing
as with any drawing operation. To add another one, simply click the button again. There are no limits to
the number of voided areas (holes) that can be on a shape.

The hotkey for adding a hole to the currently selected object is ‘0’.

If you have drawn several objects, or used path operations to create them and you want to combine
holes from multiple objects, select all the objects and use the menu Create->Outline ->Combine Holes.

Holes can be removed by selecting a node on the hole and using the right-click pop-up menu entry,
“Delete Hole.” To remove all holes from an object at once use the menu ‘Create->Delete Holes’.

Similarly you can separate the hole into a new object, as an outline, with the right-click pop-up
menu entry, “Separate Hole.”

If you have multiple objects with original art that has holes, but you would like to separate them out
as individual objects, use the menu Create->Outline->Separate Holes.

Connecting Open Lines

When you have two or more lines that should be connected, use the menu Create->Outline-
>Connect to make them into a single line. While you are drawing, it can happen that you end the drawing
before the outline is fully created. You can simply create the rest of the line as a separate object, then
select both and connect them.

When connecting lines, the head and tail of the first line in the sequence are preserved, and
thereafter the lines that are being connected to it will be reversed as needed to ensure the nearest
connecting point. You do not need to have your line endpoints adjacent, as a connecting line will be added
for you if needed.

Reversing Point Order

When you create a line, there is a point where you started and a point where you ended. If you wish
to reverse the direction of points on the line, use the menu Create->Outline->Reverse Points.

Generally, the outline order is not very important for the creation of stitches. You may, however
want to use this when working on connecting shapes you have made.

Break Across Points

You can select two points across a closed outline and break the outline into two using the context
menu option ‘Break across’. This is sometimes useful in logo or promotional designs, where you have
original shapes, but want to separate them and insert a word or other design element in between.
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Break at Point(s)

If you have an open shape selected, with one or more nodes in it selected, the context menu option,

‘Break at point’ will split the object into multiple objects.
/;/—\‘

Curved
ar _>
Line

Break at points

Copy

Reveal in Object View

Connect To Hole

Sometimes you’ll need to turn a shape with a hole into a continuous outline, such as to make a
satin stitch. To accomplish this, select two near points, one on the outline and one on the hole.
Then use the context item, ‘Connect to hole.” The hole is now part of the outline, as shown:

Curved

Cusp

Line

Comnect ToHole
Separate Holes

Copy

Reveal in Object View

While not directly used in defining a shape itself, there are
Entry and Exit points that accompany outlines once a stitch object
type has been assigned.

Entry and Exit

=4 8

These Entry and Exit points indicate the preferred location of
the beginning and ending of the stitching process. In the illustration, the stitching would begin at the
green handle on the left, and finish up at the red handle on the right. You can drag the handles around
anywhere on the outline. You cannot drag them to a hole, if the shape has one.

There are some object types where the stitching follows an algorithm that comes back to a single
point. Those object types are noted in their respective sections. Entry and exit points are used to limit the
number of jump stitches in a design. By having the objects end and begin at near-most points, the
transition stitch between the objects is minimized.
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The Entry point on an object is where the stitching will begin, and Exit is where the stitching will
complete. The purpose of adjusting the entry and exit is to minimize (or eliminate) traveling runs needed
to move from one object to the next. This also lowers the stitch count.

Note: Usually you will want to set the Entry and Exit points after you have sequenced your
objects.

Most stitch generation has the availability of adjustable Entry and Exit points, although some only
use the Exit such as Stippling, where stitching is continuous.

Entry and Exit adjustments are usually not noticeable in the resulting stitches except for Runs. Runs
by definition have styles such as Single, Double, Bean, etc. When you have a single run enter and exit at
the same point, you are going to have a double-run result. The exit handle forces the stitches to run to the
exit, over top of what'’s been stitched. This can be handy when creating redwork or running-stitch designs
as you may set the Exit Handle as needed, and not worry about changing the property to a double.

Manually Setting Entry and Exits

Entry and Exit on a stitch object are controlled by the green (Entry) and red (Exit) handles on the
outline of the object. Drag the handles to the point on the outline as desired. Generation of stitches is
automatic.

Automatic Entry and Exit

Use the menu Create->Auto Entry/Exit to set the Entry and Exit handles on selected objects. The
‘Automatic’ process looks for the nearest points on the objects if they don’t touch, or to a point where
they touch, if they do.

Magic Wand

(& |>Q The Magic Wand is a tool used to create outlines from bitmap images. There are two styles
- awand for filled areas, and a wand for lines. The Line Wand tool is available in Level 3.

When you turn on the Magic Wand, you can click on the backdrop image and the Wand will look at
the color where you clicked, find all pixels (dots) around it with a similar color, and then make an outline
out of all of those similarly-colored pixels. The shape that a Magic Wand creates will not be as clean as
one drawn by hand, but they are fully editable, and can be an effective way to get started on some simple
projects.

Note: When you like the wand result, right-click to end the wand to keep what you’ve made. If
you click the Wand button again, or hit the ‘Esc’ key, you cancel the operation.

Sensitivity

Because images differ in quality, when you click on the wand, the Sensitivity controls will appear. A
low number of sensitivity means the pixels it is looking for will be very similar to the one on which you
clicked. If you have an image with a mottled texture, for instance a piece of scanned fabric in the picture,
you can make the sensitivity large, for example use 150, and the outline will be expanded to include more
pixels to get a better outline.

Sensitivity: | 30 =}
Wand: J

I Look for holes
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As you adjust the sensitivity the wand will re-wand where you clicked automatically. You do not
need to click again.

Important: When you like the wand result, right-click to end the wand and keep what you’ve
made.

Repeat Creation

The wands will create as many objects or holes as you like. Once your sensitivity has been adjusted
and you have an outline you like, simply click the wand again in another area to begin making a new
object. Right-click to end object creation once all objects have been wanded.

Expand the Object View to watch the objects get created - sometimes a higher sensitivity will result
in fewer objects or outline nodes, which is desirable. Other times, higher sensitivity can add ‘noise’ in the
edge, or even fail to find a shape at all when the outline and background are similar.

Filled areas

The first wand button creates an outline around areas filled with a consistent color.
You can also use the wand during an ‘Add Hole’ operation.

Normal graphic fills, such as those from a cartoon image will not need a high sensitivity to the color
used. You can reasonably use the default number. If the image is scanned from a print, you might need to
increase the sensitivity a little. Try different levels to see what you get. Note that some large images with
a high value for sensitivity can take longer to wand.

Line Areas (Level 3)

The second Magic Wand is for line drawings and line areas in a cartoon-style image. The color you
click on has all of its pixels gathered and thinned to make a running-stitch object. The line drawing may
be very complex, and the Line Wand will create as many objects as it needs to in order to stitch around
the entire design doubly. This is useful for automatic outline or redwork designs. The Line Wand will set
all the Entry and Exits and create a double-run design ready to sew.

The objects that are created also have Styles used. You can adjust these styles, thus adjusting the
style of the result. Please refer to the Styles section for details.

Objects L~ |
B By O @ S
B Ok Properties L x|
=} 8 Design Color  Run I
1070 e "\’ LineWand g B [%:[
a2 FE
12 O run stye:  Add | Update |Renama | E’|
Current 'new object’ values
13 | Double Quickstyle: My Style
14 =" run Line Wand: Return
Line Wand: Double
15 \ Double Style: Normal
1:6m= Return
Ao / Doubl
e () Retum

To further explain; let’s examine a simple ‘T’ shape that might represent any ordinary outline
drawing. The Line Wand will find a starting point, run to the ‘T". Now it has to go both directions in order
to sew the entire shape. To do this, it will run out on one side first. Then run back. This process repeats
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for the second side. Now that this part of the path is complete, it can return to where it started. In this
way, the entire design has been stitched over twice.

If you don’t want the entire design branched in this fashion, the objects created are editable - you
can do what you like. Also, the objects have styles named for what they are doing within the path. By
changing objects labeled ‘Run’ you are changing the run out - not anything with topstitches. Change the
‘Double’ for branches that are open-ended - they run out and back. Change the ‘Return’ for topstitching as
the stitching comes back over itself.

Line-Wanding Grayscale Images

Some bitmap images will be like an old black-and-white television image, and we call those
grayscale. When you load a grayscale image, the chances are good that the image will have lines that look
nice and clean, but are really all sorts of gray variations, like a pencil drawing. Grayscale images are fine
to work over, but if you plan to use a magic wand line input you may want to save the image as a Black
and White (1-bit) image, if you have an image-editing program such as Paint.

Cut/Copy/Paste Operations

Basic cut/copy/paste operations are supported, and there are some additions you'll want to know
about especially for sequencing the design, as we’ll discuss shortly.

When you cut, you are removing items from the design page. Pasting them puts them back, and
keeps a copy in memory so you can paste multiple times, even on multiple design pages.

Pasting Designs

As we have discussed, there are Designs, and there are Objects. Designs contain objects, so when
you cut, copy or paste a design, you are doing it to an entire design including all the objects within it.
Pasting a design will place it at the end of the sequence on the design page (visually at the bottom of the
Object View list.)

Pasting Objects

Pasting objects will place them at the bottom of the last design in the sequence, unless you
immediately precede the paste with a menu->Create->Design->Set Current Design.

Paste Location

When you cut or copy something for a paste, its location on the design page is stored with it. When
you paste, either on the same page or another, that location is used for the paste - it will paste in the
same place. However, if you have a new location in view, say you are zoomed to a new area of work, and
the original location is not visible, the center of the current view is where the paste will occur. This helps
minimize the amount of moving-around of pasted items you will need to perform. Simply zoom in
comfortably to the location where you would like the items pasted, and Paste (or ‘Ctrl-v’).

Pasting in mid-sequence

You can decide where to paste objects by selecting a ‘target’ object, and then right-clicking on it in
the Main View. You will have the option to ‘Paste Under’, ‘Paste Over’ or ‘Paste Replace’.

Pasting Under will paste the cut/copied items before the first selected item in the sequence (the
pasted items will sew first). Pasting After will add them after the last selected item in the sequence.
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Paste Replace

Paste replace is a special feature. If you have a design element that's being used repeatedly, you may
have pasted it into multiple places. But what happens if you later discover that you need to edit that
element? Perhaps the stitching needed to be changed, or a connective run was missing from the original.
You can fix this by copying the revised element, then selecting an item it is to replace, and Paste Replace
will remove the item selected and replace it with the copied one. It will be centered where the original
was, and it will be in the sequence in the same place as the original item.

This is also useful for placeholders while you are creating. Suppose you know you’ll need a flower,
“Here, there and there.” You can simply insert an object to mark the locations of those, and Paste Replace
them later.

An especially useful feature to help with this is ‘Grouping.’ If the element contains multiple objects,
group them using the Edit menu or ‘Ctrl-G’. When pasting the first time, paste the grouped objects. Later,
when you perform a ‘Paste Replace’, you will first select the destination group by clicking on it in the
Main View and perform the ‘Paste Replace.’ This selects the entire group and will remove that entire
group when you Paste Replace.

Grouping Objects

Objects can be grouped so that when you select one in the Main View, all will be selected together
for operations such as Move, Rotate, Mirror, Cut/Copy/Paste, etc.

Use the Edit menu->Group or ‘Ctrl-g’ for this.

Note: When items are grouped, they are still individually selectable in the Object View, and can
be edited singly if selected.

If you have a design selected when grouping is performed, the design is part of the group. This
means sequencing and copy/paste operations will be done at the design level. If you want all the objects
from a design, but not the design itself, make sure to check the Object View to see that the design is not
selected.

The Edit menu->Ungroup (Ctrl-u) can be used to ungroup objects.

You can group selections that contain sub-groups. Ungrouping will not ungroup the sub-groups -
those will have to be ungrouped with a separate ungroup command.

Sequencing

The sewing order of the design is very important. You don’t want your design to sew randomly all
over the fabric. It will leave jumps, or have increased trims, or worse, increased color changes, and if you
sell designs, your customers won't be happy.

There are ‘best practices’ for sequencing on different embroidered goods, most notably hats. If
you're creating a design for a hat, you’ll want to attempt to sew from the center outward. This helps keep
the fabric in place and flat in the hat frame.

For regular designs, it can often be useful to have stitching work the edges of the design first, in
effect anchoring the stabilizer, then work from the center out.

Think about how you would like the design to sew. You've probably watched hundreds of designs
stitching out, and you can use that experience to help you decide what to sew in what order. Things that
connect are pretty easy to figure out - you want them to sew without jump stitches, usually. If you are
new to embroidery, we recommend you spend some time embroidering so you can get used to the
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stitching process. If you can look at a complete design, figure out what object types were used to make it,
and predict which objects will sew in what order, then you are ready to take on sequencing.

Work on the sequence on a per color basis. There is always a trim when the machine goes to the
next color, so imagine your machine working one color at a time. And yes, there are times when it is
necessary and even a good idea to revisit a color - you don’t have to put all your colored objects together.
Layering and Shading are good reasons to separate a color into sections with different colors in between.

Once you have a sequence in your mind, you'll need to adjust the objects to match. And for that,
you’ll need to know how to change the sequence your design.

The Object View

The Object View shows you the sequence of your objects in the design. You may have a lot of objects
for a complex design, and that’s normal. If the design can be broken down into separate designs
themselves it may be helpful. For instance if you have a picture of a flower and a butterfly, you might
make them separate designs on the page, and create them separately.

When you right-click on an object in the Object View, you get a pop-up menu that lets you move
designs in the sequence. This is often handy for simple or small moves.

You can also select objects in the Object view and drag them to new positions in the sequence. The
items being moved will go into position immediately after the item you release the drag upon.

Remember that designs operate at the root level of the Object View. If you move a design into the
middle of another design, you will get three designs - the first, up to the point where you pasted, the one
you pasted, and then finally the rest of whatever the first design contained.

If you have a Design selected, and not just objects, the Design itself will move. If you wish to move
objects only, make sure you do not have the Design selected.

You can drag all the items out of a design, leaving an empty design. If this happens, you can select
the design in the Object View and delete it using the Delete key or the Edit menu ‘Delete’.

When items are locked or hidden, they are always still selectable in the Object View, so be aware of
inadvertently selecting locked objects.

Cut/Paste Sequencing

A simple and effective method of sequencing is Cut and Paste. You can Cut any selected objects and
Paste them at the end of the sequence, or before or after any other object.

The normal Paste (Ctrl-v key) will paste the objects at the end of the design.

Using this method, you could drag or click-select objects, cut, paste, and move on. You are
sequencing the design by the order of your cut/paste operation.

Sequencing by Color

Sometimes you have made a design, perhaps with a lot of copy/paste operations, and you wind up
with objects of different colors out of sequence. You may want to sequence them by color before
adjusting the sequence further. To accomplish this quickly, select the objects and use the menu Create-
>Auto Seq. by Color.
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Automatic Sequencing

A fast way to get objects sequenced (although not a perfect method) is to automatically sequence
them. This requires that you first decide on what you want to sew first, and what you want to sew last in
a set of objects. Manually sequence those two objects so they are the first and last in that whole set of
objects. This gives the program something to use as a starting point.

Next, select the set of objects, including the first and last. Use the menu Create->Auto Sequence. To
select the set, you could drag around them in the Main view, or Ctrl-click them in the Main view, or click
the first one in the Object Tree, and shift-click on the last one in the Object view. See the Object view
section of the program help for more ways to select.

The program attempts to minimize the travel among objects so that connective runs or jumps are
shorter or eliminated. This form of sequencing is not as good as what your brain can do, with a little
thought, but it is a reasonable approximation, and sometimes a helpful starting point for your manual
sequencing process.

Click Sequencing (Level 2, 3)

Similar to the Cut/Paste sequencing method, you have the option to perform the same thing with
single clicks. The Sequence Mode button on the Tool Pane begins this mode. Click on an object. That
object and anything grouped with it will be moved to the tail of the design. Click on the next object and
the same thing will happen. Thus if you click on all the objects, starting with the one you want to sew first,
and ending with the one you want to sew last, you will have sequenced the entire design.

To exit the mode, click the button again or use the ‘Escape’ key.

You do not need to sequence the entire design - you can sequence the parts you want. Then if
needed, select what you have sequenced, cut the objects, select a target object and perform a ‘Paste
Before’ or ‘Paste After.

Sequence by Assigning Stitches

If you have imported artwork as a vector file, that artwork is flagged by the program as ‘newly
imported art’. With this art, the program assumes the sequence is not designed to sew.

As you assign stitches to objects, the program will begin sequencing the objects to the end of the
design. The purpose of this is to allow you to perform both jobs simultaneously; assigning stitches and
creating the sequence that the objects will be sewn.

If you do not want this to happen on the imported file’s objects, simply select it in its entirety and
click ‘Line’. This has the effect of clearing the ‘newly imported’ state.
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Ties and Transits

Ties are stitches that form knots in the embroidery both allowing for trims and to pull up the bobbin
thread when stitching has just begun. We refer to these as entry ties and exit ties, but some may call
describe it as “tying in” and “tying out.”

In each object property page you are given the opportunity to explicitly set ties. Click the button
with the bow tie icon on it.

S =]

Tie

[ Tie at entry
[ Tie at exit

The ties are automatic and basically look in the direction of stitching to find an innocuous angle,
then stroke a few stitches forward and back - enough to bind the stitch and bring up the bobbin thread.
For most items, even if a tie-in misses a stitch in the case of a stubborn bobbin thread, the underlay will
have enough stitches to spare.

You can of course add a few manual stitches, if you choose, with a separate object, but generally the
automatic ones work.

Transits are what happen when the embroidery moves from place to place - often between objects.
Rather than adding transit properties to each object, the overall design page has transits set in the
Program Preferences on the Files tab. When performing commercial embroidery, small movements
between objects can have a tightly nested run, which buries the stitches, and no trims are desired
because they slow down the process. For home and hobby embroiderers the tie/trim/tie approach seems
to be universally approved. To accommodate these differing viewpoints, the preferences “Run when
jumps are small” and “Ensure ties surrounding jumps” allow for automatic negotiation of the transits.

“Run when jumps are small” allows for two nested 1.5mm stitches - or a total 4.5 mm between
objects before the transit will allow a single whole stitch.

When the stitch exceeds this value, and “Ensure ties surrounding jumps” is set, ties are ensured in
both directions, and a trim command is sent out. Some machines have lower limits to the length of a
movement before they will trim, often 5mm, but in case the user wants to hand-trim the design, the ties
are there to prevent the embroidery from unraveling.

A difference in style: Most hobby embroiderers will trim everywhere they can. However,
commercial embroiderers wouldn’t nest the runs if the result was something they got
complaints about - they don’t. Only an embroiderer with an eye for it would notice a few
nested stitches, usually between lettering. So you might just want to save yourself some
effort, and turn the transit options on.

Default Style

Styles allow for repeated use of properties on a given type of object. There is a QuickStyle button on
the top, right of each object property page. When an object has been assigned a style, that style will be
highlighted in the style list, shown on the Style properties for the object. If an object was given a style, but
then modified from that style, its style name will have an asterisk (*) following the style name.
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When you begin creating objects having just run the program, the default styles are being used,
called “Normal.” These have been tested to be reasonable for all-around conditions, but naturally
properties exist for a myriad of reasons.

If you click on the ‘Normal’ style it will reset the object(s) to that style. Keep in mind that all
properties will be reset.

Line Objects

Aline is simply a shape. It has no stitches applied to it. When you bring in vector files, or
TrueType they are lines. As artwork without stitches, they have no properties other than color.

Manual Objects

m Manual stitches are straight lines, with the needle dropping at every node. Manual objects are

typically used in the creation of Motifs, but occasionally you may need a manual stitch for a tie or
something really small, where runs will not calculate well - for example when adding a single stitch to
cross a satin column when creating a Celtic knot as previously described.

To protect the user from resizing the design and obtaining a very large stitch, manual stitches have a
property that limits the maximum length of an individual stitch.

Properties a B

Color  Manual ]

Length limit {mm): | 10

Run Objects

. Run stitches are the heart of any design. You could, with patience, create virtually any design
with run stitches. There are a lot of variations to them as well.
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A basic single run is how your stitches travel from one point to another. The run has a length for
each step. With curves, however, the stitch length may shorten when needed to go around a tight turn.
This is described as “chord gapping” in math parlance. It creates a run that is more faithful to the shape.

When runs encounter curved nodes on the path they are following, they do not need to cause a
needle penetration, but with cusps and straight lines, they do, otherwise the stitches would not match the
outline. So if you see a needle penetration that makes the stitches look uneven in length in your run, go
back and check for an inadvertent line or cusp point.

A double run is one that makes its path like a single run, but then reverses its steps to return to the
starting point. For this reason, when you switch a single run to a double, the Exit point will be reset to
match the starting point for you automatically.

A Bean stitch is like a traditional sewing machine’s triple-stitch. The needle makes two steps
forward, and one back. This provides a heavier stitch that stands out better against a pile fabric. The bean
stitch also has an option to repeat the stitch (in place) up to 9 times, which can make a heavy hand-sewn
look. If you use this option, we recommend a longer stitch length so that the fabric/stabilizer can support
the tension created by that many stitches.

The chain stitch is homage to heirloom hand sewing and forms a pretty effect that looks nice when
combined with traditional design, especially floral.

Like the chain stitch, the Back stitch and Stem stitch are also traditional heirloom stitches. As you
select these stitches, you will see properties appear for them.

The Sashiko stitch attempts to emulate the Japanese hand sewing look. The word Sashiko translates
to “Little Stabs” and describes the short interval between stitches. To accomplish the look, this run
creates a small step forward, followed by a multiple-pass stitch that is a little bit thicker. At arm’s length,
the effect is rewarding. Used in the traditional colors of white thread on indigo fabric, the stitches
resemble grains of rice laid end-to-end.
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Motif Run Objects

Motif runs use patterns of stitching along a path, much like the decorative stitches of a sewing
machine.

Properties 18
Color Mot ]

SIS Bl Y Py A o
Motif: Add [ Remaove EJE I
Heicht: [00 | wigth: [0.0 |
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Add as many motifs as you like.

When you initially set an object to a Motif run, it will only have normal run stitches in it. You will
need to add a motif to the run. Click the ‘Add’ button and the Motif Selection window appears.

Once you have selected a motif, for the run, the run will re-generate with the motif. The motif will
also appear in the list box in the bottom of the property page. You can add as many motifs as you like, and
they will be added to the sequence in the order that you add them. Each motif has its own properties that
you can adjust. Select the motif in the list to adjust its properties. You can remove a selected motif with
the ‘Remove’ button, next to ‘Add’.

The height, width and rotation of the motif are set as their name implies. The mirror buttons will flip
the motif in the sequence. You might want to have two copies of a motif ‘facing each other’. This can be
done by adding the motif twice to the list, and then flipping one.

The Pé:::me; ot l ‘Gap’ of the motif indicates that some amount of space should
precede the motif, after the previous one.
§ ikl iiﬂ| E | The Motif Scaling button allows you to incrementally adjust
the size of each motif in the run. This makes for a decorative effect. If
you Scale: lm & increase the size, start with the motifs all at a regular or small
size in the Height and Width fields. Then you can add a few percent of

size for each pattern that is displayed. If you want to create your run with motifs decreasing in size, start
with the motifs’ height and width as large as you will want, and decrease will make each successive
pattern smaller. This may take some trial and error to get the result, but the effort is worth it, especially if
you want to run ‘center-out’ and have motif run scaling in both directions.

Satin Border Objects

The satin border is one of the most versatile and easy-to-use stitch types. The shape is a simply

line, with no need to worry about inclinations. The border follows the outline and has a width, much
like a sewing machine. As a satin stitch, however, there are numerous properties available for the satin
border.
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At the top of the property page there are separate buttons to show the top stitching, underlay and
applique properties. The top stitching is composed of the width and density of the stitch, along with any
variation in the stitch width which gives a simple way for a satin border to approximate a column, but
without inclinations.

The Style of the border topstitch will have a smooth satin or pattern, a split satin, which divides
itself into columns, or a feathered-edge stitch.

You can also adjust the line and nib style for open path outlines. The line style varies the width over
the length of the outline in a manner according to the image displayed in the list box.

The nib is the shape of the endpoint. You can use the normal squared-off satin end, or add a curved
or tapered tip to either end for a more finished look without the use of a column.

The border can have applique steps added to it, very much like the normal Applique object type, the
difference being that when using the satin border type you have much more control of the topstitch itself.

Please see the Satin Column section for information about the patterns and underlay.

Tip: When using a wide border, use a split (value of 2) with no reverse pattern to help prevent
the stitches from looping, while still maintaining the look of a satin.
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Satin Column Objects

= Satin columns are versatile objects, and this property page allows you to use the column in a
few styles. “Normal” satin stitches are what you almost always think of with satins; they go left-to-
right and back again, making a smooth, narrow, continuous stitch. But you also have the option for
Contour and Fringe stitching styles available.

Density

Satin columns are one of the most-used stitches, and they have a lot of properties available. The
most important of which is the density. Remember that density is measured in stitch points, which are
tenths of a millimeter. The bigger the distance, the lower the density. Normal density for satin columns is
4 points to 5 points unless a fine thread and tightly woven fabric are used. Often, the 5 point density is
preferred as it will not push the fabric around as much, and still provides nice coverage.

Pattern

When choosing the patterned topstitch, a normal smooth satin is the default, however you can
adjust the patter to appear like a fill pattern that curves with the stitching. Each pattern can have its stitch
properties adjusted. Stitch Length in the pattern relates to the size of the pattern that is made. If you
make your pattern too wide, it will not be visible unless the satin itself is very wide. Here you can see how
a satin pattern will turn with the stitching:

The Edge Pad is a means of protecting the edges of the stitches from have excessive needle
penetrations that can pull on the fabric and pucker.

When patterning, the needle penetrations can lie next to one another causing the fabric to lash or
even cut. If this is a danger for the fabric being embroidered, set the “Reverse” to “None” which means the
pattern will only occur on every other stroke of the satin. The pattern effect will be lighter, but the
embroidery will be better and the fabric will not have as many cuts.

The pattern of the satin also has compensation and gradient properties. Please refer to the Fill
Pattern section of Fill Objects for images and further description.

Feathering

Feathering the edges of satin columns is a good way to simulate animal fur. Overlap multiple layers
to make a more realistic appearance. In this example, three satin rings were set with feathered edges. The
rings sewed outer-to-inner, and overlap slightly.
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Split

A split stitch in the column simply means that the needle will land in rows, lengthwise along the
column. You can set the number of split columns, the minimal stitch value (to avoid fabric cuts) and you
can avoid the reverse stitch pattern, which helps preserve the look of the satin column. Here is a column
splitinto three:

Underlay

Satin stitches are good at covering the fabric, but they have challenges, especially along the
edge, where tightly placed dense stitches can penetrate the same hole in the fabric or even cut the
fabric. You may have sewn, for example a knit shirt, and had the edges of satin stitches create holes in the
fabric. For this reason a parallel or zigzag underlay is often used. It provides coverage while pulling the
fabric at slightly different angles and that can allow the top stitching to have reduced density.

Satin also has the issue of tension. Short stitches in the same direction, laid next to each other, builds
up stress in the fabric, gathering it in toward the middle of the satin stitch. This can cause registration
issues with subsequent stitching. This can be managed by binding the stabilizer to the middle of the satin
with a center run, or a pair of edge runs that travel just inside the shape. The edge runs also have the
added benefit of lifting the edges of the satin up, out of the pile of the fabric. For these reasons it is not
uncommon to use a medium density satin with a lot of underlay.

Properties a5
Color Satin I

~|=

~Underlay

[¥ Edge Run Length: [25Mm = |

[¥" Parallel Inset: spt e |
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[ Freestanding

Foam End 1: | None vl End 2: | None vl

In the underlay properties, the “Edge Run” will create runs on either side of the satin, just inset by
an amount controlled by the Inset field on the property page. The inset for the edge run is usually is set to
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fall just inside the stitching — perhaps a half-needle with or slightly more, which allows some relief
around tight corners. The stitch length of the edge run is also adjustable; use smaller stitches for tight,
narrow columns and longer ones if you want to reduce the stitch count, or are worried about cutting the
fabric. The default is usually sufficient though.

The density of the parallel and zigzag underlay is adjustable for increased coverage. Sometimes it is
better to have a higher density underlay (0.8 - 1.2mm) and a lower density top stitch (0.8mm) so that the
coverage is solid, but the pull on the fabric is reduced, which helps with registration issues (eliminating
gaps between stitched areas).

Freestanding Underlay (Level 2)

The ‘Freestanding’ underlay creates a mesh under the satin, similar to the freestanding background
object type. This is useful when making Richelieu bars or satin shapes that will be stitched on wash-away
stabilizer. When using the ‘Freestanding’ option, you do not need the other options, so you can leave
them off. The Length, Inset and Density properties do not apply to the ‘Freestanding’ option.

Foam (3D) Underlay (Level 2)

The ‘End 1’ and ‘End 2’ underlay properties control automatic caps and joins for 3D foam
embroidery. End 1 is defined on the outline as the location of the closing point (red node). Note: Because
the density required to cut foam cleanly is so high, avoid turning tightly, as those stitches can bunch up.

Automatic underlay shown, left-to-right: cap, join, a letter.

Foam (3D) column style(Level 2)

The ‘Foam’ style automatically sets the underlay, including end caps on both ends, sets
compensation and increases the density so that the 3D foam can be cut out by the needle.

Contour (Level 2)

Checking the ‘Contour’ button on a Satin Column will arrange the stitches to run opposite to the
inclinations, rather than parallel to them. The density is maintained throughout the column, even if the
column widens and narrows, as the program will automatically adjust the number of rows as the width
changes. Contour 2 will provide more of a fill’ effect as areas widen and narrow, whereas Contour will
have varied density across the shape as it widens.
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Fringe (Level 2)

The Fringe stitch is a unique stitch that allows you to create what some call “3D Embroidery” by
cutting the bobbin threads under the satin, which frees up one side of the stitching to come up and away
from the fabric.

This Fringe stitch lays a run down along the edge of the satin first, and then places the satin over top
with extra needle penetrations causing the satin to anchor itself to the run. It finishes off with a top stitch
run to anchor it all together. This method allows you to have fringe effects in embroidery without the
need to anchor the stitching down with a fill, as has always been the case.

Note: When setting fringe options, realize that left and right are subjective, and if you edit the
outline or inclinations after making this setting, those could actually switch.
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Satin Column Input (Level 2)

Now that we have covered outline basics, it’s time to discuss Satin Columns. Satin Columns have
stitches that go across the shape from left to right forming a smooth, possibly curving, filled area. Satin
columns are also referred to as “Turning angle fills” sometimes. Satins are generally the second most
important stitch type you will use, after Runs.

Because we tend to think of satins as going ‘left-to-right’ or ‘side-to-side’ there are special input
methods for them accommodate this.

Satin columns are special because in addition to the shape itself, you'll need to add incline lines to
get the column of stitches to curve nicely. The incline lines are the direction the stitches will lay on the
fabric.

Incline Lines

Before we can discuss the input methods of satin columns, we need to go over incline
lines. -+

When you have a shape drawn that will be a Satin Column, you will need one or more incline lines,
also called, “Inclinations.” When you first draw the shape, the program attempts to provide a satin stitch
automatically, based on the shape. If this is acceptable, you can skip adding your own.

The incline lines input can be started using the ‘i’ key or the Inclines button on the Tool Pane. To add
an incline line, simply begin on one side of the shape by clicking down, and then drag the mouse across
the shape to the other side. When you release the mouse button you will have added an inclination line to
the shape. You can repeat this drag operation to make as many incline lines as the shape requires. When
you are finished, simply right click to exit the mode.

How many incline lines do you need? That is a great question, and like a haircut the answer lies in
the form of a question, “How does it look?” Simple lines of satin stitching might only need one or two
inclines. But if you curve around, you'll need one whenever you make a quarter-circle, or whenever you
want to switch from turning left-to-right or vice-versa.

Generally, start with a pair of inclines at the ends, and at least one in the middle. As you add inclines,
you will see the stitches change. You can stop anytime you are happy.

If you make a mistake, you can exit the Inclines mode, and then simply drag the endpoints of your
inclines around. You can also drag one of the points to the opposite side to remove the incline. You can
also go back and add, remove or move the inclination lines at any time, which is handy if you decide you
need to edit the shape later.

When a shape turns, one side will be longer than the other. This means that one side will have its
stitches closer together than the other. Another way to say this is that the density (stitches per inch)
inside the turn is higher. When the satin stitch is created, it is given a specific density to maintain - and
that is on the outside of the turn, not the inside. The program will do things on your behalf, such as short-
stitching, to minimize the impact of the increased density on the inside of turns. But you can also help by
looking at what is going on, and making changes to the inclinations so that the density increase is
minimized.

Tip: When turning around a tight corner, you might want to begin ‘leaning’ into the turn, which
helps the stitches go around with less bunching:
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Perhaps a rudimentary smile? And what are the ‘ends’? If we asked a thousand people, they’d all tell
you the same thing. The ends are the flat sections, right? Therefore the natural idea is to have inclinations
that parallel those lines.

In fact, this is how inclines work, with respect to the shape. Once the last incline is ‘seen’ the
program keeps the angle the same, regardless of the shape:
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Sometimes you will see stitches ‘diving’ into corners. This is because the shape, past the incline,
looks pointed. In this image, the incline on the left is parallel to the points ending the shape, but the
incline on the right is not:
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The program will look for two corners, and find them if they make a line that is reasonably parallel with
the ending incline. If they’re not found, then the stitches just keep going at their current angle, whatever
that may be.

NOTE: You can adjust incline points by dragging them. If you hold the shift key down while dragging an
incline endpoint, the other side of the incline line will move with it.
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Sides A/B Method

ﬂ This method of input uses the knowledge that the satin stitch will have two ‘sides’, and you
draw each one separately. This method of input is easier for some types of art where it may be
that you want to add the incline lines after the outline has been drawn. To use this mode, first, select the
‘AB’ input method from the Tool Pane. Then select an input method that you will use. Generally the Point
or Freehand inputs are chosen.

The first side, usually thought of as the ‘left’, is now drawn. Once you get to the end of it, right-click
the mouse. Instead of closing the shape, this now starts you drawing the other side. You can draw from
the second side’s ‘end’ toward the ‘start’, or go back and make the side going ‘forward’, similar to the way
you made the first side. The program will figure out which way you are drawing it.

Once you have drawn each side, right click again. The shape itself will now close and you will be put
into the input mode to add Incline lines. Drag the desired incline lines across the shape, and right-click to
finally generate the object.

To sum up:
1. Draw side ‘A’. Right-click.
2. Draw side ‘B’. Right-click.
3. Add incline lines. Right-click.
This method of input is useful where the Left/Right method cannot make the shape:

X

e
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Sides Left/Right Method

This method of creating satin columns creates the shape and the incline lines at the same
time. Selecting this mode also forces you into the Point mode for entry, because the only way to
create alternating points on the sides of the satin is by clicking.

What you’ll do is create the outline by clicking a point on the ‘left’ side of the satin column, then a
point on the ‘right’ side. You keep going, left, right, left, right until you have completed the shape. It will

look like you have drawn a ladder.

As you make each pair of left and right points, you are not only defining the shape of the column, but
also adding incline lines across each pair of points at the same time.

As with Point Input mode, you can create curves by left-clicking, lines by ctrl-left-clicking and cusps
by shift-left-clicking.

When your shape is complete, right-click to end the input and generate the object. The shape can
now be edited if necessary. Note the inclines here can be manipulated as if you drew them individually.

There is no difference in this style of input from any other, other than how it is drawn. One benefit though
is that the inclines at the ends will line up to make a straight edge that goes all the way across the shape.

When entering a curve, as you click along try to imagine the curve as going around a center - as you
click, each pair of points should point toward that center.

\Q\\‘i\l‘“l :

148



Product: StitchArtist™

Satin Column Cornering (Level 2)

Creating corners with satin columns is a bit of an art. When creating lettering for example, the
cornering methods you use will radically affect how the viewer of the stitched item perceives your
embroidery.

Turning tightly

The simplest form of cornering is to simply turn, with inclinations going
around the turn. When making a hard corner, this results in stitches pivoting
around the inside corner of the turn. If you're going to turn this way, try beginning
to ‘lean’ the stitches into the turn, and when coming out of the corner, give them
some chance to ‘lean back up.’

Surprisingly, most of the time, professionals prefer to simply turn corners
instead of using more complex corner styles, which we’ll describe next.

Capping

Letters often look better with a set of satin columns, rather than turning around hard angles. One
method commonly used is with three satin columns: and entry, and end ‘cap’, and the exit stroke. A
typical example is this letter ‘A’:

You'll see that the cap angle is as ‘flat’ as it can be so that the stitching is smooth. For registration
purposes, you may want to overlap the cap on top of the entry column. And the exiting column usually is
best to be snug against the cap. In the illustration on the left, notice the slight overlap of the left column
and the cap - barely a stitch is typical.

Overlapping

A hard corner may not be appropriate for a cap. And it may be so tight that
cannot turn reasonably. In this case, break the column into two and overlap the
corner. Don’t worry about the stitches overlapping each other, as satin stitches
sew quite well even when overlapped. If the density is not too tight for the
thread and fabric, you can even get a blended look.

it
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Mitering

Mitering is a form of overlapping where the exiting column starts at a ‘point’ and widens out as it
leaves the corner. This makes the stitching resemble a picture frame:

Mitered corners work well for corner angles at 90 degrees, like a picture frame. Hard turns cause
longer miters, which have too many small stitches, and shallow turns do not need mitering.

Satin Column Joining (Level 2)

You will probably be creating lettering at some point, which constantly joins satin columns. But
many other design types require this as well.

Right Angles

When columns meet up at nearly right angles, there can be a gap that forms as the fabric is being
‘parted’ in two opposing directions. Sometimes you can overcome this by stretching the later object so
that it comes slightly over the earlier object. When doing this, you only need a few stitch points of
overlap. As the stitch forms on top of the earlier column, the stitch will ride down and seat quite well,
filling the gap.

Sometimes you have meeting columns that have low enough density that there will be something of
the fabric visible. If you need to completely cover the fabric, insert a set of stitches as a separate object as
a form of underlay. Usually you will do this with the same angle as the early column will stitch. This acts
to bind the fabric down and provide the color needed when the columns intersect.

Joining at acute angles

As in the case of a letter ‘k’, sometimes satins will come together at acute angles. You might have the
impulse to attempt to turn the joining column. Sometimes this will work, but there is another way: Simply
keep the angle constant, and overlap the joint. The ideal situation is where you have the acute angle
column being sewn before the straight one. This allows for easy (and greater depth) or overlap.

Where the part that is coming in at a steep angle will be sewn later, the joint is more difficult, but
works the same. You simply have to be careful about your shape. Sometimes this is the case where
turning the angle near the end can be helpful for a smooth joint.
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As with right angles, the use of an underlay object can provide better coverage, and make the joint
easier to accomplish.

Use Entry and Exits

When creating a shape like a simple letter “T’ you can do it with two objects. Assume the vertical
stroke comes first for this example. Let the Exit point of the stroke occur naturally - at the top, on one
side or the other. Then, make the horizontal top column. Set the Entry point of the top column to match
the Exit point of the upward stroke. This allows for continuous sewing. You still may want an underlay
object, in addition to the underlay provided by the objects themselves, but the simplicity of the
connection is nice to understand. Also, if the design permits it, ending the pattern in the inside of such a
corner as where these two strokes meet allows for tie-off stitches to be nested nicely, and in fact they also
double as color fill in the intersection. A lot of ‘old school’ embroidery fonts were digitized this way.

Getting Across (Celtic Knots)

Sometimes you have to cross over an earlier stroke. This is a common problem when digitizing a
Celtic knot, which has art that goes over-and-under repeatedly. One trick that is used is to have the Exit
point of one stroke align with the Entry point of the column that is going to pick up on the other side.
This means an exposed connective stitch will go across the ‘Over’ column, but its angle will be similar to
the angle of the satin stitches that it is going across, thus it blends in. As long as the stitch will be short,
usually under 3mm, you can avoid adding an object for it. Otherwise, simply add a Manual stitch object
with two points, and make sure you go the right direction across.

Single connecting stitch, parallel to
the vertical column

Satin Column Tapering (Level 2)

Satin stitching is hard on fabric; it pulls the fabric, it pushes the fabric, the needle comes down so
close as to cut it sometimes. Narrow satin stitches are the worst, as the fabric is pulled tightly under the
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tension of the thread, and the needle comes down in a very dense pattern. Depending on the fabric you
are embroidering, a narrow column of stitches (perhaps as wide as 1mm) can be too much stress for the
fabric and can cause puckering or gathering. A more generous 1.5mm of travel is preferred. This mean
that any ‘points’ in your shape will want to be clipped a bit so that the stitch has a bit of travel. If you are
wondering what 1mm looks like, it is slightly wider than the needle you are embroidering with. If you
think about it, a needle width isn’t a lot, but giving the extra length of stitch can do quite a bit for the sew-
ability of your design.

Sometimes your column will narrow down toward a point, and there is some relief that can be given
here with inclinations. If you angle the stitching slightly as it comes into the point, the stitches stay a bit
longer, while the column continues to narrow. This effect is known as chiseling, and it is effective.

1/2 mm Thickness

K

ol

T

1 mm Stitch

Also, narrow satin columns will appear to be of a higher density when sewn, so you may want to
open up the density a bit.

Note: The program will automatically loosen the density as the shape narrows.

Also be aware that narrow satins will not register as well as wider ones against other stitching.
When creating a satin border, try widening the stitch a bit and overlapping the adjacent stitches. This will
help prevent gaps without requiring additional stabilizer.
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Fill Objects

A Fill is a repeated run stitch back-and-forth in rows, used to cover a large area. There is a lot
of terminology associated with fills, such as “complex” (it can have holes), “Tatami” or “Ceeded”
(The runs are offset so the rows don’t line up), “Edge Travel” (the stitches run along the edge instead of
under the rows), etc.

Density

The main issue is density, or the distance between rows, and here is where you get to make a
decision. When a fill executes, it puts a lot of stitches into the fabric. Those stitches displace the fabric
somewhat, just like when you get into a bathtub, the water has got to go somewhere - stitches in fabric
are the same. So the more stitches you put into the fabric, the ‘bigger’ the fabric has to become to handle
it.

Remember that density is measured in stitch points, which are tenths of a millimeter. The bigger the
distance, the lower the density.

In the past, the typical production method was to use a cut-away stabilizer that can hold together
with a lot of stitching in it, which relieved the fabric considerably. Then, the designer could use densities
of 4 points or even tighter, thus creating “full coverage.” Full coverage means the fabric does not show
through. It sounds good and if you're being paid by the stitch, it is great. But what if you want the fabric
relaxed, not stiff as a board? And full coverage isn’t as important as wearability and softness? Then plan
on releasing some of the density. Go for 5 point density or even lower.

There are other options too. Using two fills, in different directions, but each with only half the
density, you can create a far more stable fill with less displacement. And the coverage works out quite
nicely.

If your fill sews out like a soup bowl, indented and firm, you needed less density and more
stabilization.

Travel

When a fill executes, it does so in sections. This is driven by the shape of the object, and where the
Exit point is located. When the fill has to travel between those sections, it can either run under the rows
of stitches that haven’t been filled yet, or it can run along the outside edge of the shape.

If the fill is a normal density, even, one of the lighter ones previously discussed, the traveling runs
probably will not be visible and certainly not noticeable, so the most efficient thing to do is let the fill
travel normally.

There are uses for fills that have much wider spacing between rows; trapunto effects for example. In
a fill that has low density - where the stitches are really far apart -- you may want the traveling stitches to
go along the outside of the shape, rather than under the rows where they would interfere with the
desired visual effect. This is accomplished by checking the ‘“Travel edge” box.

Inclination

A fill has a single angle at which it runs. You can add an inclination using the Incline button on the
Tool Pane.
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Fill Pattern

When choosing the patterned topstitch, a normal fill (tatami) is the default, however you can adjust
the pattern to have needle lands that form texture. Each pattern can have its stitch properties adjusted.
Stitch Length in the pattern relates to the size of the pattern that is made. If you make your pattern too
wide, it will not be visible unless the shape itself is wide enough. To make a fill appear smoother you can
also add randomness to the needle lands for a Tatami fill.

]

Tatami Fill with reverse pattern

Tatami Fill Tatami Fill with randomization
set to 'None'

Fill pattern set to Waves 2

Note: There is also an option of using fill pattern “None” which will emulate a satin. This is for
very small areas, where the stitches will not be excessively long, or for fills that are only
going to be carved.

Edge Pad

The Edge Pad is a means of protecting the edges of the stitches from have excessive needle
penetrations that can pull on the fabric and pucker.
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Edge Pad set to .4mm
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Edge Pad set to 0
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When patterning, the needle penetrations can lie next to one another causing the fabric to lash or
even cut. If this is a danger for the fabric being embroidered, set the “Reverse” to “None” which means the
pattern will only occur on every other stroke of the satin. The pattern effect will be lighter, but the
embroidery will be better and the fabric will not have as many cuts.

Compensation
P ‘NW ngl Compensation helps create embroidery that matches the image,
understanding that the process of sewing the design will create distortion as it is
Min: I opt  c| happening. With compensation, the endpoints of the lines in a fill are stretched
Bt IW =] out slightly past the edge of the shape. This helps with registration issues

Ma: I 3 pt il
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because as the lines are sewn, the fabric is pulled in slightly (shortened), so the longer lines will reach the
spot intended to be covered.

You can use a minimum value, usually 0 - 3 points, depending on what the fill is lined up against. If
your fill has a wide difference in the width of the runs, in other words some narrow parts and some fatter
parts, you may want to use a percent for the compensation. We suggest keeping it a small value, 2-3%. It
will be kept in check by the Max value though, even if you use a high percentage.

While the compensation numbers sound like something you should use, they’re really there more
for the professional who uses them all the time. Most of the time, simply adjusting the shape to overlap
anything that neighbors it will do a fine job of handling registration issues.

Curving Fills (Level 2)

Fills can have curved rows of stitching, not only straight ones. Switching to a curved fill is done with
the “Curved” checkbox. When you select the fill to be curved, a curved line, similar to a break line, will be
created for you automatically, and it will be angled as your inclination was previously.

You adjust the curve as you would with any line. You can add points and remove them. The curve is
fully adjustable, but realize there are some rules you should follow.

1. The endpoints of the curve should go past the edges of the shape.
2. The curve needs to be simple - making a loop may be fun, but it won’t be nice to sew.

3. Hard turns will give you areas of low density on the angle, and high density as they
straighten out, so use things like that with low density as second fill, for texture and
dimension.

Here are some examples of curving fills in action. The stitches and the outline are shown side-by-
side for each. Notice the curve on the right has an additional node added to produce an ‘S’ curve:

When you click off the curved fill, the line will be replaced with an inclination.
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Gradient (Level 2)

The density of the fill can be adjusted so that each line of stitching moves farther apart from the
previous line, which makes for a varying density, called a “Gradient.” Gradients are an effect, and not used
to provide coverage as a regular fill might. When making a gradient, you have two densities; the starting
density, which is the one set for the fill, and the final density, which is the one set in the Gradient
property. The gradient can have different styles selected using the list box. Note that a standard fill has a

gradient set to “None.”
X = — -
Increasing -
IIncreasing j None g
Diensity: I 2.0 mm il Decreasing

Qpen Center
Open Ends

Feathering (Level 2)

Feathering is the extending and shortening of the edges of the fill in a random manner. This is used
in fills that are adding texture to a design, and generally would be used over some other design objects
for coverage.

X [ Htt=

Left: [ 25% b Ext: [ 20%
Rjght:lﬁil Ext: I 0% il

You can adjust independently the left and right inside feathering and outside feathering values. By
feathering the edges, you can create simple fur effects.

When setting feather options, realize that left and right are subjective, and if you edit the outline
after making this setting, those could actually switch.
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Freestanding (Lace) Objects
The freestanding background has been used to simulate lace for many years. It consists

of @ diagonal runs of stitching that stitch over themselves in order to lock in the stitches. Using
only wash-away stabilizer as a base, the freestanding background can remain as-is, with no fabric, or as a
support layer for satin and fill stitches. Often, a shape made with the freestanding background, and some

clever inclinations on top-stitch satin columns, can be made to stand all by itself as lace.

In the example below, the heart came in from the library and was set to freestanding fill. The
‘Diamond’ checkbox was set and the color changed to create the middle heart. The outline was added by
copy and paste of the shape, Inflate to reduce its size so the stitches would sit on the background, and the

stitch type was set to Satin Border, with all underlay turned on.
Another alternative to the ‘Double’ pass is a single. This creates nice parallel rows of stitching which
work for quilting effects, such as sewing rows in a grid on linings, or as background quilting in an In-The-

Hoop project, etc.
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Motif Fill Objects

e Motif fills are similar to regular fills. You control the density and gradient. Motif fills can
be == curved as with regular fills. In motif fills, the traveling stitches always run along the edge so
as not to interfere with the motifs. The motifs are added in the same manner as motif runs.

The density adjustment in motif fills adjusts spacing between each line in the fill. A zero value here
will cause each row to just touch the previous row.
Please see the Motif Run section for details on the use of motif controls.
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Applique Objects

Applique Objects have “Position”, “Material” and top stitching steps. The use of the
j steps is optional, including the top stitch. Here is a general way that applique is typically
machine embroidered:

The “Position” step places a run down on the fabric, and then stops the machine. This is used to
provide you with a placement line for your applique. You can use a Pre-Cut applique, perhaps cut with a
machine, or by hand using a template. Or you can simply lay down a piece of fabric big enough to cover
the placement stitch. A tip to placing your applique is to use some adhesive, spray-on, ireon-on or
otherwise, to hold the applique fabric in place when the machine is restarted.

The “Material” step will sew another set of running stitches to anchor the applique fabric in place.
This step may be omitted if the applique is Pre-Cut, as the topstitching will anchor the fabric down.

The topstitch finishes the edge of the applique, and you can choose from Blanket Stitch, E-Stitch or
Satin Border.

Note: You can also use the Satin Border object type to make appliques, and it provides additional
properties.

The applique properties add applique steps and visualization to the object. You can select adding a
“Position Stitch” which will be a single run that sews out to indicate to the user where the applique will
be laid. Then an optional “Material” run can be done to anchor the applique in position.

Properties L x|

Blanket-Stitch

Color  Applique |
E-Stitch
Satin Border ELE]

Border: [satin -
Topstitch:
Density (pt): 5 ﬂ
Stitch Width (mm): |3 ﬂ

[~ FabricPrevien [ Preut

¥ Position  Inset(mm): | O ﬂ
[~ Material  Inset (mm): |0 _ﬂ

Color style: [user Defined  v]

Preview Fabric Color

Blanket and E-Stitch have stitch length and width that can be set in the properties. The Satin and
Zigzag stitches use density and width. The applique can have a fabric preview that lets the user visualize
the final applique with colors similar to those that will actually be used. The color used for the preview is
set by the color of the Position step.

The Pre-Cut checkbox indicates that you will have the applique already cut, and this causes the
object size to be locked, preventing you from inadvertently mismatching the design and the fabric. Pre-
Cut appliques could also come from dies, where the exact size of the applique is known in advance.

Scanning in a precut shape

If you scan in a precut shape to create an applique, such as from a die-cut fabric, place the fabric on a
background grid with known measurements - for instance 10mm or %2”. Using those measurements, you
can scale the image to match the grid in the program, so that the size will be exact. Sometimes, a scan may
have a vertical or horizontal difference in scale (it can stretch the image) but the grid you scan in will
show you that, if you use the measuring tool on the main toolbar.
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Applique insets are used to offset the stitching from the applique material itself. If the material or
top stitch was identical in size to the applique (if it is pre-cut especially) then the applique might not be
well sewn down and could lift away from the finished product.

Color Style

The Color style allows users to adjust how they work with color during appliqué steps. There are
three styles: Keep Color, PES Card (Traditional) and User Defined.

Use Keep Color to conserve thread changes by combining like colored Top Stitch and next position
placement stitches. This will allow the machine to stitch the finishing stitch of the piece and the
placement stitch of the next piece (if the same color) without having to start the machine again.

For traditional stops after each section, you may select the PES Card option from the Color type list.
This selection may be necessary depending on your machine, particularly if you use PE-Design / Palette
or similar to write a PES card for your machine.

The User Defined lets you use any color you want.

More on Applique

In the Color Properties you can click on a color to change it, and this displays the Thread window,
which also has an “Applique” tab. Using that tab, you can save a cutting file for virtually any cutter.

StitchArtist also enables you to mix an image into your applique, making mixed-media applique a
unique option for your projects.

Please refer to the Applique section in the Embrilliance Platform.

Stippling Objects

s Stippling is a wandering path that is formed automatically based on an outline and any
number of holes. The path is a continuous curve that wanders around seemingly aimlessly
yet it meets itself at the finish. Because the result is a closed shape, the Exit point is ignored, but the Entry
point is honored. The Stippling object can have a single inclination line added to it which will set the
rotation of the pattern (So that it comes off horizontal) so that different blocks will have even greater
differences in pattern.

There are four patterns that you can choose from with stippling: Drunkard, which wobbles a bit and
is slightly inconsistent with the distance between jigsaws, Curvy, which has a ‘cleaner’ and more
consistent spacing, Leafy, which tapers some of the pattern to give a floral effect, and finally, Geometric,
for a cleaner look perhaps for modern quilting.

With all of the patterns you can adjust the spacing of the run to vary from a tight stipple to a loose
meander. You can also set the stitch length.

If you want to edit the path or change the stitching in more ways, the stipple can be converted to a
run, which will keep the generated path, and let you apply stitch effects such as motif. Simply click the
Run stitch type button in the Tool Pane while the stipple object is selected.

Cross Stitch Objects

Cross Stitch objects create patterns of crosses in filled objects and on outlines to resemble
handwork.
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Properties B |
Color  Cross stitch }

ELIS

Crosssize: | 10spi & v 5P
Count: [Single -

The cross size is available in metric and Stitches per Inch (SPI). Stitches per inch settings are not
exactly duplicable in normal metric stitch points - and the result is obvious if stitched on Aida cloth
which is woven at densities of SPI. Therefore you have your choice of how the cross size works.

When creating a cross, each leg of the cross is stitched twice. Sometimes you will want more thread,
for example when using large crosses, and you can adjust the count setting accordingly. Realize that
increasing the pass count will have a dramatic effect on the stitch count.

The cross stitches for all cross stitch objects are made on a default grid of ‘cells’. This allows the
stitching of adjacent object shapes to line up. We think of each of these cells as either ‘off, meaning no
cross, or ‘on’ meaning a cross will be stitched.

When creating outlines with closed shapes, only the cells that have their center within the shape will
be set to cross. If you make a shape that appears to ‘miss’ a cell, and you want to make it appear, it is
normal to adjust the outline shape accordingly. When adjusting the shape to turn on (or off) a cell, we
suggest adding one or more line nodes to the outline (ctrl key while clicking in point mode.) We also
suggest using the Spline mode for point entry because it can make it easier to insert points to grab
specific cells.

When creating crosses with an open object, whichever cells are intersected by the line are turned
into crosses.

If you move an object, the crosses will move with it. Once moved, you may want to re-generate the
object (touch a property or outline node) so that the correct crosses, exactly on the grid, will be
generated.
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Contour Echo Objects (Level 2)

Contour Echo is a stitch type for quilting, trapunto or decorative effects. It provides
different ways to echo around outlines and holes. When echoing, you can set the distance for
the echo in mm and also see it in stitches per inch. There can be a gradient to the echo, and using the
stitch properties button at the top of the Echo properties page you can set the stitch style to several of the
Run stitch types.

You can choose from three styles:
1. Echo Outline Inward, which creates an interesting echo inside the shape.

2. Echo Interior Clipped requires any number of holes and will echo those out toward the
outline. The shape of the outline is used to clip or cut the echoes.

3. Echo outline outward is a simple echo of the outline itself. You can echo as many steps
as you choose.

The Contour Echo can be converted to a series of Run objects for further editing as desired by
clicking the Run stitch type button in the Tool Pane.

Program Motif Objects (Level 2 & 3)

j Program Motifs are items that the software knows how to digitize, and unlike a regular
motif, it will do so differently depending on the size of the design. Program motifs include
French knots, candlewicks and eyelets (Level 3).

Properties L x |
Color ~ Prog. Motif 1

Type: |French Knot VI
Beg. Size: 1 20 _EJJ

End. Size: 1 20 _5.:'..1
Gap {mm): 1 2.5 ‘_i'_]

™ Single eyelet size
controlled by a
2-point line

Type: ]French Knot Vi
Candlewick
Beg. [French Knot k
Evelet Single
End. [Evelet Run

Program Motifs digitize themselves
to the sizes you enter, and can scale
as they run.

Program motifs follow the same drawing methods as a run, but given their size, making hard points
obvious is difficult. They can run along outlines of shapes, or be used singly with short line segments. Due
to their nature, they tie themselves in and out, so you could trim between if desired.

The Single eyelet size is controlled by making a two-point line. The starting point will be the center
of the eyelet, and the second point will be the outer radius of the eyelet.

The only real consideration when using these stitch types is that knots are dimensional and have
been programmed to emulate their hand-stitch counterpart, therefore they tend to produce a lot of
stitches.

Converting Stitch Types

Converting objects to different stitch types is as easy as selecting the object and clicking on the
desired stitch type. All properties are lost when converting types; it’s like starting with new artwork.
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Specialized Conversions

There are two conversions that are different than normal conversions, and those are Stipple and
Echo. Converting Echo or Stipple to anything other than a run operates normally; the outline and any
holes are preserved.

Stipple to Run

When using stipple objects, there are times you wish to adjust the generated pattern, or apply
motifs to the run. When you convert a stipple object directly to a run, the result is a run that has the path
of the stipple, not the outline that was used to create it. That result can be turned into a line, motif or
anything else.

Echo to Run (Level 2)

When converting Echo to run, the result will be one or more objects that are the echoes. You can
then apply any stitch type to those objects for your desired effect.
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Drawing Lettering Templates

As discussed in the Lettering section, you can design templates for lettering to use in name drops,
word walls, subway art, etc. Templates are interactions between two different elements: A lettering
design, and a template object. To accommodate multiple template designs on a page, the template and
lettering items are named using a numbering system that will match them together.

(=1 Design
11 namedrop 1

2ABC Letters -c 1

Namedrop

The simplest of the template forms is a namedrop. It is a simple 2-point line, running left to right,
that controls where lettering will be placed.

Your Name Here

Namedrop lines should only have two endpoints, but they may create a curve.

BRlDGE LETTERS

Envelope

Envelopes can yield effects from simple placement to re-shaping of the lettering.
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Envelope creation requires some specific knowledge. Envelopes are closed shapes and have definite
sides. A simple template form can be described by a rectangle drawn clockwise, beginning at the top left
corner. That top left part is important as it marks the beginning of the envelope top.

First Top

Point

¥

Last B Bottom .
Point End —

The template needs to understand a ‘bottom’ and a ‘top’. Thus it will have two sides, which are made
up of normal straight-line nodes. To draw an envelope, start at the top left point, which becomes the start
of the ‘top’ of the envelope. Draw across the top and end the top line with a node that’s either a straight
line point or a cusp point.

Next the right side is drawn by adding a line point below the last top point. This marks the rightmost
end of the bottom of the envelope. Continue working on the bottom of the envelope working left toward
the left side. When you reach the left side, close the shape, which will form that left side.

The top and bottom do not have to line up vertically. This is used to stretch or shear (slant or

italicize) the lettering.

Top and Bottom do not
have to line up.
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Baseline

Baselines provide a means for lettering to follow on a path, whether open line or closed shape.

wis 15 @ bag eline

Baselines can be virtually any shape you make.

SIS is als,,

Yo @=EP Se=svliby

? baselin®

You can achieve any letter placement with a baseline. Even ‘wavy’ vertical text can be
accomplished using a vertical line and rotating the letters using the center rotation handle.
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Hoops

StitchArtist allows the display of all hoops in the platform, including multi-position hoops. The
multi-position hoops are not there to automatically split. Their inclusion is for the purpose of creating

designs specifically for those hoops. As you are in control of all stitch objects, you decide what parts of
your design will go in each hoop section.

We suggest creating a separate design for each hoop section. If the hoop you are using is not a
physical multi-position hoop, you will need to add alignment lines that exist on each design so that the
position of the designs can be lined up by the embroiderer when sewing.

As each design will center when it is saved, we suggest using a basting box for each hoop position.
The box should be centered in the hoop section, and should completely contain your design section.

Once you have each design created, copy them to a separate design page and save them individually.
As this is an advanced topic, you may want to look online for specific instruction.
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Keyboard Shortcuts

There are a number of keyboard shortcuts, sometimes called “hotkeys” in this program. Some you
may never use, and some you won’t want to live without. If you're just getting started, please don’t think
you need to memorize them all. As you become more productive with the program, have a look now and
again to see what might be useful to you. Production design creators who use the program all day every
day will no doubt use them all.

‘q"” Begin drawing using the same input method and stitch type as the last object.
‘w’ Begin drawing using the same input method and stitch type as the object prior to the last.

()

X

Begin drawing using the same input method as the last object, using whatever stitch type is

currently set.

IXP
« )

C

Begin drawing, using the same input method as the last object, using the ‘Line’ stitch type.
Begin drawing a satin column using the last input method, L/R or A/B.
Add a hole to the currently selected object.

Add inclination lines to the currently selected object.

Toggle the view of the background images one and off.

Toggle the view of the stitches on and off.

Toggle the view of the Background Grid on and off.

Toggle the view of the hoop on and off.

Toggle stitch point highlights on and off.

Zoom and pan to all objects on the page.

Zoom and pan to the selected objects on the page.

Zoom to the hoop.

‘9’ Set the zoom to a multiple of real scale.

‘Ctrl-g’ Group the selected objects/designs

‘Ctrl-u’ Un-group the selected items.

‘Ctrl-x’ Cut to clipboard

‘Ctrl-c’ Copy to clipboard

‘Ctrl-v’ Paste from clipboard

‘d’ Switch between Create and Select modes

‘G’ (shift G) Generate

‘t’ Toggle realistic 3D on/off

‘i’ Toggle display of jump stitches on/off

'Arrows’ Nudge 1mm. Add ‘Ctr]’ for 0.1mm Nudge.

Alt (hard node drawing): Constrain new point to 15 degree angles.
Alt (drag point or incline): Constrain to horizontal or vertical when close.
Shift while dragging incline moves the incline.
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StitchArtist™ Level 3

Delayed Generation

When you tell an object that it is to be a certain stitch type, the stitches will automatically generate.
Also when you adjust or edit the object, the stitches will generate for you. But what if you want to do a
complex series of edits on the object? It might be desirable to turn the automatic generation off for a
while. You can do this with the ‘Delayed Generation’ button. As long as the button is pressed, and you are
in ‘Create’ mode, your stitches will not generate.

Generate Now

When you want to generate stitches on an object or set of selected objects, click the
- | ‘Generate now’ button. If nothing is selected, the program will look for any objects needing to
be generated and will generate them accordingly. This button is useful when Delayed
Generation is turned on - you control what gets generated and when.

Default Drawing of Line/Curve

.{“- The usual mode of drawing with points is to draw with curved points and use the Ctrl key
E | to draw a line. This may be undesirable for some art. You can use this button to switch the way
that operates - pressing it will cause drawing to default to a line, and the Ctrl key will cause points to be a
curve. Note that using the Shift key to make a line constrained to 15 degree angles will work either way -
you can constrain the line angle as long as you are not making a curve.

Auto-scroll Toggle

1 When drawing, the edges of the main view have an area that act as an auto-scroll area - if
ﬁ% you move your mouse in that area while drawing your page will scroll automatically which
gives you more room to continue drawing. Sometimes this is undesirable, and the action can be
toggled on and off using this button. Note you can also use the arrow keys while drawing to scroll 1cm
per key click. And holding the spacebar will let you pan the screen by dragging it with the mouse.
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Carving lines

Areas filled with stitches such as Satin Columns and Fills can be given additional texture using
Carving Lines. Carving lines are additional shapes that can be added to objects in a very similar

+
,'-@j manner to adding holes. Use the ‘Add Carving Line’ button on the Tool Pane to begin a carving
line, and select the input method (usually Point Input) to begin drawing. Draw a path over the

object.
The carving line generates needle penetrations where the normally-generated stitches intersect the

carving line.

The only real caveat to carving lines is that in high-density areas, your fabric may lash up as the
needle is penetrating closely together. For this and other reasons, some designers create two areas of fill,
overlaid on one another, each at half density. This adds texture, can reduce fabric pull, and carved lines

will add minimal impact.
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Using Styles

Styles allow for repeated use of properties on a given type of object. There is a style button on the
top, right of each object property page. When an object has been assigned a style, that style will be
highlighted in the style list, shown on the Style properties for the object. If an object was assigned a
QuickStyle, but has been modified, it will be given an asterisk at the end of the style name.

Properties L % |
Color  Fun l
HE
Style:
Add |Llpdate Rename | Set @‘

QuickStyle: My Style
Mone

The Current Style

Once you change the property of an object you just made, the program takes the properties of that
object and uses them for the next object you make of the same type. This is the “Current Style.” For
example, if you create a run and set it to a Bean stitch, the next run you create will start out as a Bean
also. Although it may not be a named style, the current properties are important, as they are used when
creating an object.

Updating the ‘Current’ Style

The ‘Set’ button will use all of the properties as shown to set the ‘Current’ style for new object
creation; when you create a new object of that same type (run, column, etc.) it will be created with the
same settings as the first object now selected.

Alternately, if you have an object whose style is “None” and you click ‘Update’ it will likewise set the
‘Current’ digitizer settings to match that object.

Normal Style

When you begin creating objects having just run the program, the default styles are being used,
called “Normal.” These have been tested to be reasonable for all-around conditions, but naturally
properties exist for a myriad of reasons.

No Style

To remove the QuickStyle from an object, click “None.” This will have no effect on the properties of
the object; it just removes the style setting.

QuickStyles

When you have an object that has its properties set a certain way, you can save those properties as a
QuickStyle. Using QuickStyles allows you to remember a set of property settings that sewed perfectly for
a project, or simply to match prior objects you've created.

Adding a QuickStyle
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When you create a style based on a selected object, you can name it. This is called a QuickStyle, and
the style itself resides with the design page being used, and on your computer for future use. To do this,
click the ‘Add’ button.

If you load a document with a style that is not on your system, it will be referred to as a “Page Style”.
If you would like to add this style to your collection for use later, you can click the ‘Add’ button.

Renaming a QuickStyle

If you wish, you can rename the style with the ‘Rename’ button. Any object that uses this style will
show the new name in use when the style page is shown.

Updating a QuickStyle

When you have modified a QuickStyle-stylized object, and you want to update the QuickStyle to
match the current object properties, use the ‘Update’ button. This means that other objects with the same
style set will not match. Since the main reason for styles is to have all the objects working the same, there
is an option presented to update all the other objects that use the same QuickStyle to have their
properties match the current one.

Remove style “

Updating: "CuickStyle: My Style™

This will update the style based on the first currently selected object.

Would you like all objects using this style to have their properties updated to
match?,

Yes Mo Cancel

Removing a QuickStyle

Using the ‘Remove’ button, with the trash can icon on it, you will remove the QuickStyle from the
page, and from your system. Realize in doing so that other objects on the page, or indeed other files you
have created, may have used that QuickStyle.

As QuickStyles are stored with the page as well, the style will become a “Page Style” for other
documents when you load them, if they had that QuickStyle applied.

When you remove a QuickStyle, it erases it completely without affecting the properties themselves.
Objects that have had their QuickStyle removed will not lose their property settings, but will naturally
have a style setting of “None.”

Stylesheets

Stylesheets are design collections that have objects that have properties set to perform digitizing a
certain way.

For example, suppose you want to collect a set of object types that you use to create freestanding
lace. You can make a design with those objects in it. Their shape does not matter, but their properties are
what are important. The objects will have the properties needed to make your lace. You can then use that
Stylesheet at any time to set all the object properties on the sheet.
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Stylesheets allow you to add styles to your Styles lists quickly and easily. They can also be exported
in a .BX installer for use on multiple computers, or even shared with others.

Stylesheets can be loaded into the ‘current’ digitizer settings, usually at the onset of creating a new
design, but not always - they can be set as the current properties at any time.

Creating a Stylesheet

Start with a new design page. Now begin by digitizing one object, and set the properties of that
object to your style. You can use a QuickStyle that you have on hand already to set the properties. You can
add as many objects to the design as you like. Once you have the design how you want it, use the menu
‘Create->Publish->Stylesheet’:

“StyleName: | My Style Pubish:  ForMylUse |

Save As (b |

Cancel | CK I

You now have two options for Publishing: Publishing to your collection of Stylesheets, or publishing
as a .BX installer. The .BX option will also publish to your stylesheet list, but it additionally saves a .BX file
to a location of your choosing.

Here is an example:

Objects i x |
52 gd
IE"] I‘_M}, 51:_'{|E

-|-| ......... — Ctemn

In this screenshot, you can see we have two Run objects, labeled ‘Stem’ and ‘Bean’. We also have a
Fill object, labeled, ‘Light fill'.

IMPORTANT: SAVE YOUR WORKING (.BE) FILE SO YOU CAN ADJUST THIS STYLESHEET AT A LATER DATE
IF YOU NEED TO.

When we publish this Stylesheet, we have these available as QuickStyles:
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Properties |
Color  Run |Design|

Properties kSl |
Color Fil |

HE EpSq 2l [eea|E
Style:
@ | A_ddl Update | Rename | El @I

Mormal: Mormal

Style:
Add | Update

Rename Set

Mormal: Normal

My Style: Stem My Style: Light Fill
My Style: Bean Maone

QuickStyle: My Style

Mone

Notice there are now two entries on the Run (left) and one on the Fill (right).
Setting a Style as Current

The menu ‘Create->Styles..." calls up the Stylesheet manager:

Select a stylesheet for new objects:

. INnrmaI

Highlight styles to make them available:

Sashiko

This window is divided into two sections. On the top is a list of the Stylesheets available to be used
to set the ‘current’ properties. The lower list allows you to highlight any and all Stylesheets you want to
have available for use while creating a design.

Thus you are not limited to a single Stylesheet, nor are you restricted to using it only at the start of a
design page. You can set the properties to a style at any time by selecting it in the drop list. And you can
highlight as many stylesheets to be available as you like.

You will notice there are some Stylesheets that exist for you; Normal (which is the default
properties for the program) and ‘Line Wand’ which is handy to use when generating objects with the
‘Magic Wand Lines’ tool. You'll notice that in the image above, there are two Stylesheets selected, “Line
Wand’ and ‘My Style’, so here is what we see in the Run properties:
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Properties R x|
Color  Run l

Add ‘ pdate ‘Rename set i ‘

My Style: Stem

My Style: Bean
QuickStyle: My Style
Line Wand: Run
Line Wand: Return
Line Wand: Double
Mone

Notice that there are ‘My Style’ and ‘Line Wand’ available. Also, we had chosen ‘Normal’ as the
Stylesheet to use as a current property set, so the Normal is there as well.

Note that QuickStyles are always available to you; they are not a particular Stylesheet, but rather a
simple set of properties for one object type.

Removing a Stylesheet

When you select a Stylesheet that you have created, the trashcan button next to the drop list will be
active, allowing you to remove that Stylesheet from your system completely. (Remember, we told you to
save the .BE file in case you want it later!)
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Path Operations
Path operations are advanced graphical tools that help you quickly get a result shape based on

currently selected ones.
Using Breaklines

E Sometimes you would like to be able to take a pair of scissors to a shape - make a wavy or

straight cut across it. You can do this with Breaklines. Using the ‘Break line’ button, having already
% selected a closed-outline Line object, you enter the Break Mode. Next, select an input mode to draw
your line across the shape, and right-click to end drawing. You can edit the line before it is used. Once you
have the line as you would like, use the “Cut the object” button to make the cut. You will now have

multiple objects.

Start with a circle and draw a Breakline.
Objects

'~—+ -(—‘..(F-‘-

L X |

Cut the object with the Breakline. You can see it is now two objects.
A Fill stitch has been added and colors chosen.

Cut
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E Cut is a path operation that lets you remove a part of a shape, in the form of another shape.
Think in terms of a cookie cutter. There is a base shape (earliest in the sequence), your dough in this

example, and a cookie cutter on top. Position the cutter as you like, select the two shapes, and click the

Cut button. The base object will now have its shape adjusted to have the area under the cutter removed.

Objects (1R x | | ]
B Dy (O @& S | [
o g% (& — —

Here we use a couple shapes from the Library; the Pumpkin and a Flower. Note the Pumpkin is the
first object, which is the one that gets operated on. Select both items and click the Cut button which gives
the appearance of a ‘bite’ being taken out of the pumpkin. Do we have rabbits in the garden?

AND

This is a more advanced operation where two or more shapes overlap one another, and you
E want a new shape based on the area where the shapes overlap. The “AND” is where this shape ‘and’
that shape both exist. It is used more for visual effects - breaking a set of multiple overlapping shapes
into even more parts. The results of the AND operation are added after the last object used in the
operation.

Objects LR x| —
e R S Ey, O3 10 O i) N
1 : &Y p® (G

First, we merged three copies of a circle, then used the AND button.

The result is shown as a red fill on the right.
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Union

J When you have two or more shapes that overlap, and you want to make a shape that

represents the entire outline of all the shapes, you use the Union button. This could be effective for
adding a border around a design. The new Union shape is added to the design after the last of the shapes
involved in the operation.

Objects b B x |
e e e, ot o e |
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Two circles have been merged together on the left. Then the Union button has been used to create
the third object, a ‘Union’. The image on the right shows the union object having been inflated so that it
surrounds the original two circles.

Flatten

When importing vector art from outside sources, it will be unlikely that the shapes are truly ready
i] for use in embroidery. Often times in the creation of vector art it is expedient for the artist to layer
one shape on top of another. In graphic arts, only the final visible items will have any impact on the
result, so any shape or any part of a a shape may be hidden without consequence. In embroidery, those
shapes, as they exist, will be used. This means there will be a tremendous amount of overlap. The Flatten
command clips the shapes against each other so that only one top layer remains. Remember that
registration issues will occur when you sew these objects, so you will likely need to do some editing.

On the left is a graphic created and saved as an SVG. The middle is the import of the SVG - notice the
artist used three circles to create the design, which seems reasonable enough. If we make them all fills
(and set colors, if needed) as we have on the right, it looks okay...

& —’K* e

...But there is a problem. The design on the left is shown with 3D off so you can easily see the
overlapping stitches. Once we use Flatten, as in the design on the right, we are closer to having something
that will sew without damaging our needle or machine.
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Inflating / Deflating shapes

H| Sometimes you need a shape to increase or decrease in size, but be exactly the same distance

around all the lines of the original. This means the new shape will have to change. A classic example
of this is echo quilting, where, as the lines of stitching echo out, the curves become less tight, and fewer
details are visible.

Clicking the Inflate button on the Tool Pane displays the Inflate dialog, which allows you to inflate
selected objects and their holes as needed.

When inflating or deflating, the object selected will change. Thus, if you wish to have the original
shape retained on the page (for some other part of the design) you should copy and paste it before
inflating. See the next section, ‘Automatic Outlining’ for an example use of inflation.

Automatic Outlining

Automatic outlining will create a shape that surrounds any stitches on the design page. This is
useful when creating stitches that will add to an existing embroidery design that has been merged
onto the page.

Automatic outlining can also be used to create an object hole. The purpose for this is for quilting
designs. You can merge a design or create an interior design with objects, then make a new outline in
some larger shape, for instance a quilt block, or your hoop. By adding a hole to that shape, in the form of
the current stitches on the page, you can create a stipple, or an echo perhaps, that will surround those
stitches and fill the block.

The automatic outlining can be combined with Inflation to allow room around the stitches, for
quilting or other purposes. For example, there is a feature elsewhere in the platform that automatically
creates knockdown stitches for sewing on terry by first creating an automatic outline, then inflating it
slightly, and adding a light fill.

Here’s a quick illustration in use, starting with a basic monogram:

Now we will automatically outline it and set those new objects to a backstitch, made green.

Let’s try a few more steps for fun:
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Copy the outlines that were created by the Automatic Outline tool:
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Use the Inflate button E.I to create echoed outlines of the letters. Note the ‘Remove holes’
option is turned on. We are using a 5mm inflation.
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Add a Union. Next, delete the individual ‘Line’ objects, as we won't need them anymore.
Select the Union and use the menu ‘Create->outline->delete holes.’

............ 1 m Letters
E| ........ 2L Design

2‘] ......... ﬁ Bun
22 ......... @ Bun

Now add a run to the Union, change style, color, etc.
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Publishing

When you want to create your own art and use them within other designs, as motifs or embossing
patterns, you can ‘Publish’ them in several ways, including the creation of a .BX install-file which lets you
share your work with others.

Creating Motifs

Motifs are used in Motif Runs and Motif Fills. The motif itself is a design, and can contain any
number of Manual, Run and Satin objects, although usually a motif is a singular Manual stitch object.
Naturally, a motif cannot contain another motif.

Motifs run left-to-right, by convention in the system. They do get reversed when needed during a fill,
but we start with a normal orientation. A motif’s first point and its last point should line up - or rather,
they will when used so you might want to consider that as you draw one.

Motifs use the vertical position of the initial and final points as a baseline, like a letter would. The
baseline is how much above and below the line the motif will sit.

Manual points are mostly used in motifs, especially since Runs will calculate, and the points where a
needle will land are unpredictable when the user is in control of the size. This is doubly true when going
around tight curves, where small changes in size will very much affect the position of the stitches.

You can use satins to make a motif, and the satin will generate for the size used in the Motif run or
Motif fill. It is generally not needed to use any underlay in the satin, although you can.

Normal motifs are fairly small, typically 2-4mm, so as to be used in a Motif Fill with a reasonable
number visible, but they can be large, if warranted. You may want to make a motif that represents a
particular client logo, and embed that in the background of a fill in a larger design.

When storing motifs, you will be saving them on your system for use in the future, but when they
are used within an object, they are also stored in that object. This means that if you edit the motif, the
object won’t be updated - you’ll need to remove that motif from the object that’s using it, and re-add the
new version.

Let’s create a motif by drawing a shape and setting its type to Manual. Note the first and last points
are on the baseline.

Now we can publish it (along with any other designs on the page). Click ‘For My Use’:
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This page has been published for you to use.
Don't forget to also save your working file!

Now, let’s start a new Motif object. Click Add on the Motif property and select the motif:

Category: IR ~

4 o

esign

The motif, along with the result:

Creating Emboss Patterns

Embossing patterns can be either open or closed shapes, but they will be used differently depending
which they are. Open shapes are used as repeating carving lines in a normal fill.

Closed shapes will have the fill stitches that lie internal to the shape removed, unless that makes for
an extra-long stitch. The effect of closed shapes in a fill is that of satin areas within the fill, and those
provide dramatic relief from the fill stitching; almost a trapunto effect.

In order to ‘see’ more of the embossed pattern, keep its size within the realm of your stitch length or
smaller - typically 3.0mm - 5.5mm.

Embossing patterns are done with Line objects, as stitches have no effect in the design. Also, you do
not have to worry about transits, overlap, and color or anything but the shape that is your desired result.

Emboss patterns are shapes that intersect the existing stitches thus causing a needle-penetration.
When the shape is parallel to the stitches, it may not intersect; hence you can have sides of your shape
that do not create stitches. This is usually overcome by adjusting the inclination angle a little bit, or
rotating the emboss pattern, so that more intersections occur.

Keep in mind what your emboss pattern will look where its pattern will set next to a copy of itself;
the design’s right edge shape will interact with its left edge.
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When storing emboss patterns, you will be saving them on your system for use in the future, but
when they are used within an object, they are also stored in that object. This means that if you edit the
pattern, the object won’t be updated - you'll need to remove that pattern from the object that’s using it,
and re-add the new version.

Let’s go through the process. Here we have drawn some line art in two designs.
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Exporting Vector Art

Artwork drawn in the program can be exported as a vector file in .svg format and for popular
cutting machines. Use the menu ‘File->Export’ to save the artwork. This is not the same as the
applique functions to save cut-files (located on the Applique tab of the Color Window). Those
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outlines are processed to directly cut an applique. The files saved when Exporting are the objects
as-drawn.

@ Branching (Level 3)

Branching is typically used to join the underlay of multiple satin columns, often for lettering;
however it can also be used to travel through a set of objects, beginning and ending where you select.

K Edge Run underlay is

3' separate: each object sews
L init's entirety one at a time.

—

To branch a set of objects, select them and click the Branch button, which is to the right of the Path
tools. Branched objects will be grouped if they are not already. To un-branch, select the first object and
click the Branch button off. Unbranching will ungroup if the objects were not previously grouped.

-------- 1-? Design
11 --------- mgﬂ Column

QB m—"] (o |umn

All stitches from a branch will
show up in the first object.

To set the entry and exit points for the branch, select at least the first object in the branch. The entry
and exit handles can lie on the outline of the shape, or slightly outside it, which allows you to see them
better (even though the stitching will always begin on the outline.)

184



/ The Branch will have entry

i’<¥ / and exit handles

Product: StitchArtist™

Here you can see the underlay for both objects has been sewn before any topstitching:

(] —— o 4p||

stitch: 43 Location: (-1.3, -2.6) Angle:90.0° Length:24mm (0.0, 2.4)
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Branch objects will need to touch in order to join. Objects that are left on their own or in groups

separate from each other form a subgroup, which will be branched together and then into the whole

branch as one.
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Here you can see that the whole subgroup on the left will sew first, as the branch ends in the
subgroup on the right:

We can see that the branch will travel from the entry through the first subpath, sew the second
subpath, then come back and sew the first subpath to its completion, ending at the exit point.
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Objects that wholly contain other objects can produce unpredictable results, so don’t do that with
branching. However, if single runs were used within a set of satins, then those will be discarded, as the
branching operation will provide its own transition runs. Also, branching will not predictably discover
objects within holes, so sequence those manually.
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Connecting runs will be removed

Objects of different types can be branched:

It is usually unwise to branch single runs, as the transition runs that will go under them are likely to
cause obvious weight to the run. But if your single run is a bean, stemstitch, backstitch, etc. then your
design should sew just fine.

When a set of objects is branched, the sequence of those objects will be determined by the branch,
not the order in which they were digitized. The exception to this is fully-digitized satin columns (not
auto-columns). When a branch encounters a set of fully-digitized columns, it attempts to preserve the
order of digitizing. The purpose of this is lettering. In most embroidery, the order of overlapping adjacent
objects is not terribly important, but in lettering, this can be much more important as the eye is used to
seeing things a certain way. For example, in the following letter ‘A’ the center horizontal bar should
appear underneath both the left and right vertical strokes regardless of the branch exit:

To accomplish this, the topstitching of the branch will be done in a reverse fashion to end up at the
exit, as seen in the above image, which shows the letter partially stitched.
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Publishing Fonts (Level 3)

Object-based fonts can be published, which provide the user with full stitch generation as they
create, modify and resize lettering designs. A font may be created on a design page (and saved normally
as a .BE file) that will hold a set of designs, each design with one or more objects. Fonts may be multi-
colored, and may use any stitch types, with the exception of automatic satin columns or objects with
breaklines. Those require processing which makes their use in fonts slow or possibly with poor
performance.

Fonts contain a set of individual glyphs such as the letters A-Z or punctuation. Each glyph on the
design page is represented as a design. Thus, an English 26 letter alphabet will have 26 designs. If you
add lowercase letters, you'll have 52 designs, etc. It does not matter where on the page the designs are
placed, nor does it matter in which order.

AaBbCcDdEe FfGg Hh
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Each design is a glyph, named by the letter you type.

Each glyph, represented as a design, has a name. You can edit the names in the Object Tree by
clicking on the name, which will make the name editable. The name is what the program will use to look
up the design based on what the user types. Generally you will just type one key for a design name. You
may use upper and lower case in the naming, however, uppercase letters should be followed by a letter
‘v, ex: ‘Au’, ‘Bu’, ‘Cu’... If you are creating a monogram font that has position-dependent letters, you can
create the left and right versions of the letters similarly (you won’t have lowercase), ex: ‘Al’, ‘A’, ‘Ar’, ‘Bl’,
‘B’, ‘Br’...

Special characters such as punctuation are named normally. A comma is ‘,’. Try to remember that
users need to be able to type the letter you are mapping in both Windows and Mac OS without Unicode.

Each glyph has a baseline object at the end of the design. The lettering tool uses this to place the
glyphs next to each other correctly. You do not need to create the baselines manually because the first
publish cycle will add them for you if they’'re not there already. You can then modify them up or down, as
needed, to place the glyph vertically. As an example, the lowercase letter ‘y’ has a descender and you’ll
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need to move the baseline up accordingly. You may even set your baseline through the center or at the
top of your glyphs, as required in monograms or other specialty fonts.

=y A Au &5
411 :i reference

41:2 -.Z i reference

41:3 _J reference

41:6 Satin
a7 Satin
41:8 Satin
41:3 Outline
4110 baseline

ey B -

A typical letter design: Included are reference art, branched satin columns, an optional outline,
and a baseline. Baseline and Outline are always Line object types. You do not need to draw the
baseline. The first publish cycle will add one for you, which you can later adjust.
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An optional outline selected

When the baselines are correct, and things look right, publish again to make use of the lettering.
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Letters on the baseline
If you have a row of letters, you might want to bring a rule down from the ruler at the top of the
page to ensure that the letter heights are correct.
Note: The baseline must be the final object in each design, and must not have any stitches applied.

Reference art may be included in the working file. We usually label these as ‘reference’ and place
them at the start, or start of each glyph, depending how they were drawn and imported. Once the art is in
place, lock it using the Object Tree, which prevents inadvertent moves while digitizing.

We also create complete outlines as line objects. This is for planned releases. You need not have this,
but it will be useful going forward.

When you publish a font, make sure that you have no lettering designs on any design page which
have that font (if previously published) in use. If the font is in use, it cannot be updated by the publisher.

Publishing will place the font in your font folder as well as make that font instantly available to the
lettering system.

Create View Zoom Window Help

Outline ; Fﬂ) m \ /i.’ll': [J- @

Design
Publish Designs...
Stylesheet.. Motifs...
= Auto Entry/Exit Emboss Patterns...
f Auto Seq by Color Stylesheet...
| Auto Sequence Font...
STl Batch Batch Export Stitch Files...
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Size, Spacing and Kerning

When publishing a font, there are sizing issues to be aware of.
Current Size

A font is digitized at a certain size - that is to say, however you made it. Usually this is based on
fitting the reference art onto the design page. In typography, the uppercase ‘M’ is often considered the
reference letter for sizing, so if you don’t know what size to use, select the ‘M’ and look at its height. Set
that value in the Current height box.

Default Size

Fonts will load at a default size. This is usually what the digitizer thinks of as the best size, or the
size the work was created at to stitch optimally. Set this value in the Default. Often, it is the same size as
the font has been digitized, therefore it would be the same as the Current height.

Minimum and Maximum Size

If you've played with embroidery fonts at all, you’ll know there are limits to how well they’ll stitch at
various sizes. Often the limits of down to 50% or up to 250% are used, but you may wish to experiment
and discover the usable limits of the font. These limits only stop the user from dragging the sizing handles
with the mouse. They do not prevent someone from overriding those limits by typing a value into the
selection tool pane.

Spacing

Letter and word spacing are set as a percentage of height, consistent with normal typography. A
value of zero will cause letters or words to have no separation. A value of 100% will cause things to
separate to the height on the font - almost always impossibly large. If you are unsure, try a small value for
letter spacing. Play around until you like it. Then use a low multiple of that for word spacing, ex: 8%
letter, 20% word.

Kerning

There is another process in typography called kerning. This moves pairs of letters closer together,
making the text more readable. Most fonts will look better kerned. You might have something such as an
athletic applique where the font is designed to be spaced evenly, and this is known as monospaced. That’s
available by leaving the ‘Automatically kern’ checkbox unchecked. If you are unsure, check it.

Nearest Point

Single color, satin-stitch-only, branched letters can be used as Nearest-Connecting-Point (NCP, or
simply Nearest Point) letters. NCP lettering provides the ability to run right-to-left, center-out or any
order the user wants, with minimum travel or jump distances. This happens because the letter’s stitches
are sequenced so that the beginning and ending stitches are near to the previous and next letters in the
sequence. When digitizing a font for NCP do not use runs to connect the satin elements, as these are
created during branching. If the publishing system sees runs, it will not create an NCP letter, but will
instead create a normal (and perfectly usable) letter, as-digitized.

Note: the satin branching keeps the order of your digitizing for layering purposes.

When publishing, you have choices for displaying the Nearest Point setting to the user on their
Stitch properties of a lettering design. The choices are Always, Default On, Default Off and Never. The first
three allow the use of the nearest point setting.
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Font Name: | (c)
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Always means you intend the font to always use the branching NCP engine. Use this when you
haven’t set the individual glyph entry/exits because the font is known to operate well as branched. The
use may not override this setting.

Default On / Off settings allow the user to override your preferred way of using the font. In most
cases you will have digitized logical entry and exit points on all your glyphs. If you have done so, the font
will sew as you intended it with the Nearest Point on or off, but Default On is preferred. Alternately, you
may know that some combinations of letters are not as perfectly digitized as you would like, so you
choose Default off, but leave the option up to the user.

Never means you have not designed the font to branch automatically.

Note: The Never setting does not mean you cannot branch within a glyph when digitizing it. You still
can, and those branches remain exactly as you have set them. This setting is only to prevent the user from
moving things around.

AUTOMATIC BRANCH

During the publish phase, if the setting is Default On or Always, the publishing system will check all
the letters for you to see that they are (and are able to be) branched. If some are not, the system will
branch those automatically, but only if they are all satin strokes.
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Copyright

Publishing a font includes an optional step of adding copyright information about the digitizer or
company that has created the font. The copyright fields allow you to claim your work as your own and set
permissions for its use. Each country has different copyright laws, though most are generally the same.
The U.S.A. has certain oddities of copyright law regarding typefaces, so if you're in business producing
fonts, you might want to look those up. You can also state the terms of usage, such as allowing people to
sell works created using your font.

--3--~1Publish Font w b
.~ Font Name: |Block 2 © QK -

Cancel
Default Size (mm): 10 Letter Space (%): |26

Min Size (mm): 5 Word Space (%): |82 *Pyblisher Informatoin X F-----
g Mex Size (mm): 75 Automatically kernm | .. — T '
u g Digitizer: Bob :

Page ID/Sku: | 0001 w ----- .....

Ik Category: IW
: - Copyright: I Copyright (c) 2018 BriTon Leap, inc. 7—”-7: -W-t
.- Website: I embrilianee.com e -----

Designs or their elements may not be resold in any form except as

Usage / Notes:
embroidered goods. Feeee

P O R ===/ [v Allow Convert To Objects [ Allow Republishing (ETCPLEREPS

*Not all file types are capable of retaining publisher data, but this will be stored in the native '
format, and can be seen using the menu View > 'About this page...' when it is available. | [

- E

The copyright information is attached to each object in the published font forever, even if the user is
allowed to convert the lettering to objects. Copyright information can be seen using the menu
View>About this page....

Al
About Designs On This Page. X
.

[ nacee font: Blockd 18
Copyrg () 2018 by Me
oA, comn

_ =1

If you have copyright information entered for the font, you will also be given a window to save the
BX installer for that font. The BX files allow you to share or even sell your fonts easily. User need only
double click the installer to load the font on Windows and/or MacOS.

Once you have entered publishing information, don’t forget to save the .BE file in order to store that
data there too. Publisher information is stored in the file along with other data, and that is transferred to
the objects as they are placed on the page with a lettering tool.

The Digitizer field should contain you or your company’s name. The optional Page ID is for those
who track part numbers of their fonts, such as in an e-commerce solution. The category field places your
font in a subfolder when installed, and may be useful in organizing fonts for the user. It is usually left
blank.
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Convert to Objects

The checkbox, ‘Allow Convert to Objects’ does what its name states thus enabling the users who
have a high-enough level of the digitizer to convert lettering designs into objects. This is your choice. It
allows you to control how others use the lettering designs, whether they are installed with BX or even if
you give them a .BE file. Some fonts are given out in .BE form as training guides or as part of something
more useful, while others are commercial in nature and the digitizer prefers not to allow conversion of
the lettering into objects.

Conversion into objects allows the user to take a glyph and manipulate it, which is commonly done
for logo work. Many corporate logos begin with a typical typeface and have glyph manipulation to make it
specific to that logo.

Copy

Convert to Objects

Objects that have been converted from a lettering design will contain the same copyright
information when using the menu View > About this page.

Republishing

The option Allow Republishing is for those very generous souls who allow others to add to, or
modify, their work and pass it along. If another user has your .BE file, or has imported all the glyphs by
converting lettering designs to objects, they may be allowed to make a new font out of it. Does this
replace the original copyright? No. Those objects are always tagged with each copyright. The objects that
the second user has modified will be able to have another copyright added to the original. This can go on
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through as many people as have republished the font. When more than one user’s work exists on the
page, all copyrights will appear.

If any user limits what can be done with the font, only that user can adjust that setting. Subsequent
publishers can add further restriction, but not remove any. When a font is published, the publisher’s
serial number is turned into a unique identifier and placed in the copyright. This means a publisher can
modify their own settings, but they may not modify another publisher’s settings.

We have made every effort to protect the work of individual digitizers. We use encryption that’s
state of the art. Of course, hackers are always at work in the world, so there can be no guarantees. We all
know that locks are generally to keep honest folk out, and that’s what this is: a set of locks. Of course,
ordinary stitch files carry no information about their digitizer, and they’re easily copied by any user, so
this is a big improvement over the status quo.

Foam Fonts

Foam fonts are published by setting the satin columns to the style, “Foam” or using an automatic
foam endcap or plank in the column underlay properties. When publishing, the program notices the
settings and flags the font automatically.

When lettering with a foam font, Stitch properties are not available, as the font should sew with the
foam settings.

Good practice

When digitizing fonts, any normal quality procedures and settings are going to work out. Remember
that the user will have the ability to override your settings for density, pattern and underlay, so there is
no need to make those adjustments across all letters. Keeping settings in synch is always a headache
anyway, although the use of Quick Styles does help enormously.

When making NCP fonts, remember to use only satin columns, fully formed with inclination lines.
Lay the satin columns in the order you would normally, as if you were digitizing for a single sew-out. The
main difference is that you are leaving out connecting runs. For letters which are normally digitized with
extra pieces to accommodate overlap, such as is often in ‘X’ or ‘kK’, don’t break those strokes down. The
branching engine will do that for the user.

Fonts typically have a wide size range and this causes issues with overlapping elements. Serifs can
get partially obscured in an enlarged letter, so it might be best to consider sequencing those over the
strokes that connect to them. Underlaps are needed more on small letters than large ones. As a letter is
enlarged, you may see underlap build up a loft. Thus we recommend having overlap, but keep it minimal.
You do not want to perfectly butt-join objects, but rather prefer a minimal intersection, as necessary.

Remember that you can always edit a copy of your font at a larger size to make it stitch well at those
larger (or smaller) sizes.

The best recommendation we have for those new to font digitizing is to look at our examples and
then play with your own. Test, test, test. And, please, never charge a consumer for something you have
never tested at all. Thank you!
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Digitizing Tips for Font Creation

When making fonts, there are some basics that you need to understand. First, and most important, is
that fonts and embroidery are not friends. Font designers get away with things that embroiderers cannot.
Most notably, font designers have no restrictions on stroke width - or the variability of it. A glyph can
have a super narrow column alongside a super fat column. Assuming that you're making a satin font, the
lettering sizes are restricted by these column widths. A minimum column width of 1.5mm is typical. A
maximum width of 7, 8 or even 9mm is about the most you will want to use, in general circumstances. If
your glyph has sections that are 7mm wide and sections that are 2 mm wide, you have sizing constraints.
The answer to this problem is to make the font stroke thickness more regular. Embroidery font designers
do this all the time, and that’s often for fonts designed for a specific size. If you're making fonts that
should be able to scale up or down, you need to pay more attention to that problem.

The next issue is overlaps. Fonts on a computer don’t have layers -- the letter is a filled color. With
embroidery you can see the order that the machine stitches the letter. And the human eye tends to have
an opinion about what looks right in that circumstance. There are also embroidery-related reasons for
having layers set correctly, particularly registration. Two satin strokes that touch may have a slight gap,
or a slight overlap, both of which may not look right.

Another digitizing problem is turning acute angles. In a word, our advice is, “Don’t.” Take a look at
the following image which shows three methods of turning tightly.

Three methods of turning
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The bottom left, center, and bottom right are various methods of turning tightly. Can you spot the
worst one right away? If you said the center, you are right. The center simply turns around, making long
stitches and high density (even with short-stitching). This turn is ugly and unnecessary.

Look at the bottom right. This is a form of overlap, and there are a couple ways to do it. This way
doesn’t look bad in many cases and is easy to accomplish. Its best benefit is that the stitch lengths remain
at the width of the columns.
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The bottom left has a couple things going on, including a cap object, which is shaped like a bowl at
the bottom of the letter. It also has the two strokes coming down to the cap with nice, even, parallel
stitches that actually shorten just a bit as they get close to the cap. The strokes do not overlap, but look
like they do. They could overlap, but having them ‘kiss’ makes for better branching, as this will look the
same, no matter which way the letter runs, left-to-right or right-to-left.

The downside of a cap is that it has to be a bit wide, and that width may make for a long stroke, so
keep it in mind. A way of dealing with that problem is to adjust the shape of the letter.

L R s l !

______________________________________

At first glance, you may not see the difference. Here, we made the width of the cap narrower. In this
case we set it to 7mm, which is comfortable to sew and that allows this letter to sew at 35mm in height.
Notice that the left vertical stroke looks a bit wider at the top. We left it that way so you could see how the
verticals should narrow a bit in order to meet the cap at its new width. You could accept the font like this,
but it is more likely that you’ll narrow the whole column.
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This version has been normalized a bit, so the columns are slightly narrower. The result for the
embroiderer is that this letter can sew 25% larger than when it was faithful to the original art.

Digitize your lettering for the approximate size you want it sewn at. Naturally, having objects allows
for the designs to be resized by the user, and that’s nice, but if you would like a small version of the font,

makes one. Shrink it down in size and then study the column width. If you can, fatten them up a bit, and
you’ll have a smaller version of your font.

CONNECTING STROKES
Consider the angle at which strokes connect. Right angles make the strokes more obvious, tend to

have shorter stitches, and provide branching a way to move to the next stroke.

Correct

Incorrect

Keep strokes nearly perpendicular wherever possible

Strokes at angles have another set of possibilities. When the angle is acute, you might be tempted to
turn the inclination to be aligned with the stroke it is meeting. This can be done for shallow entry angles.
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Turn Parallel to point Parallel with Slow turn with
underlap underlap

Stroke connection types

In the illustration we can see four common types of strokes. The Turn is the most common and has
issues with high density along the inside edge. Short stitches can overcome this, as seen in the
illustration, but it's going to be a more textured edge than the others and should be avoided unless the
turn is not significant.

The Parallel to Point is common, but has the disadvantage of bringing a satin down to a point, which
contributes to knotting underneath the fabric and may even break needles.

Parallel with underlap has the advantage of smooth edges and prevents the point issues by allowing
the final stitches (show here at the top of the right stroke) to have length reasonable enough to be sewn
without trouble.

The shallow turn with underlap also works because the density variance is not so great as to attract
attention and the final stitches are long. The amount of overlap this uses can be a bit much if you're
making large lettering. In that case, choose the Parallel with Underlap.

For small lettering you might consider a combination, shaped similar to the parallel underlap but
with the gradual turning inclination.

Whatever methods you employ, keep them consistent across the font, where possible, especially in
similar letters, such as M, N W, V. Bear in mind the likely size of the letters when sewn, as size affects
what you’ll do when digitizing.

SIZE

The size you digitize to is somewhat important. If you digitize at a large size, you'll notice the design
will change slightly when reduced. Inclinations that look good at a larger size may not be appropriate
when the font is made small. We recommend you digitize the lettering at the default size you want the

font, then edit it at the smallest size you think it should go. Going up in size does introduce some other
issues but they are less profound then going down in size.
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Create Font Page

The menu item Create > Publish > Create Font Page... displays the operating system’s font selection

window. Once you choose a font, the program will create a new design page, on which will be a design for
each glyph in the typical font. This is a convenience item for those times you are using TrueType as art.

Remember that most TT fonts have too many nodes and wildly different stroke widths, so they are

not usually good candidates for embroidery unless you modify them heavily.
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Click below to change individual colors.

v
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Zoom: 40% Cursor: 10.6mm x -148.9mm Hoop: 350mm x 350mm 306.7mm x 267.6mm Ndis/Cols: 2/180

Each glyph comes in as a design, already named, along with bitmap, baseline, and outlines for the

glyph. We suggest you use the bitmap and digitize over it. Breaking the outline into individual strokes
usually will take longer, and you’ll still have to compensate the objects by overlapping them slightly.

You can delete the designs you don’t need and/or add more than what comes in from the tool.

Due to the wildly different methods used by font designers to publish their font, this tool is not able

to be supported for specific fonts. It can only work with the data given. If you see something strange or
undesirable, delete it.

202



Sending Designs to Brother XP1 / Baby Lock Solaris

Sending Designs to Brother XP1 / Baby Lock Solaris

These machines have built-in WiFi servers. To send the current design page to the machine, use the
Utility menu > Send to Solaris / XP1. This command exists on any Platform product that has a Utility
menu, such as Essentials.

The design name will come from the design page name, but you will be given the opportunity to
change it. Note that if the name matches a file on the machine, the name will get a (2) after it, or (3), etc.
At present, there is no way to overwrite or delete a design file that’s on the machine.

Design name pd

Design |Design

Once you hit 'OK' it may take several seconds to send the design.

Cancel ‘ 0K |

Result >

File sent to machine!

OK

Remember to save your working file (.BE)! That will not be sent to the machine.

The first time you send a design to the machine, the program will look for the machine on the
network. This can take anywhere from a few seconds to a minute. Wait for a message. Subsequent runs of
the program will try using the last known address of the machine. As modern routers tend to keep IP
addresses the same (for a given device) over time, this should allow you a much faster send-time
thereafter.

If the machine fails to respond, you will get an error message. If you just turned the machine on, give
it half a minute to wake up, and try again. If that fails, check that the machine has a good WiFi signal. The
machine owner’s manual and/or your dealer can help you learn the machine interface. If the machine is
indicating it is on the network (the same WiFi network as your computer) and has good signal, then try
sending the design again. Sometimes the network is slow or the machine may need to wake up. The good
news is that once you have sent a design the first time, it will very likely succeed reliably from that point
on.
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Correcting Sewing Issues

An Embroidery machine is not a ‘thread printer’. Often times we hear that a design looked perfect
on the screen, but didn’t sew out that way. It almost never will sew out the way you see it onscreen. As
the design sews, thread is being pushed through the fabric, opening it up, tightening it in the hoop,
reducing its elasticity and drawing it together. As the fabric moves, the ‘location’ of all subsequent
stitches is going to be incorrect by some small amount. This produces various sewing defects such as loss
of registration, puckering/gathering, dancing baselines, poor coverage and even fabric tearing. If we pay
attention to how we construct the design we can minimize these difficulties, and even use them to our
advantage if we are crafty. We also want to allow our objects the ability to move around a bit, and anchor
them as needed. It is a process guided by experience. Let’s look at some common issues:

Registration

Registration describes the effect in areas where two or more objects meet at their edges. If the
objects stitch tightly up against each other so that there is no background color bleeding through, the
registration is considered ‘tight’ or correct. As a design is being created, it is worthwhile to think about
registration - you can add overlap to your shapes or add compensation which could save you time later
when you edit the design.

Switching fabric, project types or even machines and hoops will affect the registration of any design.
This is why you often hear that digitizing for hats should be done by a professional - the registration
issues compound. The verb ‘compound’ here means that each object that sews will affect the location that
the next object will sew. This happens because the fabric gets distorted a little bit for each and every
stitch. What you see on the computer screen does not include the distortion that occurs during stitching.

How do you fix it?

You will have to do the same thing that people before you have done; sew, edit, sew, edit, sew until
you see the result you need, then try to remember what you did the next time you create a design. It's a
process that gets much easier once you have some real experience, and the only way for that to happen is
for you to do it.

Registration issues come in a couple common forms when digitizing.
1.) Outline stitches are separated from filled areas.

There are some tricks to making outlines register. The easiest is not to use them. This is a design
style issue, and we see through the years that designs will sometimes come with a double-stitch or bean-
stitch outline around everything. There is no rule that says you need to do this. Only use outlines where it
is important to make the artwork appear crisper.

Another way to help outline stitches is to give them more body; a bean stitch will work better than a
single or double run. A backstitch or stemstitch is wider and therefore naturally going to ‘hide’ any
registration issues easier.

When creating the outline, place your points slightly inset into the stitches that they surround -
perhaps only half a needle-width 3-4 stitch points for your first try. All fills and satins tend to ‘draw’ the
fabric in because of tension, and the thread has to curve down toward the fabric where the needle
penetrates. This causes the outline stitch to be pushed away. Therefore in-setting the outline, if only
slightly, will help the result.
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In the above image, notice that the inset of the darker-colored run is greater at the sides, and almost
perfectly aligned at the top and bottom. This is because the fill will sew ‘narrower’ along the inclination -
each line of stitching wants to pull the fabric in.

At the top or bottom, whichever stitches later, you may see the fill (or more typically a satin) ‘push’
or get ‘taller’ before the run happens.

2.) Adjacent filled areas pull away at the ends of the stitch lines.

When a line of stitching ends, be it from a fill or a satin, there is tension that pulls the fabric in the
opposite direction of the line. This means that a fill or satin tends to sew ‘narrower’ than the object was
drawn. We do use the compensation setting to help this - it makes the ends of the stitching a little bit
farther out past the edge of the shape. It helps, but sometimes that’s not enough, especially where two
fills or satin edges meet.

Solving this usually is done by overlapping the object shapes. The shapes can overlap quite a bit
sometimes if there is compound registration from more than two objects all positioned at each others’
edges.

If there is an edge-run in each object, for underlay or travel purposes, sometimes you can use it as
an ‘anchor’ for a subsequent object; move the outline so that it overlaps just to that edge-run and has
some needle penetrations that grab it. This tends to balance the stress on the fabric between both
adjacent objects.

) = —:=:
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In the image above, you can see the earlier yellow object has its outline inset ‘under’ the red and
purple objects, which allows for a degree of freedom of movement while it is being sewn. The other
objects will not overlap as much as it appears on screen.
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Oh, look, a rainbow, how nice! No. No, it isn’t. This is a perfect example of compound registration at
work and you will not be able to sew this consistently.

The red, then yellow, then green sew in that order. It sounds right. But the gaps you see when you
sew will make you wonder if you should take the machine in for repair. This will probably work better
going outside-in with the green, then the red, then the yellow, and don’t be surprised to have the green

and red objects nearly touch each other in the middle under the yellow.

Do not do it like this:

Rather, more like this:

206



Correcting Sewing Issues

Coverage

Watching a child use a crayon to color an image will help you understand this quite clearly. If you
move the crayon back and forth in one direction, the edges of what you are coloring will not have as much
color as the center. Typically an older child will work the crayon along the edges at some point which will
extend the color more evenly. The same is true for embroidery. Using multiple layers of stitching, with
different directions, yields better coverage. It also divides up the shift in the fabric, which helps
registration; instead of everything being pushed one way, it gets pushed half as much in two directions,
and your stabilizer will be better able to support it.

This means that if you want more coverage, try making two passes or more, each with less density
(instead of one pass at 4pt, try two at 8pt). This is in fact the reason for the underlay options in fills and
satins.

Fill Coverage

When doing a fill, often times you will want to position your Exit bead somewhere in the ‘middle’ of
the shape. This means that the pattern will sew one part of the design, then go away and work its way
back. If your fabric is being flattened by the thread, and you do not have undersewing for better coverage,
this can leave what appears to be an ‘unstitched’ line across your fill. There are solutions for this - use
more in the way of underlay, and/or move the exit bead to the opposite ‘end’ of the pattern. It is often
better to ‘run’ to the next object after your fill than to have the fill exit in the middle.

AP
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Left: A fill with the Exit bead midway in the fill. This causes the stitching to go from one side, then
the other as shown in the center image, which is shown using the sewing simulator (in this image it has
sewn below, and is now working its way down from the top).

Right: Entry and Exit Beads are at opposite ends, which can help the fill provide a smoother
coverage.
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Machine Issues

We see these often enough that they are worth mentioning here.
Thread loops on the bottom of the fabric

This is always caused by the TOP thread having no tension, or not being in the take-up lever. It
sounds counter-intuitive, but it’s true, the bottom of the design is controlled by the top thread, not the
bobbin.

Thread coming up

Usually this is a bobbin case tension too loose, or not having the bobbin thread in the tension at all.
While it is possible that the top thread is getting hung up coming from the spool (very common actually)
this usually happens in specific areas and appears quite severe. If you are seeing a lot of points coming
up, it is usually the bobbin not having tension.

Machine-gun sound

It sounds silly, but yes, that rat-at-tap-tap can be annoying and even destructive to the machine.
Usually this is your hoop flopping around when the needle rises out of the fabric. The needle lifts it up
just a bit, then pops out, and the hoop flops down. It could mean the hoop is mounted wrong, is defective
or simply a bad design. You can help by making sure you have a sharp needle, sized as small as you can
for your thread. And you can try putting something on the arm of the machine to soften the blow. And
definitely have it checked by a competent sewing machine service.
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Help

Getting help for Embrilliance products is just a few clicks away!

http://www.Embrilliance.com

Click the ‘Contact Us’ button

Design Credits & Thank you

We would like to thank the following companies for their support of Embrilliance software. Many of
the designs shown in our documentation and online help videos have been provided to us to use for
demonstration purposes. Please visit their websites for more information on how to purchase these
professionally digitized designs.

Adorable Ideas - www.Adorableldeas.com

Lindee G Designs - LindeeGEmbroidery.com

Great Notions - www.GreatNotions.com
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